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CHAPTER 1 : LOGGING ON

This chapter explains how to:

* Log on to the Oracle Daybreak system

*  Change a password

* Reset a password

* Log off from the Oracle Daybreak system.

Logging on

At the beginning of each Oracle Daybreak session and prior to working with any account,
you must log on at your workstation. Oracle Daybreak then allows you to “enter” the sys-
tem and open the programs available according to your level of responsibility. To log on to
Oracle Daybreak, you need to have your own user id and password. Each user id is
attached to a responsibility level, or “profile,” that controls the user’s access to various
areas of the system. Your user id is associated to all the accounts you process.

The ability to log on is automatically disabled after a specified number of days of inactiv-
ity. The user id and password required to log on to Oracle Daybreak may be different from
the user id and password used to log on to your computer or network. If you are unsure of
your user id and password for Oracle Daybreak, contact your system administrator.

To log on to the Oracle Daybreak system

1 Follow the guidelines for your business to launch the iAS window and begin a Oracle
Daybreak session.

After starting Oracle Daybreak, the Login form appears.

Qo - @ ¥ B G| Ooowtn Slprovons € (- @ - [J @ 3
Address @] httpsfjhorus -lex,coms = M B s | nks 7
& paybrea [=]

Welcome to Daybreak
|

SIGI g0 N[ 188 5 4 4 » Pl ®I2 (017

vser[
password[
cancel
Faorgot Password

ORACLE Copyright 1998-2010 Oracle Financial Services Software Inc.
11.6.0.0.REL.0.0.ALL.0-10.0.0.99.IF.3

2 In the User Id field, type your user identification name.
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3 Press TAB to move to the Password field.
_Or_
Click the Password field.

4 In the Password field, type your password.

5 Choose Connect.
_01‘_
Press ENTER.

Note: If you choose Cancel, Oracle Daybreak closes the Login form.

If your user id or password is inaccurate, Oracle Daybreak displays the following dialog
box:

r'g, Invalid User id or Password. OR&-20000;
£4

*  Choose OK and retype your user id and password. If problems logging on persist, con-
tact your system administrator.

IMPORTANT:

The length of a password is established during system setup. Special characters (&, @, #,
$, %, ~, &, *, and so on) cannot be used to create a password. To prevent others from see-
ing your password, your password does not appear in the Password field as you type it.
Instead, your keystrokes appear as asterisks (*). Keep your password confidential to pre-
vent access to Oracle Daybreak by unauthorized users.

If Oracle Daybreak recognizes your user id and password, the login form updates to dis-
play and automatically complete the User Id, User Name, Responsibility, Organization,
and Division fields. Your user id appears as the title of the form.

User It | JamES
User Name | JaES BOND:
Respansibilty | UsER

Croanization |DAYEIREAK
Division [C01

Copyright 1998 2010 Oracle Financial Services Software Inc. ORACLE
11.6.0.0.REL.0.0.ALL.0-10.0.0.99.1F1.3 PartnerMNetwork
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When you successfully log on to Oracle Daybreak, the menu items available to your
responsibility are available. (Whatever menu items are “unavailable” are visible, but
dimmed.)

If you have not logged out of Oracle Daybreak, have an old Oracle Daybreak session
open, or you did not correctly exit your previous Oracle Daybreak session, when you
attempt to log in again, the following dialog box appears:

ii You have previous apen lagins, Do you want to close

them?

e Choose Yes to close your existing sessions.

Note: The majority of the time, you will choose Yes. Choose No only if you want to work
with multiple Oracle Daybreak sessions.
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Changing passwords

Passwords will automatically expire after a period of time set by your system administra-
tor. Oracle Daybreak notifies you of approaching password expiration dates with a mes-
sage dialog box that appears after you log on.

To change your password
1 Close all open Oracle Daybreak forms and return to the User Id form.

2 On the File menu, choose Change Password.

The Old Password, New Password, and Confirm New Password fields appear on the form,
along with the Change Password and Cancel buttons.

File Edit @ igation Lending Jocuments
Save

Re-Logon

Change Eesponsihility

Clear Form

Print

Exit

User Id| JamES
Lzer NameW
Responsikilty| USER

OrganizaﬁonW
Divizion ,(301—

Qld Pazaward

Mewy Pazsword

Confirm Mew Pazsword

[Grange Password ORACLE’
Change Password Cancel |
PartnerNetwork

Copyright 19982010 Oracle Financial Services Software Inc.
11.6.0.0.REL.0.0.ALL.0-10.0.0.99.IFL.3

3 Inthe Old Password field, type your old password and press TAB.
4 In the New Password field, type your new password and press TAB.

5 In the Confirm New Password field, retype your new password and choose Change
Password.

Oracle Daybreak displays the following dialog box:
6 Choose Ok.
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Resetting passwords

Oracle Daybreak allows you to reset your password from the Login form by choosing the
Forgot Password button. This command button can be used when:

*  You forget your password

*  You discover that your password is not working (as another user might have disabled
or changed it)

e Oracle Daybreak disables your password after you entered the wrong password multi-
ple times.

To reset your password with the Forgot Password button
1  Close all open Oracle Daybreak forms and return to the User Id form.
2 In the User Id field, enter your user identification.
3 Choose Forgot Password.

Oracle Daybreak generates a random alphanumeric password and sends this new pass-
word to the email address listed in your record on the Administration form’s Users page.
Oracle Daybreak then displays a Forms dialog box with the message “Password Reset
Successfully. You should receive the new password in your email shortly.”

4

LENDING SUlTE1

J Fasswaord Reset Successfully. You should receive the

new passward inyour email shorly. (SYS-5Y5-5Y5-
ULG-000012)

Copyright 19982010 Oracle Financial Services Software Inc. ORACLE"

11.6.0.0.REL.0.0.ALL.0-10.0.0.99.1F1.3
PartnerNetwork
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Logging off
When exiting Oracle Daybreak, always use one of the following procedures:

*  On the File menu, choose Exit or Re-Logon
-Or-
On the Oracle Daybreak menu bar, choose Exit.
_Or_
On the Login form, press CTRL+Q.

Oracle Daybreak closes the session and releases any accounts you may have been working
on.

IMPORTANT:
Do not choose the Close button on the Oracle Daybreak menu bar to end a Oracle Day-
break session
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CHAPTER 2 : CUSTOMER SERVICE

After an application has cycled through the lease origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Day-
break’s Customer Service form.

The Customer Service form allows you to view and manage all customer information in a
centralized location to assure data integrity and provide better service. Oracle Daybreak
provides online real-time information about the applicant(s), contract, account balances,
dues, transactions, call activities, and comments. Oracle Daybreak also supports back-dat-
ing of financial transactions up to account’s opening date.

Customer Service form is divided into tabs that perform the following tasks:

*  Search for and load accounts on the Customer Service form

* View comprehensive account and customer details, including status, balances, trans-
action histories, payoff quotes, statements, escrow information, insurance informa-
tion, and vendor work orders.

»  Track attributes associated with an account

*  View vendor work orders

» Record call activities, promises to pay, comments, and references

»  Use checklists to perform customer service tasks

* View payment rating history and due date history

*  Perform monetary and nonmonetary maintenance on an lease

* Record information concerning bankruptcies, repossessions, foreclosures, and account
deficiencies

*  View contract information recorded during the funding process

* View information regarding account collateral

*  Perform a credit bureau pull

* Add comments to an account during any time of the customer service process.

This chapter explains how to do all of this.
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Activating an account

An account is automatically activated when you fund the contract with the Funding form
or when you activate an account with the Conversion App/Acc form. You cannot activate
an account with the Customer Service form.

Posting and reversing payments

A payment can be posted and reversed on the Consumer Lending (Advance and Payment)
form. You cannot post and reverse the payment in Customer Service form. (For more
information, see the Batch Transactions chapter.)

A note about account numbers

After an application completes the lease origination cycle and is funded or is ported into
Oracle Daybreak through the DLS Open Interface, it becomes an account and receives an
account number.

Oracle Daybreak assigns account numbers using the following logic:
YYYYMMNNNNNNNX
where:

YYYYMM = contract date
NNNNNNN = serial number
X = check digit

Oracle Daybreak sorts accounts using the NNNNNN portion only. That portion is what we
call the account ID.
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Search (1) master tab

There are a number of different ways to load an account on the Customer Service form.

* Use the Search (1) master tab (similarly to the Underwriting and Funding forms)
*  Use the Search block on the Customer Service form’s master page

»  Use the Next Account feature to load an account from a predefined queue

*  Use the Auto Run feature.

To search for and load an account with the Search (1) master tab

1  On the Lending menu, choose Customer Service.

The Customer Service form appears, opened at the Account Details page.

Status Product Payoff Amt Amt Due Oldest Due Ot Company  Branch
[ [ [ [ =]
[ [ [ [ [ [ [ -
Tntal| ‘ # of Aocounts: ,_IJ
Search (1) Customer Service (2) | Maintensnce (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (8) Contract (7) Collateral (8) Bureau (9) Comments (10)
Account Detsils l Customer Details BN eSS Balances Transactions Tracking Attributes Statements ST Insurances “endor Wiork Order
.clusmmers | z Mz = ‘ et e :T“d"'““stondmn | Start Dt lFunowup Ct .
[ [ ~ gl Due Ot At | | | O
Customer # SSH Birth Dt Gender Deis Due | 1 [ | | | —
[ [ [ LC Due [ 2| [ s .
Ermail | HSF Due [ 3 [ | a
Langusge | Marital St [ Cther Due | 4 [ [
Disability Skipl” Stop Correspondence Total Due | 5| [ [ ~)
Privacy Opt-cutl Time Zone Active Miltary Duty [ Activity Delinquency Information
" Effeclive [t Active Ot Paid Off Ot Chargeoff Ot Current Pmi  Due Day Late 30 B0 90 120 150 &0
o AbressType " Current Maing _Prons \ l | | l C N
r - B Last Pt At Pt Ot Last Bill &mt Last Sctivity Dt Military Duty T )
‘ | | | = BPMSF (Yesr) [ |
Producer ‘ Behavior Score Days  Category Collectar
=] App ¥ Customer Grace Score
Call Activities l Promises Comments Checklist References Payment Rating History  Due Date History
Action Result Contact Reason Promise Ct Promise Amt Cancel  Conclition Followeug Ot Time Zone A, Followeup Dt Appt
= | | \ | | 5000 | [ \ \ L= ]
[ [ [ \ [ [ il \ \ \ r
[ [ [ \ [ [ il \ \ \ r
[ [ [ \ [ [ il \ \ \ r
[ [ [ \ [ [ il \ \ \ Cii=)
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Choose the Search (1) master tab, then choose the Search tab.

search o0 Auto Run Accounts ;o Status Product Payal? At &mtDue  Oldest Due Dt Company Branch
[ T om [ [ [ [ =
ace #| [ [ [ [ [ [ =
Or S5 Total| [ # of Accounts [5}
Search (1) Customer Service (2] Maintenance (3)  Bankruptcy (4)  Repo/fForeciosure (5)  Deficiency (6] Contract (7) Collsteral (6) Bureau (9) Comments (10)
Resutts Search | Review Regussts
Search Criteria
Criteria Comparison Operator “alue =]
ACCOUNT # = WS
ACCOUNT STATUS  [LIKE [
PRODUCT  [LIKE [
CUSTOMER S5M |-
CUSTOMER LAST MANE  [LIKE
CUSTOMER FIRST MAME  [LIE
cusToMERID [
v ke
vEarR |
MAKE  [LrkE
MODEL  [LiE
ASSETTYPE  [LME
PRODUCER #  [LiE
PRODUCER NAME LIKE
ACCOUNT CONDITION — [LIKE [
GUELE MAME (UNDEFINED FOR DEFAULTY  [LIKE [
GUEUE DESCRIPTION  [LIKE [
[ [ =]
Search
Reset Criteria | Search |

3 In the Search Criteria block, use the Comparison Operator and Values columns to cre-
ate the search criteria you want to use to find an account.

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values
columns.

Choose Search.

Oracle Daybreak locates and displays on the Results page all the accounts that meet your
search criteria in the Search Criteria block.

Application
spp # ot[1107:2005 ot cos[ Purpose | Priority | Status | Comparty
Product Existing Customer| | Dupl | Contact [ Channel [ Producer| [ Sales Agert|
Search (1) Applicants (2)  Decision (3) Buresu (4) Collstersl (§)  Comments (7) Imege () Verification (9) Tools (10)
Results | Search Review Requests
Sort
Primary Sort Ordsr Secondary Sort Order Wiz a1
NOME ~| @ Cp WONE ~| ®a Cp Sort
Company Branch  Priority App # Date Title: Product Status Producer
mzzFe  |Ha |HeH  |ooon1ss234 03001 2001 |[CIMGQUEFOIL EVE f CMQUEFOIL DALE  |LEASE YEHICLE  MEW-REWIEW REQUIRED  |HI-D0DO3 : HEWLI MITSUBISHPE |~
[zsFc Ha [MORMAL (0000058135 |06/04/2004 [BRERMER: PETER / TAMMY |LEASE VEHICLE  MEW-REVIEW REQUIRED  [CA-00005 : AUTO JUNGLE
lzsFc  |Ha [MoRMAL (0000082135 |DE/04/2004 [HUNTINGTOM CHRIS / Hin |LEASE WEHICLE  MEW-REVIEW REQUIRED  |CA-00003 : ACE HEADQUARTERS
[ssFc Ha [oRMAL (0000082136 06042004 [CARRUTHERS CHAD [LEASE VEHICLE  MEW-REVIEA'REQUIRED  [FL-0000S: TEXAS AUTO MART I
[zsFc Ha |NORMAL (0000065136 |nBin4i2004 [TRACY SUSAN |LEASE VEHICLE  NBA-RECOMMERND REJECT [FL-00001 : FL AUTO CENTER, INC
lssFc |ha [MoRMAL (0000085138 |DE/m4/2004 [BROVI JOHM £ CATE |LEASE VEHICLE  MEW-RECOMMERD REJECT [CA-00003 : ACE HEADQUARTERS
[zzFc Ha [MORMAL (00000561 40 [06m4:2004 [PETERSON PETER / DEBORAH [LEASE VEHICLE  MEVY-RECOMMEND REJECT [CA-00003 : ACE HEADQUARTERS
lssFc [He [MoRMAL (000056142 |054:2004 [GREAT PETER / CATHERINE [[EASE VEHICLE [MEv¥-RECOMMEND APPRO |FL-00004 ; USA AUTC CENTER, IM
==Fc  |Ha MORMAL 0000067135 05042004 [BROVR JOHRN [LEASE VEHICLE  [MEvW-RECOMMERD REJECT [C0O-00001 : PHIL LONG MITSUBISH
==FC Ha MORMAL [DD000BE1 36 08/04/2004 [BITMAN BRAD [LEASE VEHICLE  [MEvY-RECOMMERD APPRO [CA-D0003 - ACE HEADGUARTERS
[ =
Gueue Mame MEW SPPLICATIONS GUELIE Secured Application Copy &pplication | Next &pplicstion

Note: The Secured check box indicates whether the account is secured and may only be
loaded by authorized users.

On the Results page, double-click the application you want to retrieve.

Oracle Daybreak loads the account on the Customer Service (2) master tab’s Account
details page.

You are now ready to begin work on the account.
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To load an account with the Customer Service form’s master block
On the Lending menu, choose Customer Service.

In the Search block’s Acc # field, enter the account number of the account you want to
load and press ENTER.

Oracle Daybreak displays the account details on the Customer Service form’s Account
Details page. (Note: This method will locate a single account.)

_Or_

In the Search block’s SSN field, enter the social security number of the applicant on the
account and press ENTER.

Oracle Daybreak displays all the accounts involving the applicant with that social security
number on the Customer Service form’s master block Accounts block.

Note: If you complete both the Acc # and the SSN fields, Oracle Daybreak displays the
account with that account number and all the accounts involving the applicant with that
social security number on the Customer Service form’s master block Accounts block.

To view the lease origination information about an account
On the Lending menu, choose Customer Service.
Load the account you want to work with.

If you choose Underwriting from the Lending menu, Oracle Daybreak opens the Under-
writing form and loads the underwriting information from which the account was created.

If you choose Funding from the Lending menu, Oracle Daybreak opens the Funding form
and loads the funding information from which the account was created.
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A note about conditions and queues

Accounts do not have sub statuses; instead, accounts use conditions. Conditions further
define the status of an account; for example, an account may be delinquent, bankruptcy,
and scheduled for charge off. Conditions can be applied automatically by Oracle Daybreak
based on set up and manually by Oracle Daybreak users with the Customer Service form.

Oracle Daybreak can assign accounts to specific users by way of queues. Queues are a
workflow management tool that allow Oracle Daybreak users to work on accounts sequen-
tially from a prioritized list, rather than having to manually search for and load them.
Queues are created and sorted during nightly processing. Examples of customer service
queues include due date change requests, delinquent accounts, deferment requests, and
title and insurance follow-up.

Oracle Daybreak assigns accounts to queues based on the account’s condition.

Search 5. - Auto Run Accounts

Acc # Shatu Prociuct Paryoff Amt Amt Due Olcdest Due Ot Company  Branch
DELINGLIENT (DEFALILT) TR I T2 e acTivEDELG | LEASE WEHICLE | $27 54 06 | F16,044 23 [D3n0200 [SSFC Ha

Aco #[20010200013600 [ [ [ [ [ [ [ [
or SSH Tatal| $27 6406 | $16,044.23 # of Accounts 1

LIRS

Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency [t Contract (7) Collsteral (8) Bureau (9) Comments (100
Account Details { Customer Details EHUENESS: Balances Tranzactions Tracking Aftributes Statems Exere Insurances Sendor Wiork Order

Ur=inmers D%I;isay's oMt Start Ot Falloweup Dt
W [CHRIS & KENER priery [2] Payott $ZTERA0G - ObiestDue COIMORO0 | fo g e [p3r0r2001 [parmamons =
[rema € kENMER |sPouse - Due Ot At | | |
Custamer # zan Birth Ot @aity Delg Dus [ $16,044.23 ¢ [020/2004 | $536 65 |
70161 [ioocxx-3770 021111982 MALE LC Due | 830000 2 (0171052004 | §58055 L,en ! ! -
Email [CHRIS_KENNER@METROEXPRESS COM NSF Due | $0.00 3 [12110/2003 | 358665 I =
Longusge [ENGUSH e[ | Ciherdue [ $000 4 1101072003 | 580 66 |
Disabiity Sipl stop Comespondencel || ToalDue| 1634423 5 10102003 [ 1370955 [ B
Privacy Opt-Outh® Time Zone Active itary Duty ™ petivity Delinguency Information
Contact Information Effective Dt Active Dt Paid Off Dt Chargeoff Ot Currert Pt Due Dary Late 30 &0 90 120 150 180
Sddress Type  Currert Maiing  Phone [o2r0z001 [1o0z00z | [ [ sseeea | 10 [ o o of of 1 [ 3
[Hove @ I |s06-ga7garr - Last Prot At Pt Ot Last Bill At Last Activity Dt Miltary Duty e Y ]
1232 £ FRONT ST [ $0.00 | | 916,042.23 [osn 42004 I . ——1——
MISSOLIL & MT-53802 Producer [CA-00003 : ACE HEADQUARTERS INC Behavior Score 0 Deys Catagory Collzctor
o App # 0000057135 Customer Grade [C GRADE  Scare 300 183 [180 DEMOCOLL

However, an account can have more than one condition, so an account can be in more than
one queue.In the example below, the single account for Hughs Meyers has two different
conditions, Schedule for Chargeoff and Delinquent. It can appear in two different queues,
one for Schedule for Chargeoff and one for Delinquent.

' MEYER H
Search o 0 e 2uto Run SO g o Status Froduct Payoif Amt AmtDue  Oldest Due Dt Company Branch
[PeLmauent @eFaLTy | T mz | m 2001020003626 BcmvepeLascHEpULED | LEasE vEHICLE $11,552.95 31117282 [o2n0200 [s5FC [Ha N
Acc #[2001020001 3626 [20040700014238 ACTIVE |LEASE WEHICLE $9,778.98 30.00 [08 42004 [55FC [Ha ~]
Or 55N Total $21,431 83 §11,172.92 #o0f Accounts 2
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (41 RepoForeclosurs (5) Deficiency (61 Cortract (7] Collateral () Bureau (3) Comments (107
Account Details [ Customer Details EUEHEES Balances Transactions Tracking Aftributes Statements B Insurances endor Work Orler
.C“"“"“e's Dy s T | Conditions, - 5oy, Start Dt Followup Ot
IHLIGHS L MEYER JR IPR\MARY =) o) $11,652.95 DOIdeDSt‘ Dus Dt ni::"?mnm || T S| e | |
- ue I*
[DELINGUENT 03/20/2001_[D5/512004
Gt s8N Birth Dt E— Detty e | $11,172.82 1 [mr102004 | 540,82 |,==— =
[ 72181 [ro-xx-7766 [0 /221970 | LC Due $308.96 2 [12r10/2003 329520 i b
Emeil [NONE NSF Due $0.00 3 [11/10/2003 $295.20 [ -
| angusge [ENGLISH Merital 5t Cther Due $0.00 4 [1010/2003 $295.20 [
Disaility [ skipl” Stop Correspondence[ || Totel Due $11,482,88 5 (09402003 $9,448.40 [ =
Privacy Opt-Out¥ Time Zone Active Miitary Duty [ Activity Delinquency Information
Contact Information Effective DI Active Dt Peid Off Dt Chargeoff Dt CurrentPml  DueDay | Late 20 60 90 120 150 180
Address Type Current Maling  Phone [0z /200 [romoszo0z | | [ $295 20 10 ol o of of of aof =
HOME 7 I  |oas-888-7765 |~ Last Pt &t Prrt Ot Last Bill &t Last Activity DU Millary Duty Y )
9576 M ELM DR [ $0.00 | | 11,452 68 |06 4/2004 I
BPNSF (Vear) i i
BEVERLY HILLS CA-80210  Proshucer |H-00003 : HAWAN MITSUBISHI-PEARL CITY Betavior Score 0 Days Category Callectar
= fpp # [00O00B1135 Customer Grade [C GRADE  Score| 300 b [160 DEMOCOLL
Call Activities | Promises Comments Checklist References  Payment Rating History  Due Date History
Action Result Contact Reason Promise Dt Promise Amt Cancel  Condtion Followup Dt Time Zone AdiFallowup Dt Appt
[} $0.00 [ [SCHGOFF L=
r r
r [
r [
r El=]
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Multiple queues can be created for a single condition. Account attributes (such as number
of days delinquent and product code) can be used for assigning accounts to a queue and
sorting accounts within a queue.

You can quickly load an account from a queue using the Next Account feature in the Cus-
tomer Service form master block.

To use the Next Account feature
On the Lending menu, choose Customer Service.

In the Search block of the Customer Service form master block, select the queue you want
to work with in the Queue field and choose Next Account (Nx).

Oracle Daybreak displays the account details for you on the Customer Service form’s
Account Details page.

Note: The accounts are selected from the predefined queue based on the following criteria:

* Accounts in the appointment list
*  Accounts with the oldest next follow-up date and time
*  Accounts meeting the sort criteria defined in the Queue Setup.

If the user has the authority to review queues without entering call activities, then only
those accounts based on the sort criteria are selected.

To use the Auto Run feature
On the Lending menu, choose Customer Service.
In the Search block of the Customer Service form master block, select Auto Run.

Oracle Daybreak displays the account details for you on the Customer Service form’s
Account Details page.
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Customer Service form’s master block

The Customer Service master block contains the Search block and the Accounts block.
The Search block allows you to search for and load an account. The Accounts block pro-
vides a quick overview of an account by displaying its status, lease type, payoff amount,
oldest due date, company, and branch. The information on the Customer Service form
always refers to the account selected in the master block.

To view an account’s details in the master block

Open the Customer Service form and load the account you want to work with.

On the Customer Service form’s master block, view the following information in the

Accounts block:
In this field:

Acc#

Status

Product

Payoff Amt

Amt Due

Oldest Due Dt
Company

Branch

Total (Payoff Amt)
(Total) (Amt Due)
# of Accounts

View this:

Account number.

Account status.

Product.

Payoff amount.

Delinquent amount due.

Due date.

Company.

Branch.

Total payoff amount.

Total amount due.

Total number of accounts that the customer has in Oracle
Daybreak, regardless of status (this includes closed
accounts).
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Customer Service (2) master tab

The Customer Service (2) master tab contains information that is useful to all customer
service personnel. The master tab contains the following pages:

e Account Details

e Customer Details

e Balances

¢ Transactions

¢ Statements

e Escrow (available if this account contains escrow information)
* Insurances

¢ Vendor Work Orders.

Account Details page

The Account Details page displays information about the current state of the account.It’s a
quick snapshot of the most important account-related information, including:

*  Customer and contact information

*  Dues (including delinquencies, late charges, and nonsufficient funds)
* conditions

» Dates of activities and payments, as well as payment amounts

e Number of delinquencies by length of overdue payment

e Number of broken promises

*  Number of nonsufficient funds.

To view the Account Details page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose Account Details.

Search o0, Auto Run Status Product Payoff Amt AmtDue  Oldest Due Dt Company Branch
™y 0 120 |cHARGED OFF | LEASE WEHICLE | sann | $000 042222007 [s5FC [eot -
A #2001 0200031 543 [1120200032343 |cHarzED OFF [CEasE vEHICLE | 000 | $000 04222007 [ssFc [con ~
or SSN Showe &1l TUlaI| $0.00 | $0.00 # of Accounts: 6
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (6] Contract (7) Collsteral (8) Bureau (9) Comments (100
Account Details { Customer Details HUEESS: Balances Tranzactions Tracking Aftributes Statements Exere Insurances Sendor Wiork Order
lclusmmers : gucs] . Conditions; i, Start Dt Followup Dt
= [
JOHN ABRAHAM PRIMARY = Payott $0.00 ;"’EDS: Bue B le;mm B [SKIP TRACE ASSIGNMENT (1102772009 [11/30/2009 ||~
- e
ILEE K ABRAHAM [sPousE |cREDIT NSURANCE anD wa (112772009 [11/30/2008
Customer # SEN Birth Ot Gender Delg Dus | $0.00 1 (082212007 | $0.00 | | | -
[ 219690 brx-xx-1213 0314973 [UNKNCIAN LC Due | $0.00 2 [o7rz22007 | $0.00 =
Email NOHN.ABRAHAMZGMAL COM NSF Due | $0.00 | 3 [0gr22r2007 | $0.00 I A
Language [ENGLIEA Marital 5t [MARRIED Cther Due | $0.00 4 05220007 | $0.00 I
Dissability skl Stop Correspondence | || Total Due| §0.00 5 [04rz2i2007 | F0.00 [ =
Privacy Opt.0ut Time Zane Active Witary Duty | petivity Delinquency Information
g Effective Dt Active Dt Paid Off Dt Chargeoff Ot Currert Pt Due Day Late 30 &0 90 120 150 180
Contact Information
Boldress Type CurrentConfrmeshaiing  Fhone [o3z2i2007 [o3ez22007 |01 2000 (010010 | gsasae | 22 [ z[ z2[ 2] 2[ z2[ 1] 2
[Hove W [ IV [12a456 7800 |~
HOME 123-456-7890 |~ Last Prrt At Pt Ct Last Bill Amt  Last Activity Dt Military Duty BPMEF rLife) ’70 ,70
a3 [ $0.00 01012000 [ §44,486.88 (01212010 [ N
Ear]
EDEN PRAIRIE MN-55344 Producer NC-D0003 ; JENKINS [NYESTMENT Behavior Soore 0 Deys Category Collector
- Lpp # (20010200031 543 Customer Grade [C GRADE | Scare| 800 of [pEMOCOLL
Call Activities { Fromizes Comments Checklist References Payment Rating History  Due Date History
Action Result Contact Reason Promise Dt Promise &mt Cancel  Condition Follovwup Dt Time Zone L. Follovwup Dt Appt
mlcc |Hu | [ | $0.00 [ |NGHE [11/30/2009 04:47:19 AM | [11/30/2009 044718 AM T~
cc =3 [ [ [11.2772009 | $200.00 v [NONE [11.3002009 044534 am | [11r3002009 04:45:34 2w [
lcc [P | [ f127i2009 | $101.00 | [NONE 1143002009 04158 AM | [11r3002009 04:41:58 &M [
[T T [ [ [ [ $000 [ | [DELG [11.021 2008 02 2147 am | [11r2102008 092147 apa [
[To |Lm [ [ [ [ $0.00 [ [uone [11:21,2008 09:21:04 M | [11e2102008 09:21:04 2 [~
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3 View the following information:

In this field:

Customers block

Customer Name (unlabeled)
Relationship (unlabeled)
Customer #

SSN

Birth Dt
Gender
Email
Language
Marital St
Disability

Skip

Stop Correspondence

Privacy Opt-Out

Time Zone
Active Military Duty

Contact Information block
Address Type

Current

Mailing

Phone

Address (unlabeled)

Dues block
Today’s Payoff
Oldest Due Dt
Delq Due

LC Due

NSF Due
Other Due
Total Due
Due Dt (1)
Amt (1)

Due Dt (2)
Amt (2)

Due Dt (3)

View this:

Customer name.

Customer’s relationship to the account.

Customer number (unique customer identifier).
Customer’s social security number. Note: If the organiza-
tional parameter UIX_HIDE RESTRICTED_ DATA is set
to Y, this appears as a masked number; for example,
XXX-XX-1234.

Customer’s date of birth.

Customer’s gender.

Customer’s email address.

Language spoken by the customer.

Customer’s martial status.

Customer disability indicator If selected, this indicates
that the customer is disabled.

Customer’s skip indicator. If selected, this indicates that
the customer is a skip debtor. This is selected using the
Maintenance (3) master tab.

Stop correspondence indicator. If selected, Oracle Day-
break will not send correspondence to customer. This is
selected using the Maintenance (3) master tab.

Privacy opt-out indicator. If selected, indicates that the
applicant has elected to refrain from the non-public shar-
ing of information (optional).

The applicant’s time zone.

Active military duty indicator. If selected, indicates that
the customer is on active military duty and may qualify
for the rates in accordance with the Servicemembers
Civil Relief Act of 2003 (SCRA).

Address type.

If selected, indicates that this is the current address.
If selected, indicates that this is the mailing address.
Phone number.

Address details.

Payoff (for today).
Due date.
Delinquent amount.
Late charges due.
Nonsufficient funds fee due.
Other dues.

Total amount due.
Due date.

Amount due.

Due date.

Amount due.

Due date.
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Amt (3)
Due Dt (4)
Amt (4)
Due Dt (5)
Amt (5)

Activity block
Effective Dt

Active Dt
Paid Off Dt
Chargeoff Dt
Current Pmt
Due Day

Last Pmt Amt
Pmt Dt

Last Bill Amt

Last Activity Dt

Producer

Behavior Score

App#

Customer Grade

Score
Military Duty

Conditions block

Condition
Start Dt
Followup Dt
Alert

Delinquency Information block

Late

30

60

90

120

150

180

BP (Life)

NSF (Life)

Amount due.
Due date.
Amount due.
Due date.
Amount due.

Account effective date.

Date account was made active.

Date account was paid off.

Date account was charged off.

Current payment amount.

Due day for payment.

Last payment amount.

Last payment date.

Last bill amount.

Last activity date.

Channel and producer of the account.

Behavior score.

Application number from which this account was cre-
ated.

Displays the customer grade.

Displays the score.

If selected, indicates that at the time of billing, the cus-
tomer was in active military duty and qualifies for rates
in accordance with Servicemembers Civil Relief Act
(SCRA) 0f2003.

Condition.

Start date.

Next follow-up date.

Alert on the account (This is a message marked “alert” on
the Comments master page or Comments sub page.)

The number of times less than 30 days delinquent over
the life of the account.

The number of times 30 days delinquent over the life of
the account.

The number of times 60 days delinquent over the life of
the account.

The number of times 90 days delinquent over the life of
the account.

The number of times 120 days delinquent over the life of
the account.

The number of times 150 days delinquent over the life of
the account.

The number of times 180 days delinquent over the life of
the account.

The number of broken promises over the life of the
account.

The number of nonsufficient funds over the life of the
account.
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BP (Year)
NSF (Year)
Days

Category
Collector

The number of broken promises this year.

The number of nonsufficient funds this year.

The number of days delinquent. A negative number in
this fields denotes the number of days until a payment is
due.

The delinquency category.

The default collector working on the account.

Account Details sub pages

The Accounts Details page shares the same sub pages with the Customer Details, Business
and Vendor Work Order pages, as well as the Bankruptcy (4), Repo/Foreclosure (5), and

Deficiency (6) master tabs: Call Activities, Promises, Comments, Checklist, Refer-
ences, Payment Rating History, and Due Date History.

Search o .

Effective Ot Active Ot Paid Off O Chargeotf 0t Cutrert Pt Due Day

Contact Information
|naz2rz007 (03022007 [0101/2000 [0 o500 |

Address Type Current Confirmedhailing

Phane

Late 30 ED

wasaa | 2 [ 2] 2 2[ 2] 2[ [ 2z

Auto Run Status Product Payotf Amt At Due (Cldest Due Ot Company  Branch
[ by 0010200031543 |cHarcED OFF [ LEASE VEHCLE | $0.00 | $0.00 (04222007 [SEFC o =
Acc #120010200031 543 [1120200032343 [cHaRGED oFF [ LESSE WEHICLE | 0,00 | $0.00 (04222007 [SSFC o ~
or S3H Shaiw Al Total| 5000 | $0.00 #of Accounts 6
Search (1) Customer Service (2) | Mairtenance (3)  Bankruptcy (4)  RepoForeclosure (51 Deficiency (6) Contract (7) Collateral (8) Bureau (9) Comments (100
CCOul allz Ustomer allz IS ES5 lalances ransactons Facking iglalh) (=3 EMENTs SR NSUrances Encor VYor] Lel= g
Acoourt Details | Custamer Detail ] Bal Tranzacti Tracking Attriout Statement E I “endor Vork Oreh
.Custumers D“f‘:dsay's Conditions,- i, Start Dt Followup Dt
B [
IJOHN (R }PR'MARY = Payott I [?‘“e;: DEC Uﬁf’w” B [SKP TRACE ASSIGNMENT  [11/27/2009 [11/30/2008 | 4
ILIE
LEE KSR AHAN SPOLSE M [CREDIT INSURARCE AND Wi [11/27/2009 [11/30/2009
Customer # Ssh Birth Ot Gender Dl Due [ $000 1 [namzrz007 | $0.00 i | i |
-
[ 219880 [xocx-1213 0341171873 [UNKNOAN LC Due| $0.00 2 07220007 | .00 ]
Ernail MOHM. ABRAHAMEGMAIL COM MSF Due | $0.00 3 (0622007 | $0.00 [ =]
Langusge [ENGLISH e T Gther Due | $0.00 | 4 052202007 | $0.00 ‘
Dissbiity [ sip | Stop Correspondencel | || Totel Due| 000 5 [p4i2212007 | 0.00 \ =
Frivacy Opt-out¥ Time Zone Active Miitary Duty T Activity Delinquency Information

90 120 150 180

Home W O W [1234se7600 [~ LastPrt At PrbDt LastBil Amt Last Activty Dt Miltary Duty s I
123 [ $0.00 01012000 | §44,486.88 (01721 2010 I o DD
EDEM PRAIRIE MN-55344 Froducer [MC-D0003 | JEMKINS INVESTMENT Behavior Score| 0 Days  Catedory Callectar
&= App# IW Customet Grade ,m Soore ’W ,_DI—W
II Call Activities I Promises Comnments: Checklist References Payment Rating Histary  Due Date Histor\l
Action Resutt Contact Reason Promise Ot Promize Amt Cancel  Concition Follatseup Ct Time Zang A, Falloseu Ct Appt
mo |Hu [ | [ | $0.00 [ |MonE [1r30:2009 044719 2w | [11rs02009 0aama am T
lcc |pp [ | [11/27:2000 | $200.00 [ [NOME [11/3002000 04:45:39 2w | [11/302000 04:45:34 am [
[cc [pe [ | [11727.2000 | $101.00 [ [NONE [11720/2000 04:41:58 am | [11/30/2009 04:41:58 aM [
[ro [ [ [ [ [ $0.00 [ [pELG [1172122008 08:21:47 2w | [11721 /2008 09:21:47 am [
[ro [ [ [ [ [ $0.00 [ juoNE [11721,2008 08:21.04 21 | [11721 /2008 09:21:08 aM [~

Using these sub pages, you can complete the following Customer Service tasks:

* Record call activity

*  Make and cancel an appointment

* Cancel a promise to pay

*  View payment promises

* Record additional comments

*  Complete a checklist

* Record a new reference

*  View the customer’s payment rating history
*  View the customer’s due date history.
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Using the Call Activities sub page

With the Call Activities sub page, Oracle Daybreak allows you to record the details of all
actions performed regarding this account. This includes calls from the customer, calls you
make regarding the account, or changes to the condition of the account. Entries in the Call
Activities page are listed in reverse chronological order of follow-up date.

Note: Call activity action codes (Action field) and call activity results codes (Results field)
are user-defined.

The code for the call action and call result is what appears on the Call Activity sub page.

To record call activity
Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

Choose the Call Activities sub tab.

Search o0 Status Product Payoft Amt AmtDue  Oldest Due Ot Comparry Branch
|cHaRGED OFF | LEASE VEHICLE | g0.00 | $0.00 [ndeozionn7 [ssFC oot -
A6 #120010200031543 |cHarGED OFF [CEasE vERCLE | 30.00 | $0.00 [04i22i2007 [SSFC [con )
Or SN Show 211V Total| $0.00 | $0.00 # of Accounts &
Search (1) Customer Service (20 Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (51 Cortract (T) Collatersal (8) Bureau (9) Comments (10)
Account Details l Customer Details ENENEsSS Balances Transactions Tracking Attributes Statements SO Insurances Yendor Work Order
Customers -~ D}J:;ay\s Conditinnstondmn Start Ot Followup O
u }‘JOHN EERAHAM }FR‘MARY = Payoft 3000 ;MEDS: bue bt nx:ﬂzxzmn B [SKIP TRACE ASSIGNMENT  [11/27/2009 [11/902008 =
LEE K ABRAHAM SPOUSE = ue
CREDIT INSURANCE AND W4 11/27/2009 [11/30/2009
Customer # S3H Birth Dt Gender Del Due [ $0.00 1 [08/22/2007 | 30.00 } } } =
[ 219690 poornx-1213 03411973 [UNKROwWN L Due | 000 2 0772272007 | $0.00 e
Email [JOHN. ABRAHAMEGMAIL COM MSF Due | $0.00 3 [06/22:2007 | $0.00 ‘ &)
Language [ENGLIEH Marital St MARRED Gther Due | $0.00 4 052202007 | $0.00 [
Disabilty ™ il Stop Correspondence [ || Totel Due | f000 5 0472272007 | $0.00 \ =
Privacy Opt-Outh Time Zone Active Miltary Duty T activity DolerGer o aation
Contact Information Effective Ot Active Ot Paid Off Ot Chargeotf Ot Current Pt Due Day Lste 30 B0 90 120 150 180
2ddress Type CurrertConfirmecMaling  Phone |par2202007 [03r2202007 [01001 /2000 [01m502010 | gsagae | 2 2[ 2 2 z2[ z2[ [ 2
456
HOME v [ W [123.4567890 |~ LastPmtAmt  PmtDt  LastBilAmt Last Activity Ot Miltary Duby e i ([
123 [ $0.00 (12000 | $44,496.88 (017212010 I -
EDEN PRAIRIE MN-55344 | [producer [c-00003 : JENKING INVESTMENT Behavior Soore i Days Cetegory Collector
= App # [20010200031543 Customer Grade [C GRADE  Score| 600 of [pEMOCOLL
Call Activities l Promises Comments Checklist References Payment Rating History  Due Date History
Action Resuft Contact Reaszon Promize Ot Promise Amt Cancel  Conclition Followup Dt Time Zone L. Followup Ot Appt
mlcc [Hu [ | | [ 50.00 [ [NoRE [11/30/2009 044718 AM | [1/30/2009 044718 a0 [ =
e [pe [ [ [11:2772009 | $200.00 b [MONE [11r30r2009 04:45:34 am | [11/30/2009 04:45:34 am [
lcc pe [ | [112772009 | $101.00 I [NONE [11r3002009 044158 M | [11/30/2009 04:41:58 A [
[t [ra [ [ [ [ soon [ [DELa [11r21r2008 082187 2w | [11/21 /2008 09:21:47 am [
[ro |Lr [ [ [ [ g0.00 [ |uone [11:21r2008 09:21:04 am | [11721 /2008 09:21:00 am [~
4 In the Action field, select the action performed.
5 In the Result field, select the result of the action.
6 If you want, complete the following optional fields:
In this field: Do this:
Contact Select who you contacted.
Reason Select the reason for the communication.

In the Condition field, select the condition or queue type. Conditions determine the
queue/condition for the contents of the Action field and set the follow up data for that
queue/condition.

The LOV that is used in the Condition field is the intersection of the list of condition set-
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ups for what is entered in the Action and Result fields and the open conditions on the
account.

8 In the Followup Dt field, type the next follow-up date; that is, the next scheduled review.
(This may automatically default based on setup.)

9 In the Time Zone field, view the default time zone for the customer. You can update this
information if necessary.

10 In the Adj. Followup Dt field, view the adjusted followup date based on the contents of
the Followup Dt and Time Zone fields.

Note: This information appears after you save the entry.
11 Save any changes you made to the account.

Oracle Daybreak automatically creates a comment for your entry on the Comments sub
page and master tab using the description for the call action and call result, not the code.

Making an appointment

The Appointment box on the Call Action sub page allows you to schedule an account to
appear in a particular queue at a future date and time. When you make an appointment, the
account will appear in the front of the queue listed in the Conditions field at the time listed
in the Followup Dt field.

Note: You must be working that queue at the followup time in order to view the account.

To make an appointment
1 Complete the fields on the Call Action sub page (see above, To record call activity).

2 In the Condition field, select the condition for the queue you want the account to appear
in.

3 In the Followup Dt field, type the date and time you want the account to appear. This can
be either the current day or a day in the future.

4  If necessary, update the Time Zone field if the customer is going to be in a different time
zone at the time of the appointment.

5 Select the Appointment box.

Note: If account was not worked within the queue on day of the appointment, the nightly
jobs will cancel the appointment. Also, if the account’s queue condition changes during
the nightly batch jobs, the outstanding appointments are cancelled.
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Canceling an appointment

Using the Call Activities sub page, you can cancel an appointment for an account. The
account will still appear in the queue on the follow up date, but no longer receive a prior-

ity.
To cancel an appointment
Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

Choose the Call Activities sub tab.

If you need to change the time for the appointment, create a new entry on the account’s
Call Activities sub page with the same condition, but enter a new followup date.

If you need to cancel the appointment, create a new entry on the account’s Call Activi-
ties sub page with the same condition, but don’t check the Appointment check box.

Save any changes you made to the account.

Recording a promise to pay

AN »n B~ W

If you record an action on the Call Activities sub page as a “promise to pay,” it appears on
the Promises sub page. The Promises sub page allows you to quickly view these actions
without searching for them individually and displays the 25 most recent promises to pay.

To record a promise to pay
Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

Choose the Call Activities sub tab.
In the Action field, select the action performed.
In the Result field, select PP PROMISE TO PAY.

If you want, complete the following optional fields:

In this field: Do this:

Contact Select the contact type. (Who was the person you com-
municated with?) (optional).

Reason Select the reason, as stated by the contacted person.
(What is the reason for this contact?) (optional).

Promise Dt Record the date when the person you spoke with prom-
ises to make payment (optional).

Promise Amt Record the amount of the payment the person you spoke

with promises to make (optional).
In the Condition field, select the condition or queue type.

In the Followup Dt field, enter the next follow-up date for the promise-to-pay or accept
the default date.
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9 Save any changes you made to the account.

Oracle Daybreak automatically notes this information as an entry on the Promises and
Comments sub pages.

Canceling a promise to pay

Oracle Daybreak allows you to cancel promises to pay with the Call Activities sub page.
You would do this when a customer informs you prior to the promise date that he or she
cannot make the payment.

To cancel the existing promise to pay
1 Open the Customer Service form and load the account (lease) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

3 Choose the Call Activities sub tab.
4 To find the existing promise to pay:

»  Press F7 to move to Enter-Query mode.
_Or_
* Select Enter Query button on the tool bar.

5 Search for the promise to pay you want to cancel using the Promise Amt field or Promise
Dt field.

6 Press F8 to perform the query.
_Or_
Select Execute Query button on the tool bar.

7 In the Call Activities sub page, select the promise you want to cancel.
8 Select the Cancel box.
9 Save the changes you made to the account.

The promise is marked as canceled and will not be considered when processing promises;
in other words, it will not be counted as either satisfied or broken.
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Using the Promises sub page

If a call was recorded as a “promise to pay” on the Call Activities sub page, it will appear
on the Promises sub page. The Promises sub page allows you to quickly view details about
the call and subsequent actions and displays the 25 most recent promises to pay.

If Oracle Daybreak does not receive the promised amount before the promised time, it
notes the broken promise on the Delinquency Information block of the Account Details
page.

To view payment promises for an account

Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

Choose the Promises sub tab.

Contact Information

Address Type CurrentConfirmecihsiling Phone

Eftective Ot Active Ot Paid Off Dt Chargeoff Ot Currert Pt
032202007 [03r22/2007 [01/01/2000 [010502010 |

Dus Day

Search ¢ cue Auto Run Accounts ;. y Status Product Paryoff amt &mtDus  Oldest Dus bt Company Branch
[ hx | m S ] |cHARGED OFF | LEASE vEHICLE | $0.00 | $0.00 [D4r222007 [SSFC [Co1 -
Ao #|20010200031543 [1120200032343 |cHARGED OFF | LE#SE wEHICLE | $0.00 | $0.00 (045222007 [SSFC [CO1 =]
Or 55N Show Al Total| $0.00 | $0.00 # of Accounts &
Search (1) Customer Service (2) | Maintenance (3)  Bankruptey (4 RepoForeclosure (5] Deficiency (8) Contract (7) Collatersl (5) Bureau (3) Comments (10)
Accourt Details || Customer Details Hlisirse Balances Transactions  Tracking Aftributes  Statemerts Exsriny) Insurances “Wendor Work Order
.c"smmers - D s F—0 Conditions; - jiicr, Start Dt Followup Dt
HOHR AERAHAM PRMARY = Payoff 000 ;"de;: bue bt ULﬁQ°1° B [SKIP TRACE ASSIGNMENT  [11/27/2009 [11/3002009 |
- e
(RN o |cREDIT INSURAMCE AnD vz 112772008 1173002008
Customer # S5H Birth Dt Gender Delq Due | $0.00 1 [08/22/2007 | $0.00 | | | =
[ 219690 o1 213 [03A1M973 [UNKNCWR LG Due | $0.00 2 07222007 | $0.00 R
Ermail [JOHM ABRAHAMEGMAIL COM NSF Due [ 3000 3 [06/22/2007 | $0.00 [ =
Langusge [ENGLISH Marital St MARRIED Gther Dus | $000 4 [os2z007 | $0.00 [
Disabity skip— Stop Correspondence [ || Totel Due| $000 5 |04/222007 | $0.00 [ =
Privacy om.om’\_l Time Zone Active Military Duty V_ Activi

Delinquency Information
Late 30

B0 90 120 150 180

ssssas [ 2 [ 2] 2] of 2[ 2 1 2

Home ¥ [ I [1z3-456-7800 (= Last Pt Amt Pt Dt Last Bil &mt Last Activity Dt Military Duty o ) )
123 [ $0.00 |01/01 72000 | $44,486 58 [01/21/2010 r N -
EDEN PRAIRIE MN-55344 Proncer [NC-O0003 - JEMHING INVESTMENT Behavior Score| 0 Beys Gy Collector
= App# (2010200031543 Customer Grade |C GRADE  Seors| 500 [ o[ pEmocoL
Call Activities Promises COmIments Checklist References Payment Rating History  Due Date History
Promise Amt  Promise Di Taken By Taken Dt Collected At Broken Cancelled
L [ I [ soon [ r —
[ 50.00 | [ [ [ $0.00 C r
[ $0.00 | [ [ [ sooo [ r —
[ $0.00 | [ [ [ $0.00 I I
[ $0.00 | [ [ [ $0.00 r I =

In this field:

Promise Amt
Promise Dt
Taken By
Taken Dt
Collected Amt
Broken
Cancelled

View the following information:

View:

The amount promised.

The date the promise was made.
The user who took the promise.
The date the promise was taken.

The amount collected against the promise.

Indicates if this is a broken promise.
Indicates if this is a cancelled promise.
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Using the Comments sub page

Oracle Daybreak allows you to record comments on the Customer Service form using the
Comments sub page. These comments can also appear on the Comments (10) master tab.

To record an additional comment
1  Open the Customer Service form and load the account (lease) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

3 Choose the Comments sub tab.

Auto Run Accounts

Ao # Status Product Payoff Amt Armit D Oldest Dus Ot Company  Branch
(R I 01 020 434 |cHARGED OFF | LEASE WEHICLE | $0.00 | $0.00 [o4zz007 [ssFC oot -]
Ace #]20010200031 543 [1120200032343 |cHaRGED OFF | LEASE vEHICLE | $000 | $0.00 [nazo007 [ssFe oot B
Or S5 Show &l Tatsl| $0.00 | $0.00 # of Accounts 5
Search (1)1 Customer Service (20 | Maintenance (3)  Bankruptcy (4) RepofForeclosure (3] Deficiency (6) Cortract (7) Collateral 18) Bureau (31 Comments (10)
Account Details [ Customer Details EUETESS Balances Transactions Tracking attributes Statements ST Insurances Yencor Work Order
.c‘“s“"“e’s ‘ Dpes e Conditions, o hion Start Dt Followup Ot
L] e (g T = Payort .U DC’MBDS: SRS U:’::mm B [SKIP TRACE ASSIGNMENT  [11/27/2009 [11/30/2009 | =
LEE K ABRAHAM SPOLISE ~ uie
i ‘ |CREDIT INSURANCE AND W [11/27/2009 [11/30/2009
Customer # 5N Birth Dt Gendsr Dl Due $0.00 [ 08722/2007 $0.00 ‘ | | =
[ 219680 [ooemo-1213 03111873 UKo LC Due $0.00 2 [07/22/2007 $0.00 T
Email [ JOHN.ABRAHAM@GMAIL COM NSF Due $0.00 | 3 06222007 $0.00 &)
Language [ENGLISH Marital 5t [MARRIED Gther Due [ $0.00 4 [05r22/2007 | $0.00 [
Digability [ Skip ™ Stop Correspondence Totl Due [ $0.00 5 (041222007 | $0.00 [ =]
Privacy Opt-Outh Time Zone Active hilitary Duty [ Activity Delinquency Information
= Effective Ot Mctive Ot Paid Off Dt Chargeoff Dt Currsrt Pt DusDay | Late a0 &0 490 120 150 180
Contact Information
Address Type CurrertConfirmediaiing  Phone |03rz2i2007 [0arz2r2007 |01/01/2000 010502010 | $538.45 22 2[ 2 2 2] 2 1] =2
HOME I [ [ 456 - Last Pt Amt Pt Dt Last Bill Amt  Last Activity Dt Military Dut
123-456.7890 |~ a ast Bi el Ay itary Duty BRMSF (i) 0| 0
23 [ $0.00 (01012000 | §44 486.88 |01,212010 [ P o
ear
EDEN PRAIRIE MN-55544 | producer [Mc-00003 : JENKINS INVESTMENT Behavior Score 0 Days Catetory Collector
hd App # {2001 0200031543 Customer Grade [C GRADE  Scare| 600 0 DEMOCOLL
Call Activities Promises Cotmments Checklist References Payment Rating History  Due Date History
Alert Type Sub-Type Commert
u [ [SYSTEM GENERATED  [SYSTEM GENERATED  [scC_STATEMENT LETTER GEMERATED. (CORRESPONDEMCE: CHLNOE_STM_LTR JOB REGUEST ID: 1704753) 2]
[INTERRIAL |01/08r2010 01:05:08 P |-
[ [VSTEM GENERATED |5¥STEM GENERATED ACC_STATEMENMT LETTER GENERATED. (CORRESPOMDEMCE: CHMLMOE_STM_LTR JOB REQUEST IC: 1 704753)
[INTERRIAL |o1/08r2010 01:05:08 PR =

4 If you want to tag this comment as important, select the Alert box.

Note: If you select the Alert box, the comment appears on the Customer Service form’s
Account Details page in the Alert field on the Conditions block.

In the Type field, select what type of comment you are adding.
In the Sub Type ficld, select what sub type of comment you are adding.

In the Comment field, type your comment.

o 3 N W

When you are finished, save the changes you made to the account.
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Using the Checklist sub page

3

Oracle Daybreak allows you to create checklists to ensure that procedures are followed to
complete various tasks. This information appears on the Checklist sub page.

To complete a checklist for an account
Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

Choose the Checklist sub tab.

Search o, o

Pending Reguest

Privacy Opt-cut¥ Time Zone Ative hilitary Duty

Contact Information

Address Type Current Confirmedidsiling Phone

Status Product Payoff Amt Amt Due Oldest Due Ot Company  Branch
r 3 |cHARGED OFF LEASE VEHCLE | 30,00 | $0.00 04/222007 [SSFC [cm -
Acc #20010200031543 [1120200032343 |CHARGED OFF | LEASE VEHICLE | 3000 | $0.00 04/222007 [SSFC [cm ~
r SEM Show Al Total | $0.00 | $0.00 # of Locourts &
Search (1] Customer Service (2) | Mairtenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (6) Contract (7) Collstersl (8) Buresu (9] Comments (100
Account Detsils l Customer Detsils Elinzs Balances Transactions Tracking Attributes Statements EECTE Insursnces “endor Work Order
.Clusmmers ; i w0 T Conditians:  giion Start Dl Followup Dt
Sl e T PRIMARY = | payort o ;'de;t D bt E'Lﬁfﬂ”m B (3P TRAGE ASSIGNMENT [11/27/2008 [11/30/2009 |~
e
(R EEEE = [CREDIT INSURANCE AND e [11/27/2009 [11r30/2009
Customer # SSh Bitth Dt Gender Dl Due | 5000 1 [osiz2007 | $0.00 ‘ | | !
=
[ 219680 [oeo-1213 (03111973 [UnKnciAN LCDue | $0.00 2 07222007 | $0.00 e
Email [JOHN 2BRAHAME@GMAIL COM NSF Due | $0.00 3 06222007 | $0.00 [ &l
Language ENGLIEH Marital =t [MARRED Cttver Due [ $0.00 4 0522007 | $0.00 ‘
Disabilty [ Skipl— Stap Correspondence || Total Due | §0.00 5 |0422/2007 | $0.00 ‘ =

Activity

Effective Ot Active Dt Paid Off Ot Chargeoff 0 Current Pmt  Due Day
|os22r2007 |0322r2007 [01/01 /2000 j01 052010 |

ssagas | 220 [ z[ z[ 2] 2] 2] 4 2

Delinquency Information
Late 30 &O S0 120 150 1&0

I r i o — - -
HOMWE 123-456-7800 = Last Pt Amt Prmt Ct Last Bill Amt  Last Activity Dt Military Duty BRMSF (Life) ,_El ,_El
= [ $O.00 01012000 | $44 456,88 [0121/2010 P ———
EDEN PRAIRIE MN-55344 Producer [NC-00003 © JERKINS INVESTMENT Behavior Scare i Bege  EoiEEy Collector
= App # |2001 0200031543 Customer Grade |C GRADE  Score B00 o DEMOCOLL
Call Activities Fromises Comments Checklist l References Payment Rating History  Due Date History
Checklist Comment Complete Checklist Type
[ | | = Load Checkiist
Action ez Mo MA Commert
u| e el | -
[ o oo |
[ @ @ @ | =]

In the Checklist Type field, select the type of checklist you want to complete.
Choose Load Checklist.

Oracle Daybreak loads the type of checklist you choose in the Checklist box and the
checklist in the Action column.

As you follow the actions in the checklist, note your work with the Yes/No/NA option but-
tons.

Note: You can add comments to each action on the checklist in the Comment column.
When you complete the check box, select Complete.

Save your entry.
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Using the Reference sub page

The References sub page allows you to attach new references to an account at anytime, as
well as view the references attached to the account during the lease origination cycle.

To add a new reference to the account
1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

3 Choose the Reference sub tab.

nding Reguest: 0) .-

Search o0 e Auta Run £ Status Product Payott Amt AmDus  Oldest Dus DtCompany Branch
g | m [ 543 |cHARGED OFF LEASE VEHICLE $0.00 $0.00 (0402272007 [SSFC [cot -
Ao #[20010200031543 11202 3 [cHaReED OFF LEASE VEHICLE 0,00 30.00 [Darz2r2007 [sSFC oot =
Or s8N Show a1 Tatal $0.00 $0.00 #of dcoourts[ 6
Search(1)  Customer Service (2) | Malntenance (3)  Bankruptey (4)  RepoForeclosure ¢5)  Deficiency (8)  Contract (7) Callateral (3) Bureau(9)  Comments (10)
Account Detals | Customer Details EUBfizss Balances Transections  Tracking Atrbutes  Statements Tty Insurances  Vendor Wark Order
.C‘“"t“'“e”‘ | "}’;;av‘s  om CondRions, o, Stert Dt Followup Ot
‘JOHN AERAHAM lFR‘MARY = Fayott Sy DO'”ES‘ Due bt ”L’fﬁz’z”m B [SHP TRACE ASSIGNMENT  [11/27:2008 [11/30;2008 |~
LEE K ABRAHAM [sPOUSE < ue
[CREDIT INSURANCE AND W[1127/2009 [11/30/2009
Customer # EEl] Biirth Dt Gender Dl Due [ 3000 1 foarz2r2007 | $0.00 -
[ 219680 pocx-xx-1213 0311973 [UNKNCWN LS Due 30.00 2 0772202007 $0.00 P
Erail [JOHN ABRAHAME@CMAIL COM NSF Due $0.00 3 [oBrz2e2007 $0.00 [ (]
Language [ENGLISH Wartal 5t MARRED Other Dus 30.00 4 [osrz2e2007 $0.00 [
Disabality [ Skip™ Stop Correspondence || Total Due | 3000 5 047222007 $0.00 [ 5

Privacy Opt-outl¥ Time Zone Active Mitary Dty pegivity Delinquency Information
Contact Information Effective Ot Active Dt Paid Off Ot Chargeoff Ot Current Pmt  Due Day Late 30 &0 90 120 150 180
Adidress Type CurrertConfirmeialing  Phone [asz2r2007 [asz2r2007 [0 0172000 (o1 052010 | ssasas | 2= [ 2| 2 2] 2[ 2| 1| 2

B e ~ 5 : b
HOME 1254567630 (= LostPrmiAml  PmiDl LastBilAmi Last Activiy Dt Wilktary Duy e s G D
123 | $0.00 [01/012000 | $44,486.88 017212010 [ -
[EDEN FRAIRE MN-55344 Praciuzer [NC-00003 ; JENKING INVESTMENT Behavior Score [ o @ O i

=) App # [20010200031543 Customer Grade |C GRADE  Scors| 600 0 DEMOCOLL

Call Activiies Promises Comments Checkist References | Payment Reting History  Due Date History
Relationship | Hame | vis| 0 Mhs| 0 B
Address
Prone|  Edt|
City st zip [ country[Us Prone|  Ed|
Comment | =

4  Complete the text fields on the Reference sub page.
In this field: Do this:

Relationship Select the reference type (required).
Name Enter the reference name (required).
Yrs Enter the number of years (required).
Mths Enter the number of months (required).

Address Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).

St Select the state (optional).

Zip Extension (unlabeled) Enter the zip extension (optional).

Country Select the country (required).

Phone Enter the reference’s primary phone number (optional).

Ext Enter the reference’s primary phone extension (optional).

Phone Enter the reference’s secondary phone number (optional).

Ext Enter the reference’s secondary phone extension
(optional).

Comment Enter a comment (optional).

5 Save the changes you made to the account.
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Using the Payment Rating History sub page

The Payment Rating History sub page displays the month and year of payment and the rat-
ing reported to credit bureaus through the Metro 2 file for the past 24 months.

To view a customer’s rating history
1  Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the
Customer Details tab.

3 Choose the Payment Rating History sub tab.

Search -, o Auto Run Accounts

Acc # Status Product Payoit Amt &mtDue  Oldest Due Dt Company Branch
[ x| m 2GS 43 |cHaRGED OFF LEASE VEHICLE | 3000 | $0.00 [04222007 [ssFc [oom -
Acc #|20010200031 543 [1120200032343 |cHARGED OFF [ LEAsE vEHICLE | 30,00 | $0.00 [0dizzz007 [SSFC [cor -l
Or SSN Show Al Tatai $0.00 | §0.00 # ot Accounts 5
Search 111 Customer Service (2) | Maintensnce (3)  Bankruptcy (4) Repo/Foreclosure 131 Deficiency 161 Contract (7 Collsteral (31 Bureau (9] Comments 10)
Accourt Details || Customer Details EliEiicss Balances Transactions  Tracking Aftrioutes  Statements Eiziou Insurances “endor Work Ordsr
.c“"‘"'“‘“s D.'r‘;‘say.s CondRtions, . gijion Start Dt Followup Dt
IJOHN DA bl }PR'MARY = Payoff SI.00 Do‘de;t e olf:nmmo B [SKIP TRACE ASSIGNMENT  [11/27/2009 [11/502000 =
LEE K ABRAHAM SPOUSE - Ue
[CREDIT INSURANCE AND Wi [11/27/2009 [11/30/2009
Custamer # S5 Birth Ot Gender Dreley Dute | $0.00 4 [08iz22007 | $0.00 I I } =
[ 218690 froome-1 213 [03H1 4573 [UNKNOWN LC Due [ §0.00 2 [o7r2z007 | 3000 s
Ermail [JOHN. ABRAHAMEEMAIL COM RSF Due [ 5000 3 [osr22r2007 | $0.00 a
Lancuace [ENGLISH Merital 5t [MARRIED Cither Due | $000 4 [osreze2007 | $0.00 [
Disshilty zkip— Stop Correspondence [ Total Due | 3000 5 |04r222007 | $0.00 [ =
Frivacy Opt-out™ Time Zone Active Military Duty [ Activity Delinquency Information
Cortetiforration Effective Dt Active Dt Paid Off Dt ChargsoffDt  CurrertPmt DusDay | Late 30 GO 90 120 150 180
“.ddress Type Currert Confirmedhiaiing — Phone [ozr222007 [D32202007 [01/m1 2000 [01ms2010 | §53948 | 22 2[ 2 2] 2] z[ 4 2
7] [ ] -456- - i i
HOME 123-456-7800 = Last Pmt &mt Prrt Ot Last Bl 4mt  Last Activity Ot Military Duty ™ - )
123 | $0.00 0101/2000 | $dd 486,68 |01/21,2010 r -
EDEN PRAIRIE hh-55344 | Producer [Me-00003 : JENKINS INVESTMENT Behavior Score 0 D et
b7 App # [20010200031543 Customer Grads [C GRADE  Score| 500 [i] DEMOCOLL
Call Activities Fromizes Comments Checklist References Payment Rating History I Due Date History
Pmit Rating Description A Status Description
| [0 OR MORE DAYS PAST DUE DATE a7 [UriP410 BALAMCE REPORTED AS A LOSS BY CREDIT GRAR
Monthivear 122008 112008 102008 [o9co0s  [oseo0s  ofo0s  [oeeeoos  [ps;cons |oscoos [psszoos [ozeoos  (orzo0s
Rating (5 3 5 5 B 5 5 5 B 5 5 5
Morthivear [122008  [11.2008 (102008 (092008 [Ds2008 (072008 (062008 (052008 |04/2008  [03/2008  [02/2008  [01/2008
Rating [5 3 5 5 B 5 5 5 B 5 5 6
4 View the following display only information:
In this field: View this:
Pmt Rating The payment rating.
Description The payment rating description.
Acc Status The credit bureau account status.
Description The credit bureau account status description.

Month/Year The month/year of payment rating.
Rating The payment rating.
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Using the Due Date History sub page

The Due Date History sub page provides a delinquency history, by payment, by displaying
a history of all due dates, along with when the actual payment was made for that due date
and the subsequent balance. If a payment was delinquent, the Due Date History sub page

displays the number of days the customer was delinquent against each due date.

To view a customer’s rating history

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the

Customer Details tab.

3 Choose the Due Date History sub tab.

Search 00 Auta Run Status Product Payoff Amt Amt Due Cldest Due Dt Company  Branch
| e 2001020 |cHaRGED OFF LEASE wEHICLE $0.00 $0.00 [04/22/2007 [SSFC [co1 =
Ace #]20010200031543 1120200032343 [cHaRGED OFF LEASE YEHICLE $0.00 $0.00 [pazzi2007 [SSFC [cot ~
Or 55N Show &l Total $0.00 $0.00 # of Accounts 5
Search (1) Customer Service (2) | Mairtenance (3)  Benkruptcy (4)  Repoforeclosure (5)  Deficiency (8) Coriract (7) Collatersl () Bureau (9) Comments (10}
Accourt Details || Customer Details BUsifess: Balances Transactions  Tracking Aftributes  Statemerits ESCTow, Insurances Wendor Work Order
Customers Dues Conditions
— Toaye ——55m ontion Start Dt Followeup Dt
. I‘JOHN ABRAHAM IPH'MARY = Payoff I ;"’E[i‘ Bue bt DL’:“MmD B [SiP TRACE ASSIGMNMENT  [11.27/2009 (117302008 | =
LEE K ABRAHAM SPOUSE - us
[CREDIT INSURANCE AND Ve [11/27/2008 [11/30/2008
Customer # SSH Birth Dt Gender Deley Due [ $0.00 4 [os2z2007 | $0.00 I I I " |
[ 219690 [ooex-1213 [03117973 [UnKncn Lc ous [ 3000 2 [o7i2z2007 | $0.00 e
Email [JOHN . ABRAHAMEGMAIL COM MSF Due [ 30.00 3 [o6r2z2007 | $0.00 T <]
Lenguage [ENGLISH Marital St MARRED Cther Due [ $0.00 4 [osr2202007 | $0.00 [
Disakilty [ skip Stop Carrespondence [ Total Due | $000 5 |o4z22007 | $0.00 [ =
Frivacy Opt-Cut Time Zone Active Military Duty [ Activi Delinquency Information
Contact Information Effective Dt Active Dt Paid OFf Dt Chargeofi Dt CurrsmtPmt  DusDay | Lale 30 60 90 120 150 180
Address Type CurrertConfirmedMaling  Phone |o3rz2r2007 [oz2z/2007 J0101 /2000 [M1msz2010 | $539.48 22 2[ 2 2 z2[ 2] 1] =z
fowe [izaaserean = ; i _
HOME I (I I [123.458-7500 |~ Last Prrit #mit Pt Dt Last Bl &mt Last Activity Dt ilitary Duty BPMEF ifes| 0 O
123 [ $0.00 |01/01 2000 | $44,486.88 [01/21/2010 [ AN —— ——
EDEN PRAIRIE MN-55344 Producer [NC-00003 ; JENKINS INVESTMENT Behavior Score 0 Bees @R T
= A i (2001 0200031543 Customer Grade [C GRADE | Score| 500 [i] DEMOCOLL
Call Activities Promises COomments Checklist References Payment Rating History  Due Date History [
Due Dt Due Amt Pimt Ot Pt St Balance Amt  Days Past Due Pt Recieved
= $750.00 | | $0.00 | $750.00 383 [ -
|par2zr007 | $750.00 [ $0.00 | $750.00 883 r
|o8z2r2007 | $750.00 | [ 3000 $750.00 583 [ —
|oarz2sz007 | $750.00 | [ $0.00 | $750.00 583 [
|osrzzrz007 | $750.00 | | $0.00 | $750.00 883 r -
4 View the following display only information:
In this field: View this:
Due Dt The due date.
Due Amt The due amount.
Pmt Dt The payment date.
Pmt Amt The payment amount.
Balance Amt The balance amount.
Days Past Due The days past due.
Pmt Received If selected, indicates the payment was received.
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Customer

1
2

Details page

Information gathered on the Application Entry form regarding the customer and the cus-
tomer’s address, employment data, and phone numbers appears on the Customer Details
page. Using the Customer Service form’s Customer Details page, you can update or add to
a customer’s address, employment information, or phone listing.

Note: Information about the customer can be changed using the Maintenance (3) master
tab.

To view or edit customer information
Open the Customer Service form and load the account (lease) you want to work with.

ost Customer Service (2) master tab, then choose the Customer Details tab.

Search g0 Auta Run BES e Status Pracuct Payolt At AmiDus  Oldest Dus Bt Company Branch
[ b | W (20010000021 543 |cHARGED OFF | LEasE vEHICLE | $0.00 | $0.00 042272007 [ssFc ot -
A #2001 1200031 543 [1120200032343 |CHARGED OFF | LEASE vEHICLE | $0.00 | 5000 042272007 [ssFC jent -
Qr S5 Show A1l Tntal| $0.00 | $0.00 # of Accounts: ,75
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepoiForeclosure (5) Deticiency (6] Contract (7) Collateral (8) Bureau (9) Cotnmerts (10)
Accourt Detalls  Customer Details { EUEEEs Balances Transactions Tracking Attributes Ststements ST Insurances “endor Work Orer
Customer
Customer # Relation ECOM, Mame SEN Birth Dt Langusge Marital St Enablzd
n| BB FrRmary | [JOHN ABRAHAM ferx1213 03111973 [ENGLISH  [MARRIED RN
Dependenits License # State Mathers Maidzn Mame Email Clazs Time Zone Stop Correspondence Disability Skip Privacy Opt-Out —
[ A | lomkncian |JOHN ABRAHAMEGMAIL Cf EMPLOYVEE r . 7 S
Address Military Services
Type Postal Type # Pre Street Name Street Type Post At # Active Military Duty|— Ovcer Ret #,7
Currert v [HOME InormaL atfooso [ |53s PRARE] [ [7a 8
Misiling ¥ [12a Etfective Dt Released Dt ’—
Confirmed | | Emplayment Tyse ol
mployer
City [EDEN PRAIRIE st zp[ssaaa| | countryUs | Phfizs-aseeso o T T a
Census Tract (24254354 M3A Code43343543
commertiTesT - # }1 0050 [tEsT
Tglemﬂ\emm Type Phore Extri  Start Time End Time: Time fone  Current Cityt [EDER PRAIRIE Stlvi | Zip[ssaas| | courtrylus
BICELLMOBILE PHONE [1z3-as675a0[ | [ [T [#| “  OccupationPROFESSION:  THle|SR COMSLLT,  Ph[123-4se-7amn| |
[ ’7‘ 1 [ [ I~ Commert | B
Call Activities { Fromizes Comments Checklist References Payment Rating History  Due Date History
Action Result Contact Reason Promise Dt Promise &mt Cancel  Condition Follovwup Dt Time Zone L. Follovwup Dt Appt
mlcc |Hu | [ | $0.00 [ |NGHE [11/30/2009 04:47:19 AM | [11/30/2009 044718 AM T~
cc =3 [ [ [11.2772009 | $200.00 v [NONE [11.3002009 044534 am | [11r3002009 04:45:34 2w [
lcc [P | [ f127i2009 | $101.00 | [NONE 1143002009 04158 AM | [11r3002009 04:41:58 &M [
[T T [ [ [ $000 [ | [DELG [11.021 2008 02 2147 am | [11r2102008 092147 apa [
[To |Lm [ [ [ [ $0.00 [ [uone [11:21,2008 09:21:04 M | [11e2102008 09:21:04 2 [~

3

Load the customer whose information you want to edit or enhance. Use the scroll bar on
the right of the Customer block to view all the customers associated with this account.

In this field: View this:

Customer number (display only).

Customer’s relationship to the account (display only).
Customer’s Equal Credit Opportunity Act code (display
only).

Customer’s name (display only).

Customer’s social security number. Note: If the organiza-
tional parameter UIX_HIDE RESTRICTED DATA is set
to Y, this appears as a masked number; for example,
XXX-XX-1234(display only).

Customer’s date of birth (display only).

Customer #
Relation
ECOA

Name
SSN

Birth Dt

Language Customer’s language (display only).

Marital St Customer’s marital status (display only).
Enabled Customer’s enabled indicator (display only).
Dependents Customer’s number of dependents (display only).
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License #

State

Mothers Maiden Name
Email

Class

Time Zone

Stop Correspondence

Disability
Skip

Privacy Opt-Out

Customer’s driving license number (display only).
Customer’s driving license state (display only).
Customer’s mother’s maiden name (display only).
Customer’s email address (display only).

Customer’s classification type (display only).
Customer’s time zone (display only).

Customer’s stop correspondence indicator. If selected,
this indicates that Oracle Daybreak will not send the cus-
tomer any correspondence, such as monthly statements.
This is selected using the Maintenance (3) master tab
(display only).

Customer’s disability indicator (display only).
Customer’s skip indicator. If selected, this indicates that
the customer is a skip debtor.This is selected using the
Maintenance (3) master tab (display only).

Privacy opt-out indicator. If selected, indicates that the
applicant has elected to refrain from the non-public shar-
ing of information (optional).

To change or add an address, use the Address block text boxes:

In this field:

Type

Postal Type

#

Pre

Street Name

Street Type

Post

Apt (#)

Address 1 (unlabeled)
Address 2 (unlabeled)
Zip Extension

City

St

Extension (unlabeled)
Country

Ph

Census Tract

MSA Code

Comment

Do this:

Select the address type (required).

Select the postal address type (required).

Enter the building number (optional).

Select the street prefix (directional).

Enter the street name (optional).

Select the street type (optional).

Select the street postfix (directional).

Enter the apartment number (optional).

View the address as entered on line 1 (display only).
Enter address line 2 (optional).

Select the zip code (required).

Enter the city (required).

Select the state code (required).

Enter the zip + 4 extension (required).

Select the country (required).

Enter the phone number (required).

Enter census tract/BNA code (optional).

Enter the metropolitan statistical area (MSA) code
(optional).

Enter a comment (optional).

If this is the customer’s current address, select Current.

If this is the customer’s mailing address, select Mailing.
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5

If the customer is in the military, view the following display only information in the Mili-

tary Services block:
In this field:
Active Military Duty

Order Ref #
Effective Dt

Released Dt

View this:

Active military duty indicator. If selected, indicates that
the customer is on active military duty and may qualify
for the rates in accordance with the Servicemembers
Civil Relief Act of 2003 (SCRA).

The order reference number.

The effective date. This is the date the Active Military
Duty indicator was selected.

The release date. This is the date the customer was
released from active military duty.

To edit a customer’s employment information, use the Employment block text boxes:

In this field:

Type

Employer

#

Address 1 (unlabeled)
Address 2 (unlabeled)
Zip

City

St

Zip Extension (unlabeled)
Country

Occupation

Title

Ph

Ph Extension
Comment

Do this:

Select the occupation (required).

Enter the employer’s name (required).
Enter the building number (optional).
Enter the address line 1 (optional).

Enter the address line 2 (optional).
Select the zip code (optional).

Enter the city (optional).

Select the state (optional).

Enter the zip extension (optional).

Select the country (required).

Select the occupation (optional).

Enter the title (optional).

Enter the work phone number (required).
Enter the work phone number extension (optional).
Enter a comment (optional).

If this is a customer’s current place of employment, select Current.

To record additional phone numbers, use the Telecom block.

In this field:

Telecom Type

Phone

Extn

Start Time

Time Period (unlabeled)

End Time
Time Period (unlabeled)

Time Zone
Current

Do this:

Select the telecommunication type (required).

Enter the phone number (required).

Enter the phone extension (optional).

Enter the best time to call start time (optional).

Select the time period for the best time to call start time,
AM or PM (optional).

Enter the best time to call end time (optional).

Select the time period for the best time to call end time,
AM or PM (optional).

Select the applicant’s time zone (optional).

Select if this telecom number is current (required).

Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub

pages section of this chapter.

Chapter 2 :-25 User Guide - Consumer Lease Collection



Business page

If this is a SME loan, information gathered on the Application Entry form regarding the
business and the business’s address, partners and affiliates data, and phone numbers
appears on the Business page. Using the Customer Service form’s Business page, you can
update or add to a business’s address, partners and affiliates information, or phone listing.

To view or edit business information

Open the Customer Service form and load the account (lease) you want to work with.

Choose the Customer Service (2) master tab, then choose the Business tab.

Load the business whose information you want to edit or enhance. Use the scroll bar on
the right of the Business block to view all the businesses associated with this account.

In this field:

Organization Type

Type of Business

Name of the Business
Legal Name

Tax Id #

Start Date

# of Employees (Curr)

# of Employees

Contact Person

Business Checking Bank
Bank Account Number
Average Checking Balance
# of Locations
Management Since

View this:

Organization type.

Type of the business.

Name of the business.

Legal name of the business.

Tax identification number.

Business start date.

Current number of employees at the business.
Number of employees at the business after financing.
Contact person at the business.

Bank name of the business’s checking account.
Bank account number.

Average checking balance.

Number of locations of the business.

Year the current management was established.
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In this field:

Type

Postal Type

#

Pre

Street Name

Street Type

Post

Apt#

Address

Address 2 (unlabeled)
Zip

City

St

Zip Extension (unlabeled)
Country

Ph

Own / Rent
Comment

4  To change or add an address, use the Address block text boxes:

Do this:

Select the address type (required).

Select the postal address type (required).
Enter the building number (required).

Select the street prefix (directional) (optional).
Enter street name (optional).

Select the street type (optional).

Select the street postfix (directional) (optional).
Enter the apartment number (optional).

Enter the address (required).

Enter the address line 2 (optional).

Select the zip code (required).

Enter the city (required).

Select the state (required).

Enter the zip extension (optional).

Select the country code (required).

Enter the phone number (required).

Select the ownership type (required).

Enter a comment (optional).

If this is the business’s current address, select Current.

If this is the business’s mailing address, select Mailing.

To record additional phone numbers for the business, use the Telecom block.

In this field:

Telecom Type
Phone

Ext

Current

Time Zone
Current

Do this:

Select the telecommunication type (required).
Enter the phone number (required).

Enter the phone extension (optional).

If selected, indicates that this is the current record.
Select the applicant’s time zone (optional).

Select if this telecom number is current (required).

To edit a business’s partners information, use the Partners block text boxes:

In this field:

First Name
MI

Last Name
Suffix

SSN

Birth Dt

Birth Place
Networth
Gross Income
Language
Nationality
Title
Ownership (%)

Email

View this:

Enter the partner’s first name (required).

Select the partner’s middle name (optional).

Enter the partner’s last name (required).

Enter the partner’s suffix (optional).

Enter the partner’s social security number (required).
Enter the partner’s birth date (required).

Enter the partner’s birth place (optional).

Enter the partner’s net worth (required).

Enter the partner’s gross income. (required).

Enter the partner’s language (required).

Enter the partner’s nationality (optional).

Select the partner’s title (optional).

Enter the percentage of ownership held by the customer
(required).

Enter the partner’s email (optional).
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Phone Enter the partner’s phone (required).
Extn Enter the partner’s phone extension (optional).

7 To edit a business’s affiliate information, use the Affiliates block text boxes:

In this field: Do this:

Organization Type Select the affiliate’s organization type (required)

Legal Name Enter the affiliate’s legal name (required)

Business Name Enter the affiliate’s business name (required)

Tax ID Enter the affiliate’s tax identification (required)
Ownership (%) Enter the affiliate’s percentage of ownership (required)
No of Employees Enter the affiliate’s number of employees (required)
NAICS CODE Enter the affiliate’s North American Industry Classifica-

tion System code (required).
8 Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub
pages section of this chapter.
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Balances page

Details of an account’s balance can be viewed on the Balance page. The Balances page
contains four action buttons in the Balance Group block: Current Balance, Deficiency Bal-
ance, Non-Performing Balance, and Terminate Balance.

Depending on which one you select, a different set of balance information appears. In all
cases, the Balance page can be viewed in two transaction period modes: ITD/CTD (Incep-
tion-to-date: loans)/Cycle-to-date: line of credit) and YTD (year-to-date).

To view account balance information

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances tab.

Pending Re
Search ¢ 00 Zuto Run Accounts Status Procuct Payatt At AmtDue  Cldest Due Df Company  Branch
[ mg | m [pooeto010o9c4s |acTvE DELG:SCHEDULED ¢ [LEASE VEHICLE | 1631088 | $15,55540 (11102006 [SSFC ool B
Ao #[20061 001099645 [200601 01 n098E2 |cHaRGED OFF [LErzE vEHICLE | $0.00 | $0.00 0202006 [SSFC [Col B
O SEh Show Al Tatal| 92566811 | $24 251.70 #of Accounts| 11
Search (1) Customer Service (2) | Maintenance (3) Bankruptcy (4] RepoForeclosure 13) Deficiency (6) Contract (7)1 Collateral (8) Bureau (9) Commerts (10)
Account Details Customer Details Lt | Balances [ Transactions Tracking Attributes Statements [Earre Insurances “endor Work Order
Balance Group Txn Period
@ Current Balance  Deficiency Balance  Mon-Performing Belence  © Terminate Balance & |TOVETD C¥TD
Balance Type Opering Balance Posted Paid Waived Charged Off Adjusted (-) Adjusted (+) Balance
W |LEASE RECENVABLE [ $0.00 | $15,999.84 [ Fadd 44 | $0.00 | $0.00 | 3000 | 3000 | 1555540 |~
|FEE LATE CHARGE [ 50.00 | 575548 | 50,00 | 50,00 | 50,00 | $0.00 | $0.00 | $755.45
|FEE nsF | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $o.00 | $o.00 | $0.00
|FEE ADwaNCE [ 5000 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
|FEE PHORE Py [ $0.00 [ $0.00 | $0.00 | $0.00 | $0.00 | go.00 | go.00 | $0.00
|ExPENSE BANKRUPTCY [ 5000 | $0.00 | $0.00 | $0.00 | $0.00 | 30,00 | 30,00 | oo
[EXPENSE REPOSESSIONFORE | $0.00 $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
[EXPENSE SERVICING [ $0.00 [ $0.00 | $0.00 | $0.00 | $0.00 | 3000 | 3000 | $0.00
|SALES 1 USAGE TaX | 50.00 | $0.00 | $0.00 | $0.00 | $0.00 | .00 | .00 | $0.00 |7
Total Balance $16,310.88
e B Sl Loen Detaile: | | Repayment sohedule (GG DetEE: Lease Details |, ACH Caupo Lot Exfenee DEtais Card Details
Extn and Due Dates Additional Details
ear Lite
# ot Extensions o a Tatal Term 36
# of Extension Term a a Paid Term 1
# of Due Day Changes i i hadurity Dt [094 02003
Last Extn Dt Due Day Chg Dt

3

In the Balance Group block, select the balance you want to view.

Current Balance displays the current balances for accounts with an status of ACTIVE. If
you choose Current Balance, the following information appears:

In this field:

Balance Type
Opening Balance
Posted

Paid

Waived

Charged Off
Adjusted (-)
Adjusted (+)
Balance

Total Balance

View:

The balance type.

The opening balance amount.

The amount posted (in addition to the opening balance).
The amount paid.

The amount waived.

The amount charged off.

The amount adjusted (negative adjustments).

The amount adjusted (positive adjustments).

The current (closing) balance.

The total of the account balance.

* Deficiency Balance displays the current balances for accounts with an status of
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CHARGED OFF. If you choose Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.

Opening Deficiency The opening deficiency balance.
Chargeoff Posted The additional charged off amounts posted.
Recovery The amount of deficiency balance paid.
Deficiency Balance The current (closing) deficiency balance.
Deficiency Balance (total) The total deficiency balance.

* Non-Performing Balance displays the current balance for accounts with an status of
NON-PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and
ACTIVE accounts. These accounts are treated as active when dealing with the customer,
but for accounting purposes are treated differently as they are expected to charge off in the
future. Fee and interest balances are not expected to be collected in full and therefore are
not recognized as income. If you choose Non-Performing Balance, the following infor-
mation appears:

In this field: View:

Balance Type The balance type.

Opening Non-Performing The opening nonperforming balance.

Paid The amount of nonperforming balance paid.
Paid Excess The additional nonperforming amounts posted.
Waived The amount waived.

Adjusted (-) The amount adjusted (Negative adjustments).
Adjusted (+) The amount adjusted (Positive adjustments).
Balance The current (Closing) nonperforming balance.
Total Balance The total deficiency balance.

* Terminate Balance displays the current balance for lease accounts with an status of TER-
MINATE. If you choose Terminate Balance, the following information appears:

In this field: View:

Balance Type The balance type.

Opening Balance The opening balance amount.

Terminate The terminate balance amount.

Paid The amount paid.

Waived The amount waived.

Charged Off The amount charged off.

Adjusted (-) The amount adjusted (negative adjustments).
Adjusted (+) The amount adjusted (positive adjustments).
Balance The current (closing) balance.

Total Balance The total account balance.

4 In the Txn Period block, choose how you want to view the balance:

*  Choose ITD/CTD to view transactions by Inception-to-date (loans)/Cycle-to-date (line of
credit)
-or-

* Choose YTD to view the transactions by year to date.
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Transactions page

The Transaction page displays all transactions with a monetary impact that have occurred
over the life of the account. Transactions can be sorted by when the transaction was made
effective (Post Dt) or the date the transaction was created (Txn Dt). You can also choose to
view all transactions or reverse certain transactions. This information comes from the pay-
ments and advances applied to the account, maintenance tasks, and nightly processes such
as billing.

To view the transaction history of an account

Open the Customer Service form and load the account you want to work with.

Choose the Customer Service (2) master tab, then choose the Transactions tab.

earch o0 Auto Run ceounte o ¥ Stalus Product Payoff Amt AmtDue  Oldest Due Ot Company Branch
[ ng | m [20051001099546 |4 CTIVE DELGrSCHEDULED G |LEASE VEHICLE | $16,310.88 | $15,555 40 [11n02006 [s5FC oo -
Acc #[20061001090548 [20080101 009862 |cHaRGED OFF [Loanvercle | $0.00 | $0.00 02102008 [sSFC [cot B
or 5N Sho a1 Tatal| g25,58811 $24,251.70 #of Accounts| 11
Search (1) Customer Service (21| Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (5) Contract (7] Collateral (8) Bureau (9) Comments (10)
Account Details  Customer Details =i s Balances Transzactions l Tracking Attributes Statements ESCravy Insurances “endar Work Order
Sort By View Options Action
" Post Dt & Tun Dt & Gond Paymerts © AlPayments O Good Tyns © AN Tans Reveres
Transactions
Txn Ot Txn Descrigtion Texn Amt Txn Details Balance Amt
[ 5| [10:30r2006 [FIRST PAYMENT () [ $444 44 | LSR PD=$444 44 POSTED ON 10/30/2006 [ $1555540 |~
[ [ [ [ [ [ ~
Details Description
Txn At Payment Type Reference Mode Reason

B [ EASE RECEMVABLE BILLED PAID | F4d44d |~ | =
ez Elziez elell Bz Bzl b Eamzidnan e ez [t E Lease Details ACH ) (B B B e Card Details

Credit Card Details:

Card Type Start Ot =}
Card Comparny |
Card # Expiration Ot
Pt A
Biling Address | Zip ~
. . . . . . .
3 Inthe View Options block, select the type of transactions in this account’s history you

want to view in the Transactions block.

If you select this: Oracle Daybreak displays:

Good Payments All valid payments that were neither voided nor reversed.
All Payments All transaction involving payments.

Good Txns All transactions that were neither voided nor reversed.
All Txns All transactions.

In the Sort By block, choose Post Dt to sort the entries on in the Transactions block in
order of when the transaction was made effective.

_Or_
Choose Txn Dt to sort the entries on in the Transactions block in order of when the trans-
action was created.

In either case, Oracle Daybreak displays the following information:
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In this field:

Transactions block
Post Dt

Txn Dt

Txn Description
Txn Amt

Txn Details
Balance Amt

Details block
Txn

Amt

Description block
Payment Type
Reference

Mode

Reason

View:

The transaction posting date.

The transaction effective date.

The transaction details.

The transaction amount.

The transaction details.

The balance amount. Note: This is the principal balance,
not the total balance amount.

The transaction allocation details.
The transaction allocation amount.

The payment type.

The reference number associated with the transaction.
The mode of the transaction.

The reason for the transaction.

To reverse (or void) a transaction

1 Load the account with the transaction you want to void using the Customer Service form.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the Transactions block list box, select the transaction you want to reverse in the Txn
Description column. (You may have to use the scroll bar to find the transaction).

4 In the Action block, choose Reverse.

Note: Some transactions cannot be reversed. If a transaction cannot be reversed, the
Reverse button will be dimmed when the transaction is selected.

In this example, the Reverse button is available. The transaction ADJUSTMENT TO SER-
VICING EXPENSES - ADD can be reversed.

Search g0 e Auto Run Accounts Status Pracuct Payaff Amt AmtDus  Oldest Due Dt Company Branch
™ M| m (2004120009423 [acTive | LEASE VEHICLE | $1501217 | $0.00 010172005 [S5FC [HG =
400 #20041 200094423 [ [ [ [ [ [ [ [ ~]
Or 55N Tatal| $15,01247 | $0.00 # of Accounts 1
Search (1) Customer Service (2) | Mairtenance (3)  Bankruptcy (4)  Repo/Foreclosure (5) Deficiency () Cortract (7) Collateral () Bureau (3) Comments (10)
Account Details  Customer Details Elb iz Balances Transactions l Tracking Attributes Statemerts Escrow Insurances “endor Work Crder
Sort By View Options Action
 post Dt ® Txn Dt  Good Payments C &l Payments  ® Good Tans  © All Txns _ Reverse |
Transactions
Post Ot Tun Ot gl Toxn At Tun Details Bialance Amt
[ ] *mznm TT13/2004 |ADJUSTMENT TO SERVICING EXPERSE | §125.00 | [ §000 =

|o7/z2i2004 [07n162004 [PAYMENT (v [ 547 68 | OVG PD= $47 68 POSTED ON 07/22/2004 [ $0.00

|07i2202004 [07116/2004 (NTEREST REBATE [ $0.00 | [ $0.00

[o7i15i2004 (07152004 [PAYMENT (v [ $476.77 | LC PD= $47 68 OVG FD= $429.09 POSTED ON 07.15/2004 [ §0.00  —

|07/ 5/2004 (071502004 [INTEREST REBATE | 50.00 | | 30.00

o7 42004 [07r1212004 [PANMENT (v [ §476.77 | ADY PD= $476.77 POSTED ON 07/ 42004 [ $0.00

o711 4:2004 [07n12i2004 [PAYMENT (v [ §476.77 | ADY PD= §476.77 POSTED ON 0741 42004 [ §47677 |-

Details
Txn Amt
B [ADJUSTMENT TO SERVICING EXPENSES - ADD PAID | §125.00 |~
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In this example, the Reverse button is unavailable. The transaction PAYMENT (Y) cannot
be reversed.

Search o . - Auto Run Accounts

Acc ¥ Status Product Payoft Amt Amt Due Oldlest Due Ot Company Branch
[ hig | m [20041200004423 [acTive [ Lease vericle | §15,012.17 | $0.00 [0isnns [ssFC [Ha -
A6 #120081200094423 [ [ [ [ [ [ [ [ ~]
Or 30 Total| §15,01247 | 30.00 # of Accourts 1
Search (1) Customer Service (20 | Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (5] Cortract () Collateral (8) Bureau (9) Comments (10)
Account Detailz  Customet Details Ellizip=s s Balances Transactions I Tracking Attributes Statements Escrowe Insurances Wendar Work Order
Sort By View Options Action
 post Ot ® Tun Ot © Good Payments © Al Paymerts  ® Good Tyns © Al Txns RevErse
Transactions
Past Ot Tun Ot Txn Description Txn Details Balance &mt
[1203r2004 1241302004 NG EXPENSE| $125.00 | [ 000 &
[ FE2004] [PaMENT () [ $47 58 | O¥G PD= $47 68 POSTED OM 0712212004 [ $0.00

071222004 [07AB/2004 [NTEREST REBATE | $0.00 | | $0.00

[o7115/2004 [O7A 52004 [PAMERT () [ F476.77 | LC FD= $47 68 OVG PD= $429.09 POSTED ON 07/15/2004 [ §000  —

[07#15/2004 |07 52004 [NTEREST REBATE | $0.00 | | 30.00

071472004 [07A1 202004 [PacMERT () [ F475.77 | ADY PD=$476.77 POSTED ON 07 4/2004 [ $0.00

[07114/2004 [O7A 22004 [PAYMERT () [ F476.77 | ADY PD=$476.77 POSTED ON 07/14/2004 [ F4TETT v

Details
Txn At
W [F Y MENT EXCESS PAID | 4TEE |~

Access to the Reverse button can be restricted by user responsibility and the account’s
product type using the PAYMENT_REV transaction code (Super Group: ACCOUNT
MONETARY TXN) on the Administration form. (For more information, see the Txn Codes
page section in the Oracle Daybreak Lending Suite Setup Guide).

To void an account

Oracle Daybreak can be configured to void an account using the Reverse button on the
Transaction page.

Load the account you want to void using the Customer Service form.

Choose the Customer Service (2) master tab, then choose the Transactions tab.

In the View Option block of the Transactions page, choose Good Txns.

In the Transactions block, select the ACTIVE entry in the Txn Description field.

[V B LY I\

In the Action block, choose Reverse.

In the Transactions block, Oracle Daybreak creates an entry of REVERSE ACTIVE and
reverses all transactions. Oracle Daybreak also changes the status of the account to
CLOSED: VOID and changes the status of the application to APPROVED-VOID (or what-
ever the account’s last status was before funding).

Note: To use this feature, the ACTIVE REV transaction code must be enabled and set to
manual on the Administration form for your user responsibility and account’s product
type. For more information, see the Txn Codes page section in the Oracle Daybreak
Lending Suite Setup Guide.
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Tracking Attributes page

1

The Tracking Attributes page allows you to link information to an account that is not
tracked by default in the Oracle Daybreak system, but is part of your company’s business
practices; for example, the location of important documents, how customers receive pay-
checks, or the hint questions for remembering a PIN number. Such attributes are defined
during system setup.

To track attributes on the Customer Service (2) master tab

Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Tracking Attributes tab.

Search o0 ie e Run Accounts 4 Status Froduct Payoff Amt AmtDue  Oldest Dus Dt Company Branch
[ x| w [20081001005648 | TIVE DEL G SCHEDULED C[LEASE VEHICLE | 16,310,853 | $15,555.40 (11402006 [SSFC [cot N
e #2006 001039546 [20060101 009882 |cHaRGED OFF lLoanveHcLE | 50.00 | $0.00 0202006 [S5FC oo ~]
or 5M Show &IV Toisl| 32568811 | §24,25170 #of conunts| 11
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  ReposForeclosure (5)  Deficiency (6) Contract (7)) Collateral (5) Bureau (9) Comments (10)
Accourt Detaile  Customer Details: EUEEss) Balances Tranzactions Tracking Aftributes l Statements By Inzurances Wendor Work Order
Tracking
Sub Attribute ALL
Parameter “alue Create Tracking
[] | -
|
|
|
|
|
|
|
|
|
|
|
{ =)
ez Bz Aol NEmPEEES SR e e SeEn e (B VETE S Lease Details ACH et e (BB EnE T Card Details l
Credit Card Details
Card Type Start Dt ,— [~
Card Cnmpany‘
Card # ’7 Expiration Ot ’7
Pt st
Billng Address| [ 5

Choose Create Tracking.
Oracle Daybreak loads the tracking parameters.

If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the Parameter display.

Complete the Tracking block by entering the requested parameter in the Value field.

Save any changes you made to the account.
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Balances, Transactions, Tracking Attributes, and Insurances pages’
sub pages
The Balances, Transactions, Tracking Attributes, and Insurances pages share the following
sub pages:

¢ Lease Details
« ACH
e Card Details

Note: Depending on the type of lease and the method of payment, only certain sub pages
will be available.

Lease Details sub page

The Lease Details sub page contains further information about the lease; including exten-
sions, due dates, and additional details.

To view the Lease Details sub page
1 Open the Customer Service form and load the lease account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions,
Tracking Attributes, or Insurances tab.

3 Choose the Lease Details sub tab.

Search g, 0. Auta Run Accounts 4 Status Froduct Fayatt Amt AmtDus  Oldest Dus Dt Company Branch
[ hx | m [poosto01093646 |&CTIVE:DELQ SCHEDULED C [LEASE VEHICLE | $16,31088 | $15,555.40 1141002006 [SSFC [con =
A #[20061001099645 [200801 010098862 |cHARGED OFF |LEAsE vEHICLE | $0.00 | $0.00 (02102006 [SSFC |co1 B
ar SSN Show &IV Tatal| $25688.11 | $24,251.70 #of sccourts| 11
Search 1) Customer Service (21 | Maintenance (3)  Bankruptcy (4)  RepoiForeclosure (3) Deficiency (6) Cortract (7) Caollateral (3) Bureau (31 Commerts (1001
Account Details  Customer Details Elsiiess Baslsnces | Transactions  Tracking Attributss  Statemerts Escrowy, Insurances endor Work Orcler
Balance Group Txn Period
@ Currert Balance  Deficiency Balance  Mon-Performing Balance  © Terminate Balance & [TD/CTD © ¥TD
Balance Type Opering Balance Posted Paidl Wiaived Chargsd Off Adjusted (-) Aciusted (+) Balance
W | EASE RECEIVABLE | $0.00 | $15,999.84 | §ddd 44 | $0.00 | $0.00 | 30.00 | $0.00 | $15555.40 | =]
|FEE LATE CHARGE [ $0.00 | §755.48 | §0.00 | $0.00 | $0.00 | 000 | §0.00 | $755 .48
|FEE NsF [ $0.00 | $0.00 | $0.00 $0.00 $0.00 | 30,00 | $0.00 $0.00
|FEE &Dv aNCE [ $0.00 | $0.00 | $0.00 | $0.00 $0.00 | 30,00 | $0.00 $0.00
|FEE PHOME PaY [ £0.00 | $0.00 | $0.00 | $0.00 | £0.00 | $0.00 $0.00 | $0.00
[EXPENSE BANKRUPTCY [ $0.00 | $0.00 | $0.00 $0.00 $0.00 | $0.00 | $0.00 000
|EXPENSE REPOSESSION/FORE | $0.00 | $0.00 | §0.00 | $0.00 | $0.00 | 000 | §0.00 | $0.00
[EXPENSE SERVICING [ $0.00 | $0.00 | $0.00 $0.00 $0.00 | $0.00 | $0.00 £0.00
[SALES iUSAGE TAX [ $0.00 | $0.00 | $0.00 $0.00 $0.00 | 30,00 | $0.00 | 000~
Total Balance $18,310.88
licen DeATE alell ez Uizl | Fzpiiien ezl G DA Lease Details ACH Coupon (oG BEEn s DetAiE: Card Details
Extn and Due Dates - Additional Details
vear  Lits
# of Extensions 0 0 Total Term| 35
# of Extension Term 0 0 Paidl Term 1
# of Due Day Changes 0 0 Waturity Dt (091072009
Last Exin Dt Due Day Chy Dt

4 View the following lease information on the Lease Details sub page:
In this field: View:

Extensions and Due Dates block

# of Extensions (Year) The number of times extensions granted (year).
# of Extensions (Life) The number of times extensions granted (life).
# of Extension Term (Life) The number of terms extensions granted (life).
# of Extension Term (Year) The number of terms extensions granted (year).

# of Due Day Changes (Year) Thenumber of due date changes (year).
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# of Due Day Changes (Life)
Last Extn Dt
Due Day Chg Dt

Additional Details block
Total Term

Paid Term

Maturity Dt

ACH sub page

The number of due date changes (life).
The last extension date.
The last due date change date.

The total term.
The paid term.
The maturity date.

If the account uses an automated clearinghouse method of payment, then the ACH sub
page is available. The ACH sub page displays information about automated clearinghouse
and electronic fund transfers. This information can be edited using the Maintenance (3)
master tab and the nonmonetary transaction ACH MAINTENANCE.

To view the ACH sub page

Open the Customer Service form and load the account with the ACH you want to work
with.

Choose the Customer Service (2) master tab, then choose the Balances, Transactions,
Tracking Attributes, or Insurances tab.

Choose the ACH sub tab.

Search o 0 e Auta Run Accounts Staius Product Payoff Amt Amt Due Oldest Due Ot Company Branch
| [ nex | m [poos1001099648 |&CTrE:DEL@:SCHEDULED C LEASE VEHICLE | §16,310.88 ¥15,555.40 1102008 [ssFc [em =
Ace #]20061001 099646 |20060101 009662 |cHARGED OFF |LEasE vEHICLE | $0.00 §0.00 [0z 02006 [SSFC fom -
Or S3H Show Al Total| §25688.11 | $24,251.70 #of Accourts| 11
Search (1) Customer Service (2) | Maintenance (3)  Benkruptcy (4)  RepofForeclosure (5)  Deficiency (8) Corttract (7 Collateral (8) Bureau (9) Comments (10)
Accourt Detalls  Customer Details BUSIESS Belances | Transections  Tracking Atiributes Stetements Evsroy, Insurances “endor Wark Order
Balance Group Txn Period
® Current Balance " Deficiency Balance " Non-Performing Balance Termingte Balance - TOICTD O vTD
Balance Typs Opening Balance Posted Paic Waived Chargsd Off Adjusted () Adjusted (+) Balance
= || EASE RECENY ABLE £0.00 | 15,999,584 | §444.44 | $0.00 | $0.00 $0.00 | $0.00 $15555.40 =
FEE LATE CHARGE $0.00 375545 $0.00 $0.00 $0.00 $0.00 $0.00 $755.48
FEE NSF $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
FEE ADYANCE $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
|FEE PHOME Py [ £0.00 $0.00 £0.00 $0.00 | §0.00 $0.00 | £0.00 $0.00
|[EXPENSE BARKRUPTCY [ £0.00 $0.00 | $0.00 $0.00 | $0.00 $0.00 | $0.00 000
EXPENSE REFOSESSIONFORE $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
EXPENSE SERVICING $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
SALES fUSAGE TAX $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 000 7
Total Balance $16,310.88
LoD A Loy DEtE e | RepEyE e etE e LG DS Lease Details ACH | (el Lo B ee D Card Details
Bank Information
ACHR Bank|US BANK Start Ot [1 00102006
Routing # | 373636376
Account Type [CHECKING
Account # [KKKHHHTEET
ACH Dabit Amt [ $0.00  Debit Fren MONTHLY DebitDay| 10

4  View the following information on the ACH sub page:

In this field: View:

Bank Information block
ACH

Bank

Start Dt

Routing #

Account Type

Account #

If selected, indicates that ACH is enabled.

The bank name.

The ACH start date.

The routing number.

The account type.

The account number. Note: If the organizational parame-
ter UIX_HIDE_RESTRICTED DATA is set to Y, this
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appears as a masked number; for example,
XXXXX1234.

ACH Debit Amt The payment amount.

Debit Freq The payment frequency.

Debit Day The payment day.

Card Details sub page

The Card Details sub page displays information regarding credit cards associated with the
account.
To view the Card Details sub page

1  Open the Customer Service form and load the account with the promotion details you
want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions,
Tracking Attributes, or Insurances tab.

3 Choose the Card Details sub tab.

Search 0,0 Auto Run Accounts Status Product Payaif dmt AmtDue  Oldest Due Dt Company Branch

[ nx | m [koos1001099646 |ACTIVE DELGrSCHEDULED € |LEASE VEHICLE | $16,310.58 | $15,555.40 (11102006 [SSFC [con =
Ao #/20061001093645 |z0080101 009862 |cHARGED OFF |LEASE vEHICLE | $0.00 [ $0.00 [02A 02006 [SSFC [coq ~)
or S5H Show &l Tatal| $25,680.11 | $24,251.70 # ot Accounts 11
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepoForeclosure (3) Deficiency (6] Cortract (7) Collateral (31 Bureau (3) Commernts (10)
Account Details Customer Details ENEHEss Balances l Transactions Tracking Aftributes Statements ESERE Insurances “endor Work Order
Balance Group Txn Period
@ Current Balance ™ Deficiency Balance " pon-Performing Balance ¢ Termingte Balance @ [TOUCTD CTD
Balance Type Opening Balance Posted Paid aivedd Charged Off Adjusted (-1 Adfusted (+1 Balance
W [ EASE RECEIWABLE | $0.00 | $15,999.84 | Fd44.44 | $0.00 | 0.00 | $0.00 | $0.00 | 1555540 A
|FEE LATE cHARGE [ $0.00 §755.48 | $0.00 | 50.00 | §0.00 | $0.00 | $0.00 | $755.48
|FEE nsF | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
|FEE ADvaNCE [ $0.00 | $0.00 | $0.00 | $0.00 | 30.00 | $0.00 | $0.00 | $0.00
|FEE PHONE PaY [ $0.00 | $0.00 | $0.00 | $0.00 | 30.00 | $0.00 | $0.00 | $0.00
|EXPENSE BAMKRUPTCY [ $0.00 | $0.00 | $0.00 | $0.00 | 30.00 | $0.00 | $0.00 | 000
|EXPENSE REPOSESSIONFORE | $0.00 | $0.00 | 5000 | 5000 | $0.00 | $0.00 | $0.00 | $0.00
|EXPENSE SERVICING [ $0.00 [ $0.00 | 50.00 | 50.00 | $0.00 [ $0.00 | $0.00 | $0.00
|SALES F USAGE TAX | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | §0.00 7
Total Balance $16,310.88
ey Bt Sl iey Detee) PRepeymenecheaue LG DA Lesse Details ACH Gy Lo Bl Enioe et Card Details |
Credit Card Details
Card Type Start Ot =
Cardl Campany |
Card # Expiration Dt
Pt At
Billng Address | Iip B

4 View the following display only credit card details on the Card Details sub page:
In this field: View:

Credit Card Details block
Card Type The credit card type.

Start Dt The credit card start date.
Card Company The credit card company.
Card # The credit card number.
Expiration Dt The expiration date.

Pmt Amt The card payment amount.

Billing Address The billing address for the credit card.
Zip The zip code for the billing address for the credit card.
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Statements page

The Statements page contains three display only blocks. The Statements block displays a
list all the statements generated during the life of the account. The Transaction block dis-
plays monetary transactions applied to the account from the closing date of the previous

displays

statement through the closing date of the current statement. The Messages block
the user-defined message that appears in the statement.

To view the Statements page

1  Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Statements tab.

Accourt Detsils  Customer Details eSS Balances Transactions Tracking Attributes Statements { =S Insurances “endor Work Order
Statements

Ot Due Ot Generation Ot

B 0901072009 (115252009 =
0772072009 081072009 [11/252009 —
OBA92009 |07A0/2009 [11/252008 -

Transactions Messages

Search 0 Auto Run Accounts Stetus Product Payotf Amt &mtDuz  Oldest Due Dt Company Branch
" x| m [20061001099646 [#.CTIVE DELG: SCHEDULED C [LEASE VEHICLE $16,310.88 $15,555.40 111102008 [5SFC  [co1 |~
o 420081001 099646 [200801 01009862 [cHaRGED OFF [LoanvercLe 50.00 $000 (02102006 [S5FC  [cO1 |+
Or SSN Show &l [ Total $25,688.11 $24,251.70 # of Accounts: ihl
Search (1) Customer Service (2) | Mainlenance (3)  Bankrupley (#)  RepoForeclosure (5)  Deficiency (8] Corfract (7).  Collateral (3) Bureau(9)  Cemments (10)

Txn Ot Description Amourit Seq# Message
B (0902072009 [LATE CHARGE [ §22.22 < L} 1| [+]

[o9r20/2009 [REVERSE LATE CHARGE [ §22.22 2

09202009 [LATE CHARGE [ §22.22 El

|o8r20/2009 [LATE CHARGE [ $22.22 [

[ [ [

[ | | I |

[ [ [ - [ -
ey e et ered Lease

Statement Details
Current Due [+ Past Due [+ Late Charge (+) Cther Charges = Total Due
$add 44 [ $15,110.95 | 4438 $0.00 | $16199.78

The Statements block displays the following information:

In this field: View:

Closing Dt The statement closing date.
Due Dt The statement due date.
Generation Dt The statement generation date.

3 In the Statements block, select the statement you to view.

Oracle Daybreak displays the following information for the selected statement in the

Transactions and Messages block.

In this field: View:

Transactions block

Txn Dt The transaction effective date.
Description The transaction.

Amount The transaction amount.

Messages block
Seq # The sequence number.

Message The message.
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In this field:

Current Due

(+) Past Due

(+) Late Charge
(+) Other Charges
= Total Due

Insurances page

View the statement details on the available sub page.

View:

The current due.

The past due amount.
The late charge due.
The other charges due.
The total due.

1

If during the lease origination, the Insurance sub page was completed on the Funding
form, you can view the financed insurance information on the Customer Service form’s
Insurances page. The Insurances page displays detail information related to all financed
insurances, including cancellation and refund information whenever applicable. It also
displays the insurances that were financed after funding of the lease using the Mainte-
nance (3) master tab.

To view the Insurances page

Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Insurances tab.

Search g0 e Auto Run Accounts ., Status Pracuct Payaff Amt AmtDus  Oldest Due Dt Company Branch
[ M| m [20051001093646 |#CTIVE DEL@ SCHEDULED G |LEASE VEHICLE | $16,310.83 | $15,555.40 [1171002006 [sS5FC [co B
400 #[20061001099645 [200601 01008862 |cHARGED OFF [Loan vEHCLE | $0.00 | $0.00 0202008 [ssFc [cm [+
Or SSh Show &1 Tatal| $25688.11 | $24,251.70 #of Accounts| 11
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (8) Contract (7) Collsteral (8) Buresu (3] Comments (10)
Account Details Customer Details Elfzifza Balances Transactions Tracking Aftributes Statements Eeriy Insurances l “endor Work Order
Insurance Insurance Tracking
Policy Information CancellationRefund Sub Attribute |ALL Creste Trecking
Contractusl Insurance Type Sub Type Status T Parameter Value
I— Palicy Cancelistion Ot a
_____ [ | | s ] e
Insurance Plan Insurance Mode ftemization S EEmEnng
| ‘ | Refuncd Methac ,7
[
Company Phone Mo Ext R s
Estimated Refund Amt i0.00
Policy Mumber Phone Mo Ext g
Received Refund Amt 0.00
Effective Ot Expiration Dt - g
premium amt[ Term[ CEFE G 7
_ Beneficiary Grace Days Canoellation Fes Alowed
Commission Rule | Primary Grace Days ’_ ’7
Commission Amt Secondary e T, ’7
Comments: | =
-]
Loz Dizeziifs: bl Bezin Bzl 8 Hegzinere Zepzelle L) Cieitzjjf Lease Details ACH el Loy Bz e s Dzt | Card Details l
Credit Card Details
Card Type Start Ot =}
Card Cumpanyl
Card # Expiration Ot
Pmt At
Billing Address | Tip =]

3

In the Insurance block, view the following display only information:
In this field: View:

Policy Information:
Contractual

If selected, indicates that the insurance policy is required
by contract.

Insurance Type The insurance type.
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Sub Type

Status

Insurance Plan
Insurance Mode
Itemization
Company

Policy Number
Phone No

Ext

Policy Number
Phone No

Ext

Effective Dt
Expiration Dt
Premium Amt
Term
Commission Rule
Commission Amt
Primary (Beneficiary)
Secondary (Beneficiary)
Comments

Cancellation/Refund block:

Policy Cancellation Dt
Term Remaining
Refund Allowed

Refund Method
Estimated Refund Amt
Received Refund Amt
Complete Refund

Grace Day’s Cancellation
Fee Allowed

Grace Days

Cancellation Fee

The insurance sub type.

The insurance status.

The insurance plan.

The insurance mode.

The contract itemization.

The insurance company.

The insurance policy number.

The insurance company’s primary phone number.
The insurance company’s primary phone extension.
The insurance policy number.

The insurance company’s alternate phone number.
The insurance company’s alternate phone extension.
The insurance effective date.

The insurance expiry date.

The insurance premium amount.

The insurance term.

The insurance premium amount.

The insurance commission amount.

The primary beneficiary of the insurance.

The secondary beneficiary of the insurance.

The comments regarding the insurance policy.

The insurance cancellation date.

The remaining term on the insurance at cancellation.

If selected, a refund is allowed. A selected box indicates
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

The refund calculation method.

The estimated insurance refund.

The insurance refund received.

If selected, a complete refund is allowed.

If selected, indicates that cancellation fees during grace
period is allowed.

View the number of grace days allowed for cancellation
without charging a cancellation fee.

View the amount of the cancellation fee to be charged
when the insurance is cancelled.

In the Insurance Tracking block, choose Create Tracking.

Oracle Daybreak loads the insurance tracking parameters in the Insurance Tracking block.

If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

Complete the Insurance Tracking block.

Save your entry.
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Vendor Work Order page

1

To expedite repossessions and foreclosures, the display only Vendor Work Order page
allows you to view all the work orders issued to different vendors for an account.

To view the Statements page

Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Vendor Work Order tab.

ending R
Search o e Ao Run Accounts Status Froduct Payotf Amt funtDue  Oldest Due Dt Company Branch
[ [hc | m (2006101099645 |4CTIVE DELGrSCHEDULED  |LEASE WEHICLE | $16,310.88 | $15,555.40 1141002006 [55FC  fom =
800 #]20061001029646 [20080101 009662 |cHARGED oFF [Loan vericle | $0.00 | $0.00 |02 02006 [3SFC [Cod B
Or 55N Shaw &1 Tatal| 52558611 | §24.251.70 #of Accourts| 11
Search (1) Customer Service (2) | Mairtenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deticiency (6) Contract (7) Collateral (5) Bureau (3) Cotnments (10)
Account Details  Customer Details ENENEES Balances Transactions Tracking Attributes Statements ESCra Insurances “endor Wiork Order l
Vendor Work Order
Wieny Wiark Croler
Work Order # ot Estimated Type “Wendor Status
u| | | | \ | e
| | | | [ |
| | | | [ |
| | | | \ |
| | | | \ |
| | | | [ |
| | | | \ |
| | | | \ |
| | | | \ |
| | | | \ |
| | | | \ | 7]
Total Smt
Call Activities l Promizes Comments Checklist References Payment Rating History  Due Date History
Action Result Cortact Reason Promize Dt Promise &mt Cancel  Condition Followeup Ot Time Zone A, Follovweup Dt Appt
n | | | | [ $0.00 | [ [amERICANEN_vOR | L=
[ [ [ [ [ | ol [ | [ r
\ \ \ \ \ | | \ | \ r
\ \ \ \ \ | | \ | \ r
\ \ \ \ \ | il \ | \ Ei=)

3

In the Vendor Work Order block, view the following display only information:

In this field: View this:

Work Order # The work order number.

Dt The assignment date.

Estimated The estimated dollar amount of work order.

Type The assigned type.

Vendor The vendor number and name.

Status The assigned status.

Total Amt The total estimated dollar amount of all work orders.

Select the work order in the Vendor Work Order block you want to view and choose View
Work Order.

Note: The View Work Order button appears dimmed if your responsibility does not allow
access to the Vendor form.

Oracle Daybreak opens the Vendor Management form’s Work Orders page with informa-
tion about that work order. You can then perform tasks and record additional information,
such as changing the work order’s status and adding comments on the Work Orders page.
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Maintenance (3) master tab

The Maintenance (3) master tab acts as a single command stations that allows you to post
a wide array of monetary and nonmonetary transactions for any given account. The trans-
actions available depend on the nature of the account. This section explains how to com-
plete the following tasks:

Monetary tasks

Lease:

*  Apply, adjust, or waive servicing expenses

e Adjust or waive late charges

*  Adjust or waive nonsufficient funds

*  Apply, adjust, or waive repossession expenses
*  Apply, adjust, or waive bankruptcy expenses
*  Apply or adjust phone pay fees

* Change an index/margin rate

*  Apply, adjust, or cancel financed insurance

*  Generate a payoff quote

* Payoff an account

*  Charge-off an account

* Close an account

¢ Change a due date

e Apply, adjust, or waive a disposition fee

*  Apply, adjust, or waive a termination fee

* Record selling an asset

*  Apply, adjust, or waive an excess usage fee
* Apply, adjust, or waive other fees and taxes

Nonmonetary tasks

Lease:

* Update a customer’s name

*  Maintain customer details

* Mark a customer as a skipped debtor

* Change a customer’s Privacy Opt-Out indicator
*  Stop correspondence

*  Modify financed insurance information

*  Start or stop an ACH

* Reprint a statement (batch only)

*  Create or cancel a one time ACH - phone pay
* Re-order coupon books

Oracle Daybreak allows you to post a monetary transaction immediately or submit it for
nightly processing. The transaction is identified as either a “real-time” or nightly batch
transaction in Oracle Daybreak’s transaction setup codes. Oracle Daybreak also allows
you to cancel the future dated transactions or the transaction that have been submitted for
nightly processing. All the activity on the account, including who performed it and a date
and time stamp, is captured in the audit trail.
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A note about verifying transactions:

You can set up transactions so that they must be validated by a different Oracle Daybreak
user. With this authorization process, you can view these transactions on the Transaction
Authorization form before they are posted. When you post such transaction on the Mainte-
nance (3) master tab, they receive a status of WAITING FOR AUTHORIZATION. For more
information, see the chapter Transaction Authorization (Maker-Checker) in this User
Guide.

Using the Maintenance page for monetary and nonmonetary transac-

tions

1

All of the monetary and nonmonetary tasks listed in Appendix C: Transaction Parame-
ters use the Maintenance page. Each task requires a Transaction value and a Parameter
value.

For each task, complete the following steps:

To use the Maintenance page to complete monetary transactions

Open the Customer Service form and load the account you want to work with.

2 Choose the Maintenance (3) master tab.

=0 ABRAHAM JOHN (Customer

Search o0 Auto Run Accounts Stetus Procuct Parvatf Amt At Due Olclest Due Dt Company  Branch

[ hig | m [20010200031543 |cHaRGED OFF LEASE VEHICLE | sann | $000 042222007 [s5FC [eot
A6 #120010200031543 [1120200032343 |cHarGED OFF LEASE VEHICLE | 000 | $0.00 042272007 [ssFc o

Or SN Show 211V Total| $0.00 | $0.00 # of Accounts [

4r

Search (1) Customer Service (20 Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (6] Contract (7) Collsteral (8) Bureau (9) Comments (100
Maintenance {
Action Results
Laad Parameters | Post Vaid |

Date Monetary Transaction Status Batch Tranzaction Processing Details
TR [ [ADJUSTMENT TO CREDIT IMSLURS |OPEN i+

|

Parameter Walue Rejuire
THNDATE ® | W =

AMOUNT [0 7
-

3 In the Action block:

*  Select the Monetary box to complete a monetary transaction
_Or_
*  Clear the Monetary box to complete a nonmonetary transaction.

In the Transaction field, select the transaction for the task you want to complete. Transac-
tion availability depends on the type of account (lease), whether the transaction is mone-
tary or nonmonetary, and user responsibility.
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5 During set up, you can choose to process a transaction in real time or as a batch transac-
tion.

» Ifa transaction will be performed in a batch transaction, the Batch box appears selected.
» Ifatransaction will be performed in real time, the Batch box appears cleared.

6 Choose Load Parameters.

7  Enter all the required parameter values and choose Post.

Oracle Daybreak displays the results (success, failure, or waiting for authorization) in the
Results block “Transaction Processing Details” list.

Transactions page (A reminder)

As discussed earlier in this chapter, the Transactions page displays transactions with a
monetary impact that have occurred over the life of the account. The Transaction page also
allows you to view transactions or reverse certain transactions you manually perform on
the Maintenance page. For more information, see the Transaction page section of this
chapter.

amm

Search g0\ Auto Run Accounts —, 0y Stetus Procuct Payoft At Amt Due  Oldest Dus Dt Company_Branch

[ ‘nee | m [20080200199537 |cLosED:PaID OFF [Loan HE [ $0.00 | $0.00 [03n02007 [pce |Ha B
Ace #|200502001 99537 2008020019961 |cLosEDPAID OFF LA HE [ $0.00 | $0.00 [03M02007 [pcc |Ha ~
Or TSN Shoye AV Tmal‘ $33,57117 ‘ 20,992 .53 # of Ancounts 20
Search (1) Customer Service (2) Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency () Cortract (7) Collateral () Bureau (3) Comments (10)
Account Detsils Customer Details EUE s Balances Transactions l Tracking Attributes Statemerts Escrow Insurances “endor Work Crder
Sort By View Options Action
O post Ot *® Tun Dt ® Good Paymerts (Al Payments  ( Good Tans  © Al Txns Reverse
Transactions
Post Ot Texn Ot Txn Description Txn Amt Tin Detailz Balance Amt
m (02172008 [08i24/2007 [PayMENT () $969.44 | O%G PD= $969.44 POSTED ON 02/10/2007 [ §0.00 =
[10/21/2008 [08/24/2007 [PAYMENT () $968.44 | ADY PD= $55.60 INT PD=$2.71 OTH PD= $20,00 OVG FD= §881.13 POSTED ¢ | 30.00
[10/27.2008 [02:07:2007 [PAYMENT (¥) $1,938.58 | ADV PD= §1,936.43 INT PD= $2.45 POSTED ON 02/10/2007 [ $55.50

[
[
|
[10/27/2008 [0202/2007 [PAYMENT () | §1,935.55 | ADY PD= §1,834.05 INT PD= $4.53 POSTED ON 02/10/2007
[
[
[

| §1,080203 ] —
[10727/2008 [01.282007 [PacMERT () $1,338.58 | ADV PD= §1,831 67 INT PD= 57 21 POSTED ON 02/10/2007 [ §3,926.08
[0727/2008 [01.23,2007 [PAMERT () §1,938.88 | ADY PD= §963.75 INT PD= $848.01 LC PD= §127.12 POSTED ON 0202007 | §5,857.75
[10/27/2008 |01 472007 [PAYMENT () §1,589.25 | ADY PD= §1,550.25 POSTED ON 024 042007 | $6,621.50 |+
Details = e Description
. ‘ xn | Paymert Type Reference Miode Reazon
MEMO PAYMENT PAID OED44 |~
i | £ = [ACH PAYMENTS [0528501 0000000 [ACH REG
5
Loan Details l &ddl. Losn Details  Repayment Schedule (ECE et E |2z iz ACH G L B e R B Card Details
Interest and Accruals Extn and Due Dates Additional Details
Rate| 8.9900 Last Rate Change Dt "’573' ’ﬁ
# of Ext 0 0
Acorual Start Dt (0211072008 # of Rete Changes (ear)[ 0 OTBaEnsens % Tetal Term| 36
Last Acerul Ot [Dar2472007 # of Rete Changes (Life) o LEEHAE N ,_U ’_U Paid Term i
Stop Accruall Rate Start Of ¥ear|  6.9900 ﬂ e e ’u Mturfty Ot 02/10/2009
cerusl Wt INTEREST BEARI. Fiehate 1t NONE Last En bt B2 EY e Baloon At $0.00
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Bankruptcy (4) master tab

The Bankruptcy page allows you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of
the bankruptcy process based on its follow-up date and record information using the
Details and Tracking blocks.

As there are occasions when a borrower files bankruptcy more than once during the tenure
of the lease, you can record information for multiple bankruptcies. The Create New Bank-
ruptcy button enables you to create a new bankruptcy record with different start and end
dates. You can also use the Bankruptcy page to view the previous bankruptcy record using
the scroll bar in the Details block. The Current box in the Details block indicates the cur-
rent bankruptcy details.

To enter bankruptcy details for an account

Using the Customer Service form, load the account you want to add bankruptcy details
to and choose the Bankruptcy (4) master tab.

Accounts

Ace #[20010200031543

Search (1)
Bankruptcy {

Cueue Auto Run Acc Status Product Payoft Amt Amt Due Oldest Due Ot Company  Branch
[ hig | m [20010200031543 |cHaRGED OFF LEASE VEHICLE | g0.00 | $0.00 [ndeozionn7 [ssFC oot -
[1120200032343 |cHarGED oFF LEASE YEHCLE | 30.00 | $0.00 [04i22i2007 [SSFC [con )

O SSN Showr Al T\:na\| §0.00 | §0.00 # of Acocourts -]

Customer Service (20 Maintenance (3)  Bankruptcy (4 RepoForeclosure (5) Deficiency (51 Cortract (T) Collatersal (8) Bureau (9) Comments (10)
Tracking
Sub Attribute | ALL
Parameter “Yalue

Details

Followup Ot

Digpostion |

Tivpe: |

File Received Dt =
Bankruptcy Start Ot
Bankruptoy End Ot

Comment |

-

Create New Bankruptey | Create Tracking |

Call Activities l Promises

Comments Checklist
Result Contact Reason

References Payment Rating History  Due Date History

Promise Dt Promise &mt Cancel  Concition Followrup Ct Time Zone ). Fallowup Ot Appt

mlcc

[Hu | [ $0.00 [ [NONE [11/30/2009 04:47:19 M | [1/30/2009 044718 a0 [ =

e

[pe [11:2772009 | $200.00 b [MONE [11r30r2009 04:45:34 am | [11/30/2009 04:45:34 am [

lcc

[112772009 | $101.00 I [NONE [11r3002009 044158 M | [11/30/2009 04:41:58 A [

[ro

[ra [ [ soon [ [DELa [11r21r2008 082187 2w | [11/21 /2008 09:21:47 am [

\ I
[ [
2 \ [
[ [
\ [

[ro

|Lr [ [ 50.00 [ [NonE [11:21/2008 D9:21:04 M | [11721 /2008 09:21:00 am [~

If there is a previous bankruptcy record in the Details block, choose Create New Bank-
ruptcy to refresh the Bankruptcy page.

Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current bankruptcy record.
Followup Dt Enter the follow-up date for the bankruptcy (required).
File Received Dt Enter the file received date for the bankruptcy (optional).
Disposition Select the bankruptcy disposition (required).

Bankruptcy Start Dt Enter the bankruptcy start date (optional).

Type Select the bankruptcy type (optional).

Bankruptcy End Dt Enter the bankruptcy end date (optional).

Comment Enter a comment (optional).
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4  Choose Create Tracking.
Oracle Daybreak loads the bankruptcy tracking parameters.
5 Ifyou want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.
7 Save your entry.

Note: Sub pages for the Bankruptcy page are described in the Account Details sub
pages section of this chapter.
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Repo/Foreclosure (5) master tab

The Repo/Foreclosure (5) master tab allows you to record information regarding reposses-
sions on the Repossession page or foreclosures on the Foreclosure page in a manner simi-
lar to how bankruptcies are recorded on the Bankruptcy page. You can track each stage of
the repossession or foreclosure process based on the follow-up date and record informa-
tion using the Details and Tracking blocks.

On occasion, a lender performs multiple foreclosures or repossessions for the same lease.
The Create New Fore Closure buttons on the Repossession and Foreclosure pages enable
you to create a new repossession or foreclosure record for a different collateral and differ-
ent start and end dates. You can also use the Repossession and Foreclosure pages to view
the previous repossession or foreclosure information using the scroll bar in the Details
block. The Current box in the Details block indicates the current repossession or foreclo-
sure record for each asset.

You can update the current record, but previous records cannot be modified.

To enter repossession details for an account

Using the Customer Service form, load the account you want to add repossession details to
and choose the Repo/Foreclosure (5) master tab, then choose Repossession.

Search o0 auto Run Accounts

Acc # Status Procuct Payoff Amt Amt Due Olddest Due Ot Company  Branch
[ Mg | m (0070100014576 |scTivE REPD | LEASE VEHICLE | 15,0000 | $0.00 020007 [s3FC [Ha =
400 #20070100014975 [ [ [ [ [ [ [ [ ~]
or 55N Tatal| $15,000.00 | $0.00 # of Accounts 1
Search (1) Customer Service (20  Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (8) Contract (7) Collsteral (8) Buresu (3] Comments (10)
Repozsession l RETEEEEITE Analysis
Tracking
Sub Aftribute [ALL
Parameter “alue
u =
Details I
Current W |
Followeup Ot File Received Ot =l |
Disposition ‘ Repo Ot
Type ‘ Repo End Ot I
Collateral |
Commert | ~] I
Create New Repossession Create Tracking |
[
[
| ~]
Call Activities l Promises Commerts Checklist References Payment Rating History  Due Date History
Action Result Cortact Reason Promize Ot Promize Amt Cancel  Condition Followup Ot Time Zone A, Folliowup O Appt
mlcr |ore o | [ | 50.00 [ [NOME 0472472007 12:00:00 &M | UNDEFINED [04i24r2007 12.00.00 &M [~
[ [ [ [ [ [ =il [ [ [ r
[ \ [ [ \ [ el \ [ [ r
[ [ [ [ [ [ o | [ [ [ = 8
[ [ [ [ [ [ =il [ [ [ Cil

Note: If there is a previous repossession record in the Details block, choose Create New
Repossession to refresh the Repossession page.

Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclo-
sure record.

Followup Dt Enter the follow-up date for the repossession/foreclosure
(required).
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File Received Dt Enter the file received date for the repossession/foreclo-
sure (optional).

Select the repossession/foreclosure disposition
(required).

Enter the repossession/foreclosure start date (optional).

Disposition

Repo/Forc Start Dt

Type Select the repossession/foreclosure type (optional).
Repo/Forc End Dt Enter the repossession/foreclosure end date (optional).
Collateral Select the repossession/foreclosure asset (required).
Comment Enter a comment (optional).

3 Choose Create Tracking.

Oracle Daybreak loads the repossession tracking parameters.

4 Ifyou want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

5 Complete the Tracking block.

6 Save any changes you made to the account.
Note: Sub pages for the Repossession page are described in the Account Details sub
pages section of this chapter.
To enter foreclosure details for an account

1 Using the Customer Service form, load the account you want to add foreclosure details to

and choose the Repo/Foreclosure (5) master tab, then choose Foreclosure.

Search o . o

[ tix | m [20010200031543

\ding Request : 0)

HEEILE Acc # Status
|cHaRGED OFF

Avtta Run Procuct

LEASE VEHICLE |

Paryoff &mt
$0.00 |

At Dug Cldest Due Dt Company  Branch
$0.00 042272007 [ssFc ot

A #2001 1200031 543

Al

[1120200032343 |CHARGED OFF [LEASE vEHICLE | $0.00 | 5000 042272007 [ssFC jent

or S5 Shaow Al Tatal | soon | $0.00 # of Accounts 6
Search (1) Customer Service (2)  Maintenance (3)  Bankruptcy (4)  RepoiForeclosure (5) Deticiency (6] Contract (7) Collateral (8) Bureau (9) Cotnmerts (10)
FERESESEI, Foreclosure { Analysis
Tracking
Sub Attribute ALL
Parameter Valug

-

\
Details ‘
Currert [ ‘
Fuallowup Ot File Received Dt = ‘
Disposition | Foreclosure Ot ‘
Type | Foreclosure End Ot ‘
Collsteral | [
Commert | = }
Create Mew Fareclosure Create Tracking ‘
[
[
| ~
Call Activities { Promises Comments Checklist References Payment Rating History — Due Date History
Action Result Cortact Reason Promise Dt Promise Amt Cancel  Condition Fallovwup Dt Acdj. Followiup Dt Appt

mjce

|Hu

$0.00 [ [NONE

[11/3002000 04:47:19 40 |

[11r3002000 a7 1e am [

lcc

[P

[11.272200 |

$200.00 | [NONE

1143002009 04534 M |

[11/5002009 04.45:34 am [

lcc

(=3

$101 00 [ [NONE

[11.300200 4155 am |

[11/30/2009 04:41:56 &M [

[ro

|Lm

g0.00 [ [pELG

[11:212008 09:21:47 am |

[11:21/2008 032197 2 [

[T

|Lm

\
\
[ [11:2712009
[
\

$0.00 [ [NONE

[11.421 12005 092104 M |

[11/2102008 09.21:04 &M [+

Note: If there is a previous foreclosure record in the Details block, choose Create New
Foreclosure to refresh the Foreclosure page.
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2 Complete the Details block.

In this field:

Current box
Followup Dt
File Received Dt
Disposition

Repo/Forc Start Dt
Type

Repo/Forc End Dt
Collateral
Comment

Choose Create Tracking.

Do this:

Select to indicate this is the current repossession/foreclo-
sure record.

Enter the follow-up date for the repossession/foreclosure
(required).

Enter the file received date for the repossession/foreclo-
sure (optional).

Select the repossession/foreclosure disposition
(required).

Enter the repossession/foreclosure start date (optional).
Select the repossession/foreclosure type (optional).
Enter the repossession/foreclosure end date (optional).
Select the repossession/foreclosure asset (required).
Enter a comment (optional).

Oracle Daybreak loads the foreclosure tracking parameters.

If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

Complete the Tracking block.

Save any changes you made to the account.

Note: Sub pages for the Foreclosure page are described in the Account Details sub

pages section of this chapter.
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Recording repossession or foreclosure analysis

The Analysis page allows you to create and analyze possible scenarios for the remarketing
and the sale of the asset. This enables you to calculate the possible gain or loss in the sale
of an asset. Expenses already incurred on the asset are displayed on the form. You can
change the numbers if you expect more expenses by the time the asset is sold.

Note: You can have three Repo/Foreclosure analyses and three Sales analyses on a work-
sheet, but you can create more than one analysis worksheet.

To complete a repossession/foreclosure analysis or sales analysis for an
account

Load the account you want to work with on using the Customer Service form.

Choose the Repo/Foreclosure (5) master tab, then choose the Analysis tab.

Search o eue Auta Run Accounts oy Statuz Froduct Payotf At AmtDue  Oldest Dug Dt Company Branch
[ [ng | m [20010200031543 |cHaRGED OFF | LEASE VEHICLE | 50.00 | $0.00 04222007 [ssFc [ent -
oo #2001 0200031 543 [1120200032343 |cHaRGED OFF | LEASE YEHICLE | 50.00 | $0.00 04222007 [ssFc [en B
OF SN Shawe Al Tcrta\l $0.00 | $0.00 # of Ac:ourﬂsﬁ
Search (1) Customer Service (2)  Maintensnce (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (B) Cortract (7) Collateral (5) Bureau (9) Comments (10)
REREEEESSIEN Foreclosure Analysis {
Cu‘r‘r‘:a:rt‘ygis e Balance % Analysis Dt RememeunsureAna\ysws 1 Analysis 2 Analysis 3 Soles Bid1 Bid 2 Bid 3
W | T | T | = Sale Prics | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
""" Asset Expenses(-)| $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
[ Refunds(+) 50.00 | 50.00 | 5000 | $0.00 | $0.00 | $0.00
Current Yalue het Proceeds(=)| F0.00 | F0.00 | $0.00 [ s000 | s000 | $0.00
50.00 Balance(-)| 50.00 | 50.00 | .00 | $0.00 | $0.00 | §0.00
Analysis Comment het Gainloss(=) | $0.00 | $0.00 | $0.00 [ $0.00 | $0.00 | §0.00
Recovery % 000 | 000 | 000 [ 000 | 000 | 000
Analysis Elyl | | | | |
Status|MER |mEwAY |mEwy =5 =0 =0
Final Analysis Final Sales Verity D'll | | | | |
& hone ® hone Verity By | | | | | |
L B
C mnstysis 2 ez Load 1 | Load 2 | Load 3 | Load 4 J Load 5 J Load §
Cltnelysisd CBida
i By | [ [
Expenzes l Retuncs
Repo/Foreclosure Sales
Expense Type Manual  Analysis! Amt  Analysis? Amt  Analysis3 Amt Bicil At Bici2 Armt Bicld Amt
m | Vo $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00 |~
[ o [ [ [ [ [
[ | [ [ [ [ [
[ ] [ [ [ [ [ >

Select the Current box if you wish to indicate that this is the current analysis worksheet

In the Analysis block, use the Level field to select the analysis level you want to use,
ACCOUNT or ASSET.

Choose Account if you want the analysis to use the value of the entire account.
Choose Asset if you want the analysis to use the value of a particular asset.

Enter the following information in the Analysis block:

In this block:

Balance %
Analysis Dt
Asset

Current Value
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Do this:

Enter balance allocation percentage (required).

View the analysis date (display only).

If you want to perform an analysis for a particular asset,
select the asset (optional).

View the asset current total value (display only).

lection



Analysis Comment

Enter comment associated with the analysis (optional).

6 Enter all the required information in the Repo/Foreclosure or Sales block, depending on
the type of incident you are analyzing.

7 Complete the details in the Expenses and Refunds sub pages, corresponding to the anal-
ysis or bid number on the Analysis page.

* To complete the Expenses sub page:

In this field:

Expense Type
Manual

Do this:

Select the expense type (required).
Indicates that the expense was entered manually
(required).

Repo/Foreclosure block

Analysis1 Amt
Analysis2 Amt
Analysis3 Amt

Sales block
Bid1 Amt
Bid2 Amt
Bid3 Amt

Enter the expense amount for analysis1 (required).
Enter the expense amount for analysis2 (required).
Enter the expense amount for analysis3 (required).

Enter the expense amount for bid1 (required).
Enter the expense amount for bid2 (required).
Enter the expense amount for bid3 (required).

* To complete the Refunds sub page:

Search o o o

Refund Type
Manual

Ao Run Accounts -y Statuz Product Payott Amt AmtDue  Oldest Due Dt Company Branch
[ (Mg | m [20010200031543 |CHARGED OFF LEASE VEHICLE | $0.00 | $0.00 042212007 [SSFC oo B
Acc #[20010200031543 [1120200052343 [cHARGED OFF [ LEASE vERICLE | $0.00 | $0.00 042212007 [SSFC [ood ~
Or SN Shaw &)l Total| $0.00 | $0.00 # of Accounts &
Search (1] Customet Service (2] Mairtenance (3)  Bankruptcy (4] RepofForeclosure (5] Deficiency (6) Cortract (7) Collsteral (3) Bureau (9) Comments (10)
e sl Foreclosure Analysis {
Analysis Repo.Foreclosure i . Sales _. .
Current Level Belancs % Anslysis Dt Analysis 1 Analysis 2 Analysis 3 Bid 1 Bic 2 Bid 3
il T TR Zale Price| $0.00 | $0.00 | §0.00 | $0.00 | $0.00 | $0.00
""" e Expensest-)| $0.00 | $0.00 | §0.00 | $0.00 | §0.00 | $0.00
[ Retunds(+) 50.00 | $0.00 | $000 | 50.00 | $0.00 | $0.00
Current Yalue het Proceeds(=) 5000 | 000 | $0.00 [ 5000 | s000 §0.00
$0.00 Balancel-)| $0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
Analysis Comment Met GainLoss(=)| $0.00 $0.00 | $0.00 [ $0.00 | $0.00 | $0.00
Reoovery % 000 | 000 | 000 [ 000 | 000 | 000
analysis By | \ | | |
Status B |rE [WEws B ey (=
Final Analysis Final Sales Verify Dt| | ‘ | | |
® [ong ® [one “erify By | [ [ [ [ [
O Analysis 1 L=
 pnsiysis 2 - Load 1 | Load 2 | Load 3 | Load 4 | Load 5 | Load &
@ Analysie 3 CBid |
Bir By [ [
Expenzes Retunds l
Repo/Foreclosure
Refund Type Manual Analysis Amt Analysis2 Amt Analysis3 Amt Bid1 Amt Bici2 Amt Bici3 Amt
m| T $0.00 | $0.00 | $000 | $0.00 | $0.00 | $0.00 A
[ m || [ [ [ [ [
[ ER [ \ \ [ [
[ m ] [ \ \ [ [ -
In this field: Do this:

Select the refund type (required).
Indicates that the refund was entered manually
(required).
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Repo/Foreclosure block

Analysis1 Amt Enter the refund amount for analysis1 (required).
Analysis2 Amt Enter the refund amount for analysis2 (required).
Analysis3 Amt Enter the refund amount for analysis3 (required).
Sales block

Bid1 Amt Enter the refund amount for bid1 (required).
Bid2 Amt Enter the refund amount for bid2 (required).
Bid3 Amt Enter the refund amount for bid3 (required).

The data here is loaded to the analysis and bid columns as “expenses” and “refunds.”

8 Ifyou are analyzing a repossession/foreclosure, choose the corresponding Load button on
the Repo/Foreclosure block to load details on the Repo/Foreclosure block spread sheet.

If you are analyzing a sale of an asset, choose the corresponding Load (#) button on the
Sales block to load details on the Repo/Foreclosure block spread sheet.

If this is a sales analysis and you know who is bidding, complete the Bid By fields.

9 Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales
analysis.

10 In the Status field, select the status of the analysis: APPROVED or REJECTED.

11 When you have decided which analysis or which sale bid you want to approve, select your
choice in the either the Final Analysis or Final Sales block.

Note: You can approve only one analysis.

12 Save your entry.
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Deficiency (6) master tab

The Deficiency (6) master tab allows you to record information about deficiency accounts
- accounts that are no longer collectable. You can create and track specific details on the
status of the charged-off account for timely follow-up and analysis. You can track each
stage of the deficiency process based on its follow-up date and record information using
the Details and Tracking blocks.

The Create New Deficiency button enables you to create a new deficiency record with dif-
ferent start and end dates. You can also use the Deficiency page to view the previous defi-
ciency information using the scroll bar in the Details block. The Current box in the Details
block indicates the current bankruptcy details.

Note: To view the balance of a charged off account, choose the Customer Service (2)

master tab, then choose the Balances tab and in the Balance Group block, select Defi-
ciency Balance.

To enter deficiency details for an account

Using the Customer Service form, load the account you want to add deficiency details to
and choose the Deficiency (6) master tab.

Search g0 e Auto Run Accounts ., Status Pracuct Payaff Amt AmtDus  Oldest Due Dt Company Branch
[ (Mg | = [20010200031543 |cHARGED OFF LEASE YEHICLE | $o.00 | $0.00 [ndzi2007 [S5FC [cm B
oo #120010200031543 [1120200032343 [cHARGED OFF LEASE VEHICLE | $0.00 | $0.00 042202007 [SSFC [co =]
Or SSh Show &1 Tatal| $0.00 | $0.00 # of Accounts [
Search (1) Customer Service (20 Maintenance (31 Bankruptcy () RepofForeclosure (5) Deficiency (8) Contract (7) Collsteral (8) Buresu (3] Comments (10)
Deficiency l
Tracking
Sub Attribute | ALL
Parameter Yalue
l| =
Details I
Current WV
Followsup Ot File Received Ot =] |
Disposition Charge Off Dt 01052010 |
Type ‘ Deficiency End Dt I
Comment ‘ ~) |
Create Mewy Deficiency Create Tracking ‘ |
|
[
[
| ~]
Call Activities l Promises Commerts Checklist References Payment Rating History  Due Date History
Action Result Cortact Reason Promize Ot Promize Amt Cancel  Condition Followup Ot Time Zone A, Folliowup O Appt
mfcc HU | | [ | 50.00 [ [NOME [1/30/2009 04:47:18 AM | [11/30/2009 044719 AW [ 1=
|cc 3 [ [ [1172772009 | 200,00 v [HONE [11/30/2008 04:45:34 &M | [11.3002009 04:45:34 2w [
o PP | | [1/27/2009 | $101.00 I [MONE [11/30/2009 04:41:58 &M | [11.43002009 0 41:58 ant [
[ro [Lra [ [ [ [ s0.00 [ [pEL@ [11/21/2008 09:21:47 am | [11.021 2008 02 2147 amt [
[ro [Lm [ [ [ [ 30.00 [ [MONE [11721/2008 09:21:04 &M | [11:212008 09:21:04 2 [ <]
2 Ifthere is a previous deficiency record in the Details block, choose Create New Defi-

ciency to refresh the Deficiency page.

Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current deficiency record.
Followup Dt Enter the follow-up date for the deficiency (required).
File Received Dt Enter the file received date for the deficiency (optional).
Disposition Select the deficiency disposition (required).
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Charge Off Dt Enter the deficiency start date (optional).

Type Select the deficiency type (optional).
Deficiency End Dt Enter the deficiency end date (optional).
Comment Enter a comment (optional).

4  Choose Create Tracking.

Oracle Daybreak loads the repossession/foreclosure tracking parameters that track actions
taken to collect on the account.

5 Ifyou want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.
7 Save your entry.

Note: Sub pages for the Deficiency page are described in the Account Details sub pages
section of this chapter.
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Contract (7) master tab

The Customer Service form Contract (7) master tab allows you to view the contract and
truth-in-lending information recorded during the funding process. It’s a display only ver-
sion of the same pages and sub pages found on the Funding form Contract (5) master tab.

To view an account’s contract information
1 Open the Customer Service form and load the account you want to work with.

2 Choose the Contract (7) master tab.

Search g, Auta Run Accounts oy Status Product Payoff Amt AmtDue  Oldest Due D Company Branch
T nx | m [20080101009703 |4CTIVEDELGSCHEDULED ¢ [LEASE WEHICLE | 1032280 | FI040270 (202008 [S5FC [con 4
Acc #[200601 01009703 2008020101 9604 |cHaRGED OFF [Loan veHcLE | $0.00 | $0.00 03102006 [sSFC [cm B
0Or 55N Show )il Tt $12,28042 | §10,953.68 #of Accounts| 10
Search (1) Customer Service (2)  Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5)  Deficiency (6) Cortract (7) Collateral (8) Bureau (9) Commerts (10)
ez ) Wizl rzelie Leaze I Ezefoy Sl
Contract
Gross Capitalized Cost $12,000.00
Contract Ot | ITUNZE Capitalized Cost Reduction (-) §1,000.00
- Instrument |LEASE INSTRUMENT
At Due &t Signing $2,019.22 Adjusted Cap Cost (=) $11,000.00 Residual %
Total of Paymerts (Estimated) $10,633.92 Residual alue (3 $2,50000 | 20.833533 Acorial i (ACTURRIAL -MONTHLY
Due Day 10 Deprecistion Value (=) $8,50000  Rate Rent Factor Bill hthcl |LEVEL Bill Type |STATEMENT
1t Pt 0|01 102008 Rent Charge (+)] 5219992  8.9900 0004527 | Gales Tax o [UPFRONT (GAF bithel PURCHASE PRI
Maturity Ct[12/10/2008 Tatal of Base Manthly Prts (=) $10,699.92 Lease Type DIRECT FINANC
Security Depost: $500.00 Leaze Term (/) 36
Reve Ot (011072008 Baze Marthly Payment (=) 329722 Sales Tax %
Werify Ot 1 A0/2006 Estimated Morthly Sales Tax (+)] $0.00 | 0000000
erifiec By | UNDEFINED Estimated! Monthly Prmt (=) $297.22
Cortract I Cortract (2) femization Trade-n  Insurance ESC  Escrowy  Compensafion  Compensation  Subwention  Proceeds  Dishursement Fee® “ACH REEUEGNN SREH EE e RE
Tol Due Dat
Servicing Branch |CU1 Collector |GIR\ olerance Refund ¥ ue fate
Mige: ’7 Max Due Day Chy Days | 15
[ LinkTo  Anniversary Period| 12 Fetund Tolerance #1.00 MinDuaDag[ 1 Wax| 3T
P in Due Day 5
Esling  pefat Pt Spread [ACTIVE SPREAD-LEASE Pirt Tolerance $1000)|F 55 0000/ T ——
Custamer Wiiteoff Tolerance 10,00 ax Lue Lay th Tr e
Billing = 5
PreBill Days| 21 Bil Cycle MONTHLY Delinguency Extension
Late Charge Grace Days 10
HHMDA — Wax B Period e[ 2 Lite[ 5
Lien Status [NOT APPLICABLE HOEPA [ORIGINATED OF PUR Delg Grace Days| 8 -
[2x3 nYr Ife
Rete Spread | 0.0000 el Cat i [0S

3 Use the following sub pages to view more information about the contract, if available:

¢ Contract

e Contract (2)
¢ Itemization
¢ Trade-In

e Insurance

« ESC

*  Compensation (lease)
¢ Subvention
¢ Proceeds

* Fee

« ACH
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Collateral (8) master tab

The Collateral (8) master tab contains pages that record information regarding any assets
associated with an account. Collateral can be a vehicle, home, or something else, such as
household goods.

To view the Collateral details

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Collateral (8) master tab.

» Ifthe account’s collateral is a vehicle, the Vehicle page appears:

Search g, Auta Run Accounts Status Product Payoft At AmtDue  Oldest Due Dt Company Branch
[ mx | m [20041200004423 |acTrve | LEASE wEHICLE §15,139.20 $0.00 01012005 [s5FC |Ha -
Aoe #]20041 200004423 [ [ [ [ [ [ ~
Or S3N| Total $15,139.20 $0.00 # of Accourts 1
Search 1) Customer Service (20 Maintenance (3)  Bankruptoy (41 Repo/Foreciosure (51 Deficiency (51 Cortract (7) Callateral (3 Buresau r9) Commerts (10)
wvehicle || Home | Siter
Vehicle Usage Details
“ear Make hode! Body
USED VEHICLE 2001 [Braey B2s 1T wisGoN =]
\VEHICLE Desc [2001 B 325 1T WAGON kT 9
Suls Type [CAR Conition | EREs 0
Identification Mumber WBACJ352XSIC34208 Address (32218 [saTH 2vE Extra 0
Registration # |UNDEFINED Total o
Status |NOT DEFINED City [HOmOLULU st zZip[essso Courtry [US Charge $0.00
“wehicle Details County |HOMOLULL =
Y aluation l Tracking
Value Addons
Currert ¥ Valuation Dt [06/21/2004 - Addon/attrioute velus At
- L [REDElE m[cD PLAYER [kErooD | $1,00000 =
ource
T [LEATHER SEATS [BLack [ $500.00
et Yalu S g [POWVER WANDICHAS [pLue TiT [ $500.00
Edition [2004
Whaolesale Retail ‘ |
Base $17,000.00 Base $19,500.00 [
Addons + $2,000.00 I

[ [

\ [

Usage 42068 Usage Value + $0.00 } I
Total Value = $21,500.00 -

- [ [

e Ifthe account’s collateral is a home, the Home page appears:

Auto Run EECLLE e Status Product Payaft Amt 2t Dug Gldest Due Ot Company  Branch
™ wx | m [200102000%1543 [cHARGED OFF LEASE YEHCLE | $0.00 $0.00 joaizzez007 [ssFC oot -]
Ace #2001 0200031543 [1120200032343 |cHaRGED OFF | LEASE vEHCLE | $0.00 | $0.00 [04/22/2007 [3SFC [co -]
or 5N Show Al Total $0.00 $0.00 # of Accaunts B
Search (1) Customer Service (2) Maintenance (3) Bankrupicy (41  RepoForeclosure (5)  Deficiency (5)  Coriract (7) Collateral (8) Burssu(8)  Commerts (10)
Veriee | Home || Ghier
Home
Primary [ Asset Class [NEA HOME “ear hiake hodel w L Legal Description
substiute oot typeliome 2005 |UNDEFINED UNDEFINED 43 22 ‘ al
Asset Mumbsr  Sub Type [SINGLE FAMILY HOME Deseription [2005 UNDEFINED UNDEFINED
UMDEFINED Occupancy | PO (0123424234333 Caneition [50CD CONDITIGNED Lot Sub Division Parcel I
Id # [KT4534F 5345343333 Address [535 535 PRAIRIE CENTRE DR [ [ [
Census TractBNA Code[7383.3222
MSA Code [327873-3665 City [EDEN PRAIRIE stfun | zip[ss3a4 Courtry [Us Metes-Bourds [ Flood Zone | =
GeoCade (36626332632 Courtty [HEMMERI
aluation | Tracking
Value Addons
=] AcdonAttribut Val At
Current 2 ‘alugtion Ot [03/28/2007 - RS Lo -
Source [INVOICE r
Getiaie Supplement
Edltion
Wholesals Retail
B | 524,000.00 Base| $24,000.00 [ [ [
Addons + $0.00 [ [ [
Usage | 0 Usage Value + | $0.00
Total Value = §2400000 L
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* Ifthe account’s collateral is neither a vehicle nor a home, the Other page appears:

Total Value = $24,000.00

Usage 0 Usage Value + $0.00

) (s nding Request: 0y -7
Search g0 Auta Run Accounts Status Product Fayoit Amt AmtDue  Oldest Dus Dt Compary Branch
| [ Mg | m [20001100031983 |cHARGED OFF | LEASE VEHICLE | $0.00 | $0.00 (121062000 [SSFC [CO1 =
Ace #[20001100031983 | | [ | | | | | [~]
or S3h Total| 1513515 | 50.00 # of Accounts 1
Search (1) Customer Service (21 Maintenance (3)  Bankruptcy (4)  RepoForeclosurs(5)  Deficiency (5) Cortract (7) Collsteral (5) Bureau (9) Commerts (10)
Senitien | Home, | other |
Other Usage Details
Vear Make Madel Bacly
Primary [ 8sset Class [NEW ASSET 2002 |SENERAL PERSOMAL ¢ [ =
Substitute| Asset Type [HOUSEHOLD GooDS Desc (2002 GENERAL PERSONAL GOCD Start o
Sub Type [SENERAL HOUSEHOLD GOC | Gongition [GOOD CONDITIONED =D i
idertification Mumber [13573055555390004 Address [45231 [wonooaLe RosD Extra 0
Registration # [UNDEFINED [ Tatal o
Status [NOT DEFINED City |M\NNEAPOL\S StiMM Zip 28422 [1001 Courtry [US Charge: F0.00
Courty L
“aluation I Tracking
Value Addons
=] Addoniattribul Vil Amt
Current walustion Dt [03728.2007 ol EnEriaue ‘ e ‘ <
Source [voIcE | ‘ ‘ =
et alue Supplement | ‘ ‘
Ecltion
Wholesals Retail | [ [
Base $24,000.00 Base $24,000.00 [ [ [
Addons + $0.00 I } }

Substituting collateral

With the Customer Service form, you can substitute one asset for another to be used as an
account’s collateral. However, you cannot substitute collateral involving homes.

To substitute the collateral for an account

Open the Customer Service form and load the account with the collateral you want to sub-
stitute.

Choose the Collateral (8) master tab.

Depending on the account you selected, the Vehicle or Other page appears.

Press Fé6 to clear the page.

Enter the data regarding the new asset to be used as collateral on the available page

If you are using the Vehicle page, complete the Vehicle block:

In this field:

Asset Class

Asset Type

Sub Type
Identification Number
Registration #

Do this:

Select the asset class (required).

Select the asset type (required).

Select the asset sub-type (required).

Enter the identification number (optional).
Enter the registration number (required).

Status Select the asset status (required).

Year Enter the year of the vehicle (required).
Make Select the make of the vehicle (optional).
Model Select the model of the vehicle (optional).
Body Enter the body of the vehicle (optional).
Desc View the vehicle description (display only).
Condition Select the vehicle condition (optional).
Address (#) Enter the building number (optional).
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Address 1 (unlabeled) Enter the address line 1 (optional).

Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).

St Select the state (optional).

Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).

Oracle Daybreak validates the VIN if you add or modify the Identification Number field
on the Customer Service form’s Vehicle page.

Interface with VINTEK (If interface is installed)

Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

e Year

* Make
¢ Model
*  Body

If the Vintek interface is unable to retrieve information based on the VIN entered in the
Identification Number field, Oracle Daybreak displays an error message.

If this account involves leasing, complete the Usage Details block. Note: Information in
this block pertains only to leases. The Usage Details block records details about the
allowed and extra mileage covered as part of the lease agreement:

In this field: Do this:

Start Enter the initial usage (required).

Base Enter the base usage (required).

Extra Enter the extra usage purchased (required).
Total Enter the total usage (required).

Charge Enter the usage charge (required).

If you are using the Other page, complete the Other block:

In this field: Do this:

Asset Class Select the asset class (required).

Asset Type Select the asset type (required).

Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).

Year Enter the year of the collateral (required).
Make Select the make of the collateral (optional).
Model Select the model of the collateral (optional).
Body Enter the body of the collateral (optional).
Desc View the collateral description (display only).
Condition Select the collateral condition (required).
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6
7

Address (#) Enter the building number (optional).

Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).

St Select the state (optional).

Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).

If this account involves leasing, complete the Usage Details block. Note: Information in
this block pertains only to leases. The Usage Details block records details about the
allowed and extra mileage covered as part of the lease agreement:

In this field: Do this:

Start Enter the initial usage (required).

Base Enter the base usage (required).

Extra Enter the extra usage purchased (required).
Total Enter the total usage (required).

Charge Enter the usage charge (required).

Note: Accounts that are secured with collateral can have exactly one Primary collateral.
Clear the Primary box on the collateral you are replacing and select the Primary box on
the new collateral page.

Select Substitute on the new collateral page.

Save your entry.

Valuation sub page

b W

With the Valuation sub page, you can change the collateral or asset valuation for an
account. In this process, you reassess the current value of the collateral (which has been
used to secure the loan) using multiple sources. This helps companies determine if the risk
of delinquency or charge off is worth the asset securing it.

To add the collateral or asset valuation for an account

Open the Customer Service form and load the account you want to work with.
Choose the Collateral (8) master tab.

On the available page (Vehicle, Home, or Other), choose the Valuation sub tab.
If the Valuation sub page already contains information, press Fé to clear it.

On the Valuation sub page do the following

In this field: Do this:

Value block

Current Select if this is the current valuation (required).
Valuation Dt Enter the valuation date (required).

Source Select the valuation source (required).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).
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Wholesale (Base) Enter the wholesale value (required).

Usage Enter the usage. This pertains to leases and usually is
entered as the current mileage on the vehicle (required).

Retail (Base) Enter the retail value (required).

Addons + View the add-ons value (display only).

Usage Value + Enter the usage value; that is, the monetary effect that the
current mileage has on the value of the vehicle (required).

Total Value = View the total value (display only).

Addons block

Addon/Attribute Select the add-on/attribute (required).

Value Enter the value of the attribute (optional).

Amt Enter the add-on amount (required).

6 Save the changes you made to the account.

Note: Assets can have exactly one current valuation. NADA and Kelly Blue Book inter-
faces are available only in the client/server environment.

Tracking sub page

With the Tracking sub page, you can add the collateral or asset tracking details for an
account. This allows you to track additional data related to an asset, such as the location of
the title, liens, and insurance information.

To add the collateral or asset tracking for an account
1 Load the account you want to work on using the Customer Service form.

2 Choose the Collateral (8) master tab.

3 On the available page (Vehicle, Home, or Other), choose the Tracking sub tab.

nding Requ
Search o\, Auto Run Accounts Ao # Status Product Payoft Amt Amt Due Cldest Due Ot Company  Branch
[ ‘hie | m [20010200031543 |cHaRGED oFF | LEASE vEHICLE | 30.00 | $0.00 j04i22i2007 [SSFC [cot -
Ace #120010200031543 [1120000032343 |cHARGED OFF | CEasE vERCLE | 30.00 | $0.00 [odi2ze2007 [s3FC [om ~
Or 55N Shawy &l Tetal| g0.00 | $0.00 # of dooounts &
Search (1) Customer Service (2)  Maintenance (3)  Bankruptcy (4)  RepoForeclosure (5) Deficiency (6) Cortract (T) Collateral (8) Bureau (9) Comments (10)
WenisEs|  Home l g
Home
Primary [ Asset Class BV HOME ‘ear Make Mods! w L Legal Description
susstivtel " pocotTypelrovE 2005 [LUNDEFINED: [UNDEFINED 43 |22 ‘ =]
B Subs Type [SINGLE FAMILY HOME Description |2DDS UINDEFINED LINDEFINED
UNDEFINED Occupancvl PO [#D123424234333 Condition (300D COMDITIONED Lot Sub Division Parcel ID
o # [{T4534FG345343353 Address 35 635 PRAIRIE CENTRE DR [ [ [
Cenzus TractBhla Code |?383-3222 |
MSA Code[327873-3665 City [EDEM PRAIRIE StiMM Zip 55344 Caurtry [US  Metes-Bounds [ Flood Zone[ (=
GenoCode (39526932832 Courty [HEMNERIN
Walustion  Tracking l
IR (e Tracking tem Disposition Start Ot EnciCt  Followwup Ot Enshbled -
- " | | | | i Laad Details
| | | | | = .
Commert| ~)
Tracking tem Details
Parameter Value T
[l -
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4  Choose Load Details.

5 Enter or select the tracking details in the Tracking Items block.

In this field: Do this:

Tracking Items block

Tracking Item View the tracking type (display only).

Disposition Select the disposition (required).

Start Dt Enter the tracking start date (required).

End Dt Enter the tracking end date (optional).

Followup Dt Enter the next follow-up date (required).

Enabled Select to track the information from the start date in the
Start Dt field. (required).

Comment Enter a comment (optional).

Tracking Items Details block
Parameter View parameter (display only).

Value Enter the tracking parameter value (optional).

6 Save any changes you made to the account.
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Bureau (9) master tab

The Customer Service form Bureau (9) master tab allows you to create and pull a credit
bureau report and view the results as a text only file.

To request a manual credit bureau report
1 Open the Customer Service form and load the account you want to work with.

2 Choose the Bureau (9) master tab.

< Queus Auto Run s

Acc Status Product Payol Amt AmtDue  Oldest Due Dt Company Branch

{ [ mx| m [20010200031543 |CHARGED OFF LEASE YEHICLE | $0.00 30.00 [04/22/2007 |SSFC [CO1 [~]
Acc #20010200031543 (1120200032343 |[CHARGED OFF LEASE WEHICLE | 30.00 | 30.00 [04222007 |SSFC o1 [~]
or 5N Show &)1 Totel $0.00 $0.00 # of Accounts 6
Search (1) Customer Service (2)  Maimtenance (3)  Bankruplcy (4)  RepoForeciosure (5)  Deficiency (6) Contract (7 Collatersl (8) Bureau (3) Commerts (10)
New Request Bureau Details
Customer Type Bureau  # Status ot Report Credit Bureau Reorderd  app Ind

Spouse ol [ || [ [ [ m 2
r =

e — \ — [ | [
Report ApplicantiCustomner Detail
Tvie First Name i Last Mame Suffix AddressType  #  Pre Street StType Post AptNo
Create Request | Submit Recusst [ I I I [ I T [

Hun
View Report Birth Ot | Phore | [

 seryicing Qrigination Status: City St Zip

IMPORTANT:  #ccess to credit reporting sgency systems is for authoriz
profibitec! undsr the Fair Crecit Reporting Act and is punis

rs and only for permissible purposes. Unauth
/& by = $2500 fine anclior 1 year in Federal priso

ce.
Print Repart

3 In the New Request block, use the LOV to complete the following fields:

In this field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau (required).

Report Select the credit bureau report type (required).

4 Choose Create Request.

Oracle Daybreak displays this information in the Bureau Details block and further infor-
mation about the customer in Applicant/Customer Detail block.

5 If'you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
block. This allows you to receive a previously pulled credit report from (currently other
bureaus do no provide a copy) (optional).

6 In the New Request block, choose Submit Request.
7 Press F8 to refresh the status of the credit request until the credit pull is completed.

Oracle Daybreak displays the latest status of the currently requested bureau report in the
Bureau Details block.

When the report pull process is complete, the Status field in the Applicant/Customer
Detail block changes to COMPLETED. The results of the credit bureau pull appear in the
list box at the bottom of the Customer Service form.

Note: To send a copy of the report to a predefined printer, choose Print Report.
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Comment (10) master tab

1
2

The Customer Service form Comment (10) master tab allows you to view and add free-
form text notes regarding an account at any time. This tab contains the same information
as the Comments sub page.

The Type field allows you to classify comments in user-defined categories. Oracle Day-
break assigns each comment a time-date stamp and records the User Id of who made the
comment.

To use the Customer Service form Comment tab
Open the Customer Service form and load the account you want to work with.

Choose the Comments (10) master tab.

Search . - auto Run Accounts

Acc # Status Product Payoff Amt Amt Due Olddest Due Ot Company  Branch
[ (Mg | = [20010200031543 |CHARGED OFF |LEASE VEHICLE | $0.00 | $0.00 [042202007 [s5FC [em B
Ace #120010200091543 [1120200092343 |cHARGED OFF [LEASE VEHICLE | $0.00 | $0.00 [0a22r2007 [ssFC [cm [+
Qr SSN| Shaw Al Tulal‘ $0.00 ‘ $0.00 # of Accounts ’_E
Search (1) Customer Service (20 Maintenance (31 Bankruptcy () RepofForeclosure (5) Deficiency (8) Contract (7) Collsteral (8) Buresu (3] Comments (10)
Comments l
f._lfrt Type Sub Type Comment
B[ |SYSTEMGENERATED  [SYSTEM GEWERATED  |acc_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNOE_STM_LTR JOB REQUEST - 1704753) =
INTERMAL |p108r2010 01:05:05 PM
[ |SYSTEM GENERATED  [SYSTEM GENERATED  |acc_STATEMENT LETTER GEMERATED. {CORRESPOMDENCE: CNLMOE_STM_LTR JOB REQUEST ID: 1704753)
[INTERNAL [01/08r2010 01:05: 08 P
[ \SYSTEM GENERATED |SYSTEM GEMERATED  |CUSTOMER CALLED-HUNG P
== [11r27r2008 04:47:33 21
[ [SYSTEM GENERATED  [SYSTEM GEMERATED  [CUISTOMER CALLED-PROMISE TO PaY-PROMISES $200.00 TO BE POSTED BY 11/27/2009
[ssc [11 12712008 04 45.53 M
[ [5VSTEM GENERATED  [SYSTEM GENERATED  [CLISTOMER: CALLED-PROMISE TO P4Y-PROMISES $101.00 TO BE POSTED BY 11/27/2009
[ssc [11r27r2008 04:43.05 M ‘ ||
[ [5VSTEM GENERATED  [SYSTEM GENERATED  [ACC_STATEMENT LETTER GEWERATED. (CORRESPONDENCE: CHLNOE_STM_LTR JOB REQUEST ID: 1667688)
[INTERMAL [11r25r2009 11:22:08 P11
[ |[SVSTEM GENERATED  |SYSTEM GENERATED ACC_STATEMENT LETTER GEMERATED. (CORRESPOMDENCE: CRLNOE_STM_LTR JOB REQLEST ID: 1667665)
[INTERNAL [11/25r2009 11:22:08 M
[ |[SVSTEM GENERATED  |SYSTEM GENERATED ACC_STATEMENT LETTER GEMERATED. (CORRESPOMDENCE: CRLNOE_STM_LTR JOB REQLEST ID: 1667665)
INTERMAL [11r25r2008 11:22.08 Pm
[ [SYSTEM GENERATED  [SYSTEM GENERATED  [acC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNGE_STM_LTR JOB REGLEST ID: 1667565)
[INTERMAL 112502009 11:22.08 PM
[ [5VSTEM GENERATED  [SYSTEM GENERATED  [ACC_STATEMENT LETTER GEWERATED. (CORRESPONDENCE: CHLNOE_STM_LTR JOB REQUEST ID: 1667688)
INTERMAL 112502009 11:22.08 PM ‘ he

AN »n B~ W

In the Type block, select the type of comment you are adding.

In the Sub Type block, select the sub type of comment you are adding.

In the Comments block, type your comment.

If you want Oracle Daybreak to recognize this comment as an alert, select Alert.

Note: If you select the Alert box, the comment appears on the Customer Service form’s
Account Details page in the Comment sub page.

Save any changes you made to the account.
Note: Comments on the Comments (10) master tab also appear on the Comments sub

pages
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CHAPTER 3 : REVIEW REQUESTS

The Review Requests page is primarily a workflow tool used to flag an account for the
attention of another Oracle Daybreak user and ask for feedback. It allows Oracle Day-
break users to send and receive messages (including e-mail) that make comments regard-
ing a specific account.

In this chapter, you will learn how to:

* Review a request

* Send a review request

* Respond to a review request
* E-mail a review request

e Close a review request.

Note: While the Review Request page is available on the Underwriting, Funding, and
Customer Service forms, the screen shots in this chapter will all use the Underwriting
form. The Underwriting form and Funding form use the same Review Request page and
contain an Application # column.

The Customer Service form’s Review Request page is nearly identical, though the

Account # column replaces the Application # column.

Review Requests page blocks
The Review Requests pages contains the following blocks:

*  Query
 Action
¢ Email

* Review Request

The Query block contains these option buttons:

If you choose this: Oracle Daybreak:

Originator Displays the active messages with your user id in the
Originator column of the Review Request block. These
are the review requests you created.

Receiver Displays the active messages with your user id in the
Receiver column of the Review Request block. These are
the messages you received.

Both Displays in the Review Requests block all the active
messages you created and received with a status other
than CLOSED.

View All Displays in the Review Requests block all the messages

you sent and received, both the active and closed.
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The Action block contains these command buttons:

If you choose this: Oracle Daybreak:

Send Request Sends a review request to another Oracle Daybreak user.

Send Response Sends a response to a review request from another Oracle
Daybreak user.

Close Changes the status of the message to “Closed” and

removes it from the Review Request block. Note: You
can view messages with a CLOSED status by selecting
View All in the Query block.

The Email block contains these command buttons:

If you choose: Oracle Daybreak:

Originator Sends an email of the review request information to the
person listed in the Originator column on the Review
Request block.

Receiver Sends an email of the review request to the person listed

in the Receiver column on the Review Request block.

Note: The email recipient cannot respond or reply to e-mails with the email system.
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Reviewing a request

When you receive a review request, Oracle Daybreak notifies you by completing the
Pending Request parenthesis in the form’s title bar with the number of unseen messages.

If you are working lease origination and you have a review request, the Pending Request
parenthesis in the Underwriting or Funding form will contain a number.

If you are working with an account, the Pending Request parenthesis in the Customer Ser-
vice form will contain a number.

To review requests

1  On the Lending menu, choose Underwriting or Funding if you are working in lease orig-
ination or Customer Service is your are working with accounts.

2 If the Pending Request parenthesis in the title bar contains a number, choose the Search
(1) master tab, then choose the Review Requests tab.

"'__ (RN g R e ndin | R e g S e e e e e e e e e e e e oo e e e e R R R e e

Application

s 2| ctf12n5r2004 ot cogl | Purpnse | Priority | Status | Company |
Prosuct Existing Customer” Dupl Contact[ channel Producer| [ Sales Agent |

Search (1) Applicarts (2) Decision (3) Cortract (9) Collateral (5) Comments (7) Image (5) “erification (9] Tools (10)

Resuts Search Review Requests {
Query Action Email
" Originator ® Receiver " Bigth “iews A1 Zend Reguest Send Response Close Origingtar Receiver

Review Request

Criginator Priority Receiver Application # Resson Status Date
m uanick) [noRmaL [BFozo o000 24188 [REVIEW APPLICATION [wiamis FOR RES [12015/2004 121252 P |~
\ [ [ [ \ [ [
\ [ [ [ \ [ [
\ [ [ [ \ [ [
[ [ [ [ [ [ [
Originator Comment Receiver Comment

FLEASE WERITY THE ACTUAL LENGTH OF TIME AT CURRENT PLACE OF EMPLOYMENT,
THANMKS

3 In the Query block, choose Receiver.

In the Review Request block, Oracle Daybreak displays all open messages you have
received. The Review Requests block contains these fields:

In this field: Do this:

Originator View the user id of the request originator (display only).

Priority View the request priority: HIGH, NORMAL, or LOW (dis-
play only).

Receiver Select the request receiver (required).

Application # (Underwriting and Funding forms only) Select the appli-
cation number which needs review (required).

Account # (Customer Service form only) Select the account number
which needs review (required).

Reason Select the review reason (required).

Status View the request status (display only).

Date View the request creation date (display only).
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Originator Comment Enter the originator comment (optional).
Receiver Comment Enter the receiver comment (optional).

Note: If you double-click an entry in the Review Request block, Oracle Daybreak does the

following:

On this form: Oracle Daybreak:

Underwriting Loads the application and displays the Primary Applicant
page.

Funding Loads the application and displays the Primary Applicant
page.

Customer Service Loads the account and displays the Account Details page.
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Sending a message

10

The Send Request button allows you to send a message to another Oracle Daybreak user.
However, you must save your message before this button is available.

To send a review request

Using the Underwriting, Funding, or Customer Service form, load the account to which
the message applies.

Choose the Search (1) master tab, then choose the Review Request tab.

In the Query block, choose Originator. (If necessary, press F6 to create a new record.)
The account number for the loaded account appears in the Account # field.

In the Priority field, select High, Normal, or Low from the LOV.

Note: This Priority field helps guide the recipient in responding to requests. It does not
affect the order in which messages are sent or received.

In the Receiver field, use the LOV to select the person you want to receive the message.

The Account # field displays the number of the account in the form’s master block. If no
account is currently loaded, you can use the LOV to complete the field. You can also use
this field to reference an account other than the one currently loaded on the form.

In the Reason field, use the LOV to select the purpose for the review request.

In the Originator Comment field, type any additional message you want to send.
Choose Save.

In the Action block, choose Send Request.

In the Review Request block, the Status field changes to WAITING FOR RESPONSE and
Oracle Daybreak sends the message.
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Responding to a message

When you receive a message, Oracle Daybreak will notify you by completing the Pending
Request parenthesis in the form’s title bar with the number of unseen messages. In the fol-
lowing example, two messages are waiting on the Review Request page.

?_5 (FundinghiPending Requast: 1% ©

Application
Aop #‘ D1|1 201 52004 Juiml’ Cusr Purposel Priorrty‘ S‘tatusl Company
Prociuct Existing Customarl— Dup’— Contact | Channel ‘ Producer| | Sales Agent
Search (1] Applicarts' (2] Decision (31 Contract (51 Collateral (5 Comments (7] Image (8] Werification (90 Tools (10)
Rezulttz earch Review Requests l
Query Action Email
C Ctiginstor . Receiver r Bith Wigw Al Send Reguest Send Response Cloge Cigfingtor Receiver
Review Req
Cnator Priority Receiver Application # Reason Statuz Diate:
B [Lnnck [oRmaL BFoco o000t 24192 |REVIEVY APPLICATION [WAITING FOR RES [124 502004 1212:52PM | &
\ | | | | \ \
\ | | | | \ \
[ | | | | [ [
\ | | | | \ \
Originatar Comment Receiver Comment
PLEASE WVERITY THE ACTUAL LEMNGTH OF TIME AT CURRENT PLACE OF EMPLOYMENT,
THANKS
To respond to a review request
1 On the Lending menu, choose Customer Service if you are working with accounts.
2 Choose the Search (1) master tab, then choose the Review Requests tab.
3 Inthe Query block, select Receiver.
Oracle Daybreak displays the unread messages in the Review Request block.
4 In the Review Request block, double-click the request you want to view.
Oracle Daybreak loads that request’s account on the current form.
5 Perform the request from message on the account.
6 Type your response in the Receiver Comment field.
7 In the Action block, choose Send Response.

Oracle Daybreak sends your response to the originator’s workstation, where it appears on
the Review Request page with the status RETURN TO ORIGINATOR

The recipient can view the sent response by choosing Receiver and View All in the Query
block. (The message has a status of RETURN TO ORIGINATOR.)

Back on the originator’s Review Request page, the message appears when Originator is
selected in the Query block. The message has a status of RETURN TO ORIGINATOR.

Note: Choose Close in the Action block to remove the message from the Review Request
block.
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E-mailing a review request

A WD

While Oracle Daybreak updates the Pending Request number on the title bar to alert you
of new messages, you can also e-mail a review request to either the originator or a
receiver. Oracle Daybreak will use the e-mail address recorded in the User Definition
block on the Administration form’s User page.

Note: E-mail addresses must be recorded for both the originator and receiver for this fea-
ture to work.

To e-mail a review request

On the Lending menu, choose Customer Service if you are working with accounts.
Choose the Search (1) master tab, then choose the Review Requests tab.

Select the message you want to e-mail in the Review Request block.

In the Email block, choose Originator to send the message to the person listed in the Orig-
inator field.

_Or_

Choose Receiver to send it to the person listed in the Receiver field.

Oracle Daybreak displays one of the following dialog boxes:

Choose Ok.
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Closing a message

You can close a message you created at anytime, regardless of status. However, you can
only close messages that have your user id in the Originator field. When you close a mes-
sage, Oracle Daybreak removes if from the Review Request block.

To close a message
1 In the Review Request block, select the message you want to close.

2 In the Action block, choose Close.

Oracle Daybreak assigns the message the status of CLOSED and removes it from your

Review Request block.
Apphication
App #| D1|1 0/20/2004 Juiml— Cusl— Purpose | Priority | Status | Company
Product Existing Customer Dupl— Cantact Channe|| Prnducar| ‘ Sales Agert

Search (1) Applicants (2) Decision (3) Buresu (4) Collateral (6) Comments (7) Image (5) Yerification (9) Tools (10)

Resultts Search Review Reguests I

Query Action Email

i Originstor r Receivet C Bioth Wiswy Alllv? ol Reguest Send Response Cloze Oiginatar Receiver

Review Request

Crriginator Priority Receiver Application # e Statuis Diate
B [BFOGO [MORMAL BHATCHER oooore423s |REVIEWY APPLICATION ﬁCLOSED [oneoos oragiee 2
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
| \ | | | \ |
Origingtor Comment Receiver Comment
PLEASE WERIF'Y THE APFLICANT'S FLACE CF EMPLOYMENT AND MONTHLY WAGE INFORMATICN RECORDED OM PRIMARY ARPLICANT'S EMPLCYMENT PAGE

Note: You can review closed accounts anytime by selecting View All in the Query block.
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CHAPTER 4 : IMAGE MAINTENANCE / DOCUMENT TRACKING

The Documents menu opens the Image Maintenance form and the Account Document
Tracking form. Both allow for the paperless storage of documents within Oracle Day-
break, with accounts during customer service.

Account Document Tracking form

The Account Document Tracking form contains two pages: the Document Tracking page
and the Document Maintenance page. The Document Maintenance page allows you to
attach documents to an account in the form of GIF files, PDF files, DOC files, XLS files,
and TXT files. The Document Tracking page allows you to view these documents. Any
documents that were attached to the account when it was still an application, (such as the
application received as a fax and saved as a GIF file), also appear on the Document Track-

ing page.

This chapter explains how use the Image Maintenance form to:

* View an image

* Search for an image

»  Split an image of more than one page

» Change the status of an image

* Combine two images into a multiple page image

e Attach an image to an existing application

e Print an image

»  Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking form to attach documents to
accounts and then view these documents in a browser.
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Document Tracking page (Account Document Tracking form)

You can view the documents attached to a particular account by loading the account on the
Customer Service form, then opening the Account Document Tracking form. You can also
open the Account Document Tracking form and select from a list of all accounts with doc-
uments attached on the Document Tracking page.

To locate an account document (method one)

1  On the Documents menu, choose Account > Tracking.

The Account Document Tracking form’s Document Tracking page appears.

"% Account Document Tracking -
Document Tracking l Document intenance
Account
Acc# Account Status Title e All
2001020001 0763 ACTIVE (COTOMEASTER MARIE § COTONEASTER HARNK - v
Account Document
Documert Type Comment
B [4PPLICATION IMAGE | B
[contRacT [
| | &
Account Document Details
Document Sub Type “ersion Page # Documert File Type Comment
B [MAGE PAGE [ [1 |GIF FLE | <]
Wignw DocLment

2 Press F7 to move to Enter-Query mode, in the Acc # field type the account number you
want to view, and then press F8 to perform the query.
-or-
Select View All and use the scroll box to choose the account with the documents you want
to view.

Information about the documents attached to the account appears in the Account Docu-
ment and Account Document Details blocks.

To locate an account document (method two)

1 Open the Customer Service form and load the account with the attached document you
want to view.

2 On the Documents menu, choose Account > Document Tracking.

The Account Document Tracking form appears with the account loaded in Account block
and information about the document in the Account Document and Account Document
Details blocks.

Chapter 4 :-2 User Guide - Consumer Lease Collection



To view a document attached to an account

Using one of the two methods above, load the account with the document you want to
view.

In the Account block, view the following information:

In this field: View this:

Acct# Account number.
Account Status Account status.
Title Account title.

In the Account Document block, view the following information:

In this field: Do this:
Document Type View the document type (display only).
Comment Enter comment (optional).

In the Account Document Details block, view the following information:

In this field: Do this:

Document Sub Type View the document sub type (display only).

Version View the version (version numbers will be incremental
by batch job, first version will start with 1.0) (display
only).

Page # View the page number (display only).

Document File Type View the document file type (display only).

Comment Enter comment (optional).

Use the Account Document and Account Document Details block to select the docu-
ment you want to view.

In multiple paged documents, choose 1 in the Page # field on the Account Document
Details block to view the all the pages in the document

_Or_

Choose a specific page number to view only that page.

Choose View Document.

Oracle Daybreak opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work in
conjunction with your Oracle Daybreak system).

If you want, add comments to the Comments field in the Account Document and
Account Document Details blocks.

Save your entry.
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Document Maintenance page (Account Document Tracking form)

Oracle Daybreak supports the online attachment of document images to an account with
the Account Document Tracking form’s Document Maintenance page. You can attach the
documents from either a client machine or server. A default image directory can be main-
tained in Oracle Daybreak using the system parameter: UIX_DEFAULT IMAGE_PATH.

When you choose List File in the New Document block on the Document Maintenance
page, Oracle Daybreak displays all available files in the selected directory in the Docu-
ment Details block. You can use the Document Maintenance and Action blocks to attach
selected documents to a particular account.

To attach a document to an account from a server
1  On the Documents menu, choose Account > Maintenance.

The Account Document Tracking form’s Document Maintenance page appears.

Document Tracking Documert Maintenance l

Select Document Document Maintenance Action
"
Directary Peth - tare o
‘MQme.idevneWJimagas AccH gy BT
Search " Move Document ‘iewr Document
Reset Path List Filz: Upload From Client ™ Aftach Document (Server)
@ Attach Document (Clisrt)
Upload Status
Total Fiie(s) [1 Last Flle [payton miller contract gif Biytes Uplogded 317627 of 317627 uploaded. File Uploadd Status 100 % Overall Upload Status 100 %

Document Details
File: Mame Document Type Document Sub Type Comments Acc# Attach  Copy SMove Acc # Status

B [PAYTON MILLER CONTRACT_2' hionE

|®

I s S S |

1]

2 In the Action block, choose Attach Document (Server).

3 In the Select Document block, use the default image directory in the Directory Path
field. (The default path is the value for the system parameter
UIX DEFAULT IMAGE_PATH).
_Or_
In the Directory Path field, enter the full path name to the document on the server that you
want to attach to an account.

Note: You can choose Reset Path at any time to return to the default image directory.
4 In the Select Document block, choose List File.

Oracle Daybreak displays the files from the entry in the Select Document block’s Direc-
tory Path in the Document Details block.

5 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).
Document Type Enter the document type (required).
Document Sub Type Enter the document sub type (required).
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Comments Enter any comment you want to associate with the docu-
ment attached to the account (optional).

Acc# Enter the account number of the account to which you
want to attach the document (optional).

Note: If a document is attached to an account, and the account is loaded on the Customer
Service form, when you open the Account Document Tracking form’s Document Mainte-
nance page, the account number appears in the Document Maintenance block’s Acc# field.
You can view the document in a browser by choosing View Document in the Action
block.

Select the Attach indicator to attach the file to the account.
Save your entry.
In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed
using the Account Document Tracking form’s Document Tracking page.

To attach a document to an account from a client machine
On the Documents menu, choose Account > Maintenance.

In the Action block, choose Attach Document (Client).

In the Select Document block, choose Upload From Client.

An Open dialog box appears.

In the Open dialog box, use the Look in: list box to locate the document you want to
attach to the account.

Note: You can select multiple files by holding the CTRL or SHIFT key on your keyboard.

When you have located the document you want to attach to the account in the Open dialog
box’s File name: field, choose Open.

Oracle Daybreak uploads the selected file to the Document Maintenance page and dis-
plays the progress in the Upload Status block.

In this field: View this:

Total File(s) The total files uploaded from client.
Last File The last uploaded file name.

Bytes Uploaded The file upload status in bytes.

File Upload Status (%) The file upload status in percentage.
Overall Upload Status (%) The overall upload status in percentage.

In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).

Document Type Enter the document type (required).

Document Sub Type Enter the document sub type (required).

Comments Enter any comment you want to associate with the docu-

ment attached to the account (optional).
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Acctt Enter the account number of the account to which you
want to attach the document (optional).

8 Select the Attach indicator to attach the file to the account.
9 Save your entry.
10 In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed
using the Account Document Tracking form’s Document Tracking page.

You can also view the document in a browser by choosing View Document in the Action
block.

Copy Document

The Action block’s Copy Document command copies the document image from one
account to another account. This command has no impact on the source account or the
source account’s document image.

To copy a document to an account from another account
1  On the Documents menu, choose Account > Maintenance.
2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the
image you want to copy.

4 In the Document Maintenance block, choose Search.
Oracle Daybreak displays the files attached to that account in the Document Details block.
5 In the Document Details block, select the document you want to copy.

6 Inthe Copy/Move Acc # field, enter the account number of the account to which you want
to copy the document.

7 Save your entry.

8 In the Action block, choose Post.

Move Document

The Action block’s Move Document command moves an existing document image from
one account to another account. This command detaches the document image from the
source account and attach to second account.

To move a document to an account from another account
1 On the Documents menu, choose Account > Maintenance.
2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the
image you want to move.
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In the Document Maintenance block, choose Search.
Oracle Daybreak displays the files attached to that account in the Document Details block.
In the Document Details block, select the document you want to move.

In the Copy/Move Acc # field, enter the account number of the account to which you want
to move the document.

Save your entry.

In the Action block, choose Post.
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|
CHAPTER 5 : CORRESPONDENCE

Oracle Daybreak features two types of correspondence: predefined correspondence tem-
plates for leases included in the baseline system and ad-hoc correspondence that you cre-
ate yourself. The predefined correspondence address matters regarding customer service
and collections for accounts. They also enable financial organizations to manage bulk

mailings.

Collection: COLLECTION LETTER 1
COLLECTION LETTER 2
COLLECTION LETTER 3
CUSTOM LETTER 1
CUSTOM LETTER 2

Ad-hoc correspondence allows you to include information from accounts in documents
templates you create yourself without manually transferring the data. Ad-hoc documents
can be generated as either Microsoft Word or PDF files.

Note: Predefined correspondence templates are stored on the Product Setup form’s Letters
tab’s pages (Setup > Products > Lease > Letters > Letters).

Setup Loan | Lineof Credt  Lease
Products: Pricing Ediitz Cycles Scoring Contract Fees Compenzation  Checklists Spreads Statement Letters Promotions  [Gsurances
Letters l
Letter Definition
Letter Code File Maime Batch Printer Biatch User Letter Type Cotmpany  Branch Product State  Channel Enabled

[CNLNCE_ACOLTR  |LORACO_EM_111_01  [archive [paTcH [COMDITIONAL ADVERSE AC AL |ALL AL laLL [acl [V 4]
[CNLNCE_ADY LTR  |LORADY_EM_100_01 [archive [paTcH |ADVERSE ACTIONLETTER |aLL  |aLL  [ALL [aLL facC 7]
[CHLMCE_COL_LTRY  [LCOLTT EM_100_01 [archive [paTcH [COLLECTION LETTER 1 |LL (AL |ALL [aLL [aLL [
[ChLMCE_COL LTR2  |LCOLTZ EM_100_01  [archive [patcH (COLLECTIONLETTER2  |ALL  [sLL  [aLL far facc ¥
[CNLNCE_COL LTRZ  [LCOLT3 EM 10001  [archive [patcH [COLLECTIONLETTER @ |alL  |alL  [aLL [all [alC 7]
[CNLNCE_CONLTR  [LORCON_EM_100 01 [archive [paTcH [COMTRACT FUNDING FAXENALL  |ALL  [ALL [aLL JalC v
[CNLNCE_DEC_F&%  |LORDEC_EM_111_01 [archive [paTcH [DECISION FaX/EMAIL lal [ [ [aLL facC 7]

B |CRLNCE_FOF_LTR |LcsPOF EM_111_ 01 [archive [paTcH [PAID N FULL LETTER lan e fan [aLL [aLL v
[ChLMCE PORLTR  |LCSPOGEM_111_01  [archive [paTcH PAYCFF QUOTELETTER AL [sLL  [ALL fare [acc ¥
[CNLNCE_STM_LTR  |LCSSTM_EM_A11_01  [archive [paTcH [ACCOUNT STATEMENT  |alL  |alL  [aLL [aLL facC 7]
[CHLMCE_WEL TR LCSWEL_EM_111_01  [archive [paTcH [WELCOME LETTER lan e fan [aLL [aLL [

\ | | | \ \ \ \ [ r
\ | | | \ \ \ \ [ O )
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Request page

Ad-hoc correspondence can be viewed on the Request page when you have opened an
account. The page allows you to generate a new letter or view a previously generated let-
ter.

To generate an ad hoc correspondence

1  On the Lending menu, choose Funding, Underwriting, or Customer Service and load
the account for which you want to generate the ad hoc correspondence.

2 On the Letters menu, choose Ad-hoc.

Tz Request
Request {
Correspondence Request
Level Mumber Title Compary Branch
APFLICATION 00001 01135-CICERD KEN ssFe |He
Correspondence
Id Correspondence Date
30003 [NOTE AND SECURITY AGREEMENT 1 4272005 |+ Generate
Documents
Documert I Documert Recipient E-Faorm Source Source Type  Generated Select
[ 28004 |LN_BSI_CONTRACTS_1_DOC PRIMARY [ [ r [ (&
u| 29005 [MOTE AND SECURITY AGREEMERIT 1 [PRIMARY [DavERERK [WioRD DOCUMENT 2 " Wiews
\ \ \ \ \ m mE
Elements
@ a1 O User Defined
Elemert Content
B [4PPLICATION AFF NER [o0o0101135 =
|aPPLICATION STATE cD s
[2PPLICATION ASSET DESC [
|APPLICATION ASSET IDENTIFICATION HER |
|#PPLICATION A5SET VERR [2004
[spPLICATION ASSET MaKE [sanTos
[£PPLICATION ASSET MODEL [PraRE 2 BR
|PRIMARY APPLICANT ADDRESS LINE 1 [3298 casper RD
|PRIMARY APPLICANT ADDRESS LINE 3 [NSTON SALEM NC 27103 US
[PRIMARY APPLICANT NAME [kEn Lo cicero -

3 Inthe Correspondence Request block, the following information appears regarding the
account currently loaded:

In this field: View this:

Level The correspondence type.
Number/Title The entity number and title.
Company The entity company.
Branch The entity branch.

4 In the Correspondence block, use the Correspondence field’s LOV to select the type of
correspondence you want to generate.

Oracle Daybreak displays the following information in the Correspondence block for the
selected type of correspondence:

In this field: View this:

Id View the correspondence id (display only).

Correspondence Select the correspondence you want to generated
(required).

Date View the correspondence generation date (display only).
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10

11

Press F10 to save your entry.

The Documents block displays all the types of documents available for the type of corre-
spondence you selected.

In the Documents block, view the following information for each document:

In this field: View this:

Document Id The document Id.

Document The document description.

Recipient The recipient description.

E-Form Source The e-form source.

Source Type The source type.

Generated If selected then Oracle Daybreak generated the docu-
ment.

In the Documents block, select the correspondence you want to view.

The Elements block displays the elements Oracle Daybreak used to generate the corre-
spondence.

If you choose All, Oracle Daybreak displays all elements in the correspondence.
If you choose User Defined, Oracle Daybreak displays user-defined elements in the corre-

spondence.

In the Elements block, view the following information:

In this field: Do this:
Element View the element description.
Content Enter/view the value of the element.

Choose User Defined and complete the Content fields for the Element fields you want to
include in the correspondence.

Choose Generate.

Oracle Daybreak “locks” the information included in the correspondence and prevents it
from being changed.

Choose View.

Oracle Daybreak displays a PDF of the ad hoc correspondence.
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Samples of Oracle Daybreak LS predefined correspondence

Collections: Collection letter 1

The predefined Collection letter 1 is automatically sent a configurable number of days
after an account becomes delinquent (receives a condition of ACTIVE: DELQ on the Cus-
tomer Service form).

To generate the Collection letter 1

1 On the Customer Service form, load the account you want to receive the Collection 1 let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Collections sub menu, choose Collections 1.

Example of the Collections letter 1

DAYBREAK CORPORATION
10100 VIKING DRIVE, #102
EDEN PRAIRIE MN 55344 7255
Phone: 952-416-6506

Fax: 952-416-6507

Date: 09/25/2002

PAULA CCERASTOSTIGMA
45231 MOESIA ROAD
BOLIVIA NC 268422

Account number: 2000110000454
Amount past due: $8,136 .48

Dear PAULA,

Our records indicate that you are past due on your loan in the amount of $8,136 48. This amount includes
monthly payments together with all applicable fees due pursuant to your confract. In order to attain a current
acount status, itis important that we receive your payment immediately if there is a problem meeting the above
request, please contact our office at 952-416-6506

If you already mailed your payment, please contact our office so we may update your account

Sincerely,
DAYBREAK CORPORATION
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Collections: Collection letter 2

The predefined Collection letter 2 is automatically sent after a configurable number of
days for a delinquent account (one with a condition of ACTIVE: DELQ on the Customer
Service form).

To generate the Collection letter 2

1  On the Customer Service form, load the account you want to receive the Collection 2 let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4  On the Collections sub menu choose Collection 2.

Example of the Collection letter 2

DAYBREAK CORPORATION
10100 VIKING DRIVE, #102
EDEN PRAIRIE MN 55344 7255
Phone: 952-416-6506

Fax: 952-416-6507

Date: 09/25/2002

PAULA CCERASTOSTIGMA
45231 MOESIA ROAD
BOLIVIA NC 28422

Account number: 2000110000454
Amount past due: $8,136 48
Dear PAULA,

Qur records indicate that you are past due on your loan in the amount of $8,136.48. This amount includes
monthly payments together with all applicable fees due pursuant to your confract.

Several attempts have been made to contact you conceming this matter. In an effort to assist you in attaining a
current status on your account, we would like to speak with you immediately. Please contact our office at
652-416-6506 to make suitable arrangements to bring your account current.

Thank you in advance for your anticipated cooperation.

Sincerely,
DAYBREAK CORPORATION
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Collections: Collection letter 3

The predefined Collection letter 3 is automatically sent after a configurable number of
days for a delinquent account (one with a condition of ACTIVE: DELQ on the Customer
Service form).

To generate the Collections letter 3
1  On the Customer Service form, load the account you want to receive this letter.
2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Collections sub menu, choose Collection 3.

Example of the Collections letter 3

DAYBREAK CORPORATION
10100 VIKING DRIVE, #102
EDEN PRAIRIE MN 55344 7255
Phone: 952-416-65086

Fax: 952-416-6507

Date: 08/30/2002

STEYEN JJONES
&<Cus addressi>
ROCK ISLAND IL 60750

Account number: 2000120000350
Amount past due: $2,741.16

Dear STEVEN,

This is to inform you that your account with DAYBREAK CORPORATION i currently in Default. We hereby

demand that payment for $2,741.16 be brought current immediately. This amount includes monthly
payments together with all applicable fees due pursuant fo your confract.

IT you are unable to send such a payment, it 1s imperative that you contact our office at 952-416-6506 fo
discuss this matter. Your immediate response to this demand is necessary if you wish to avoid further
consequences.

Thank you in advance far your anticipated cooperation.

Sincerely,
DAYBREAK CORPORATION
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CHAPTER 6 : USER PRODUCTIVITY

The User Productivity form is a supervisor feature that allows you to monitor the daily
performances of Oracle Daybreak users completing lease origination and lease servicing
tasks. These tasks are categorized as customer service/collection tasks (lease servicing).

Note: Oracle Daybreak updates this display only form every day.

Using the User Productivity form, you can review the following daily tallies:

*  Number of accounts worked and call activities, by user
*  Number of accounts worked and call activities, by queue.

This chapter explains how to use the User Productivity form to view this information.
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Viewing the Customer Service/Collection tasks

Daily tallies from the Customer Service module appear on the following pages:

*  Collector Activity
*  Queues Status

Collector Activity page

The Collector Activity page displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.

To view the Collector Activity page
1 On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Collector Activity tab.

w8 Lser Productiity

UndersritingFunding Customer Service/Callection

Collector Activity l Queues Status

Users

User Mame Acocounts Call Activities
B BFOGO BRIAN A FOGO 31 a1 =y
SHATARAJAN S AKUMAR NATARAJAN 22 22
JUAMICK] JILL R JAMICK] 28 28
CRUDC: DANRUDD 24 24
DROEHL DALE ROEHL 24 28
-
Activity Details
Queue Name Lett Messages Promise To Pay Mo Anseeer Ciher Total
u ‘DELINQUENT DELINQUENCY QUEUE: DAYS MORE THAN 30 1 [t} 24 25 =
ISCHEDULE FOR CHARGEQFF
[

1]

3 In the User block, view the following information:

In this field: View this:

User User code.

Name User name.

Accounts Number of accounts worked.
Call Activities Number of call activities.

4  In the Activity Details block, view the following information for the selected user:

In this field: View this:

Queue Name Queue name.

Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.

Total Total activity count.
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Queues Status page

The Queues Status page displays daily information regarding queues, such as the number
of accounts worked, number of call activities, number of accounts pending, and totals
number of accounts in the queue. It also displays information about the users who worked
these queues and details of the call activities.

To view the Queues Status page

1  On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Queues Status tab.

' User Productivi

UnderwertingFunding Customer Service/Collection

Callector Activity Queues Status l

Queues

Company Branch GUeLE Mame Accounts Activities Pending Total
[ssFc |ha [BankrUPTCY | 143 143 of 143 (|2
m s |He |pEFicENCY [ 31 31 of 31
|ssFc jom |DELINGQUENT | 52| 52| of 52
[ssFc jom  [SCHEDULE FOR CHARGEOFF [ 7| 7| o 71
[ssFc Jeot[PAYOFFTERMINATION M PROGRESS [ 91 | ot | ol a1
Activity Details
User Mame Lett Messages Protnise To Pay Mo Answeer Other Total
B BFOGO |ERIAN & FOGO | 3 1 o 5| =
[asaricia [JLL R samick [ 11| o 8 | 7| 27
|pRUDD |DamRUDD [ & | ol 7 10 | 22
[oRoEHL [caLE RoEHL [ 19 | Bl 1 5 | 28
|ssiwapnL |SwapHIL SALUNKE | s | g & | 2 | 24
[krUDD [kRiSTINA R RUDD [ 3| 2 1| 17 33
[ [ [ [ [

3 In the Queues block, view the following information:

In this field: View this:
Company Company.
Branch Branch.
Queue Name Queue name.
Accounts Number of accounts worked.
Activities Number of call activities.
Pending Number of accounts pending.
Total Number of total accounts.

4 In the Activity Details block, view the following information for the selected queue:
In this field: View this:
User User code.
Name User name.
Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.
Total Total activity count.
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APPENDIX A : ORACLE DAYBREAK INTERFACE

This appendix explains the Oracle Daybreak’s graphical user interface (GUI). It defines
the components commonly found on a GUI, provides an overview of their functions, and
explains how to:

e Use Oracle Daybreak’s windows and forms
e Work with the parent-child relationships between blocks
* Navigate within the Oracle Daybreak system.

Oracle Daybreak’s graphical user interface
All the forms in Oracle Daybreak appear as graphical user interfaces (GUIs). To use Ora-

cle Daybreak, you need to understand the components found on a GUI, as well as their
functions.

Windows and forms

Oracle Daybreak uses two basic GUIs in completing tasks: windows and forms.

mjDaybreak

File Edit Guen

g
W 1

Search o o Auto Run Accounts

Product Parvyaft Amt Amt Due Oldest Due O ny /Branch
Coe| m R - N/ -
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Or 55N Total| ‘ a form)
S —
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Oracle Daybreak Lending Suite uses two windows, the iAS window and the Oracle Day-
break window. The Oracle Daybreak window is the java applet that is running Oracle
Daybreak. The iAS window is the browser that launched the applet. In this sense, the iAS
window is the parent of the Oracle Daybreak window.
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Windows can be maximized, minimized, opened, closed, and repositioned. More than one
window can be opened on your desktop; windows can overlap or appear adjacent to each
other. The window that you are currently using, or is currently selected, is the “active”
window. It appears on the top of the overlapping windows. Windows that are open but not
selected are “inactive.” The title bar of an active window is a different color than the other
inactive windows.
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For more information on window components, see the Window components section of
this chapter.

Oracle Daybreak uses forms to complete tasks. A form is an organized display of a mod-
ule’s fields, contained within a window. Forms allow you to enter, view, and update infor-
mation in the Oracle Daybreak system. Each module has its own form. Forms are opened
from the Oracle Daybreak menu. For example, on the Lending menu, the Underwriting
command opens the Underwriting form, the Funding command opens the Funding form,
and the Customer Service command opens the Customer Service form. You can open mul-
tiple forms simultaneously. The forms that are available to you are based on your assigned
responsibility.

Windows and forms have a very similar appearance, as forms always appear within win-
dows. An easy way to distinguish a window from a form is that a window contains the
Minimize, Maximize, and Close buttons in the upper right corner, while a form does not.

For more information on form components, see the Form components section of this
chapter.
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Window components

This section presents an overview of the components found on windows, as well as their

use.

Window title bar

A horizontal bar containing the name of the window. The active
window has a different colored title bar to distinguish it from
other inactive windows.

The title bar also contains the Minimize, Maximize, and Close
buttons.

The Minimize button reduces the Oracle Daybreak LS applica-
tion to a taskbar button on your desktop’s status bar.

The Maximize button allows you to resize Oracle Daybreak’s
window on your desktop. (Note: You may have to choose the
Maximize button to ensure Oracle Daybreak’s window is not cov-
ered by your desktop’s status bar.)

. E;g Daybreak !Em J

Menu bar

The Close button will quit Oracle Daybreak without logging off.
(Note: Do not use the Close button to end a Oracle Daybreak ses-
sion.)

The horizontal bar containing the menu names. The menu bar is
located beneath the title bar and contains commands that allow
you to open, view, and maintain a form.

Note: You view the contents of a menu by clicking it or pressing
ALT + [THE UNDERLINED LETTER IN THE MENU NAME].
For example, ALT + R opens the Reports menu. Commands can
be selected using the mouse or by pressing the key of the under-
lined letter in the command name.

File Edit Query MNavigation Lending Letters Reports Interfaces Batch Transactions Monitor Setup Window Help

The following menus are available from the Oracle Daybreak menu bar.

File Contains the following commands:
Save - Records the current data on a form in the
database.
Re-Logon - Closes the current Oracle Daybreak
session and refreshes the Login form, allowing
you to re-log on to Oracle Daybreak without
leaving the system.
Change Responsibility - Allows you to change
your Oracle Daybreak responsibility. Responsi-
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Edit

Query

Navigation

Lending
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bilities determine what Oracle Daybreak features
are available.

Change Password - Allows you to change your
Oracle Daybreak password.

Clear Form - Clears the active form of its
unsaved data.

Print - Prints the contents of an active form.
Exit - Closes the Login form and ends your cur-
rent Oracle Daybreak session.

Contains the following commands:

Cut - Removes selected text from a form and
stores it in the clipboard buffer.

Copy - Copies selected text from a form and
stores it in the clipboard buffer.

Paste - Moves data from the clipboard buffer to
a selected field on a form.

Edit Field - Opens the Editor dialog box with the
contents of a selected field.

List of Values - Opens a field’s List of Values
dialog box, if one exists.

Contains the following commands:

Enter - Changes Oracle Daybreak to Enter-
Query mode. This allows you to search the data-
base.

Execute - Performs the query entered during
Enter-Query mode.

Cancel - Changes Oracle Daybreak back to user
mode.

Last Criteria - Repeats the most recently per-
formed query entered in Enter-Query mode.
Count Hits - Displays the number of records the
current query produced in the message line.

Get Next Set - Retrieves the next set of records
using the most recent query entered while in
Enter-Query mode.

Contains the following commands:

Block - Allows you to navigate to the previous
or next block, or clear the current block.

Record - Allows you to navigate between the
previous and next record, scroll up and down
between records, insert or remove a record, or
duplicate or clear a record.

Field - Allows you to navigate between the pre-
vious and next field, as well as clear or duplicate
a field.

Contains the following commands:

Sales Lead - Allows you to open the Sales Lead
form at the Lead Entry, Follow-up, or Mainte-
nance master tabs.



Letters

Documents

Reports

Application Retrieval - Opens the Application
Retrieval form.

Customer Service - Opens the Customer Ser-
vice form.

Collection - Opens the Customer Service form
designed for a Oracle Daybreak user focussing
on collections, as the Bankruptcy (4), Repo/Fore-
closure (5), and Deficiency (6) master tabs are
unavailable.

Repossession/Foreclosure - Opens the Cus-
tomer Service form designed for a Oracle Day-
break user focussing on repossessions or
foreclosures, as the Bankruptcy (4), and Defi-
ciency (6) master tabs are unavailable.
Bankruptcy - Opens the Customer Service form
designed for a Oracle Daybreak user focussing
on bankruptcies, as the Repo/Foreclosure (5) and
Deficiency (6) master tabs are unavailable.
Deficiency - Opens the Customer Service form
designed for a Oracle Daybreak user focussing
on deficiencies, as the Bankruptcy (4) and Repo/
Foreclosure (5) master tabs are unavailable.
Collateral - Opens the Collateral form (currently
unavailable).

Producers - Opens the Producer Management
form.

Vendors - Allows you to open the Vendor Man-
agement form at the Vendors, Work Orders, or
Invoices tab.

Securitization - Opens the Securitization form at
the Loan tab.

Tools - Opens the Calculator Tools form at the
Loan Calculator or Lease Calculator tab.
Transaction Authorization - Opens the Trans-
action Authorization form at the Authorization
tab.

Custom Forms - [This is a placeholder for any
forms customized (or added) by the client.]

Contains the following commands:
Pre-defined - Allows you to generate a pre-
defined letter, either as a file or a printed docu-
ment, or preview it as a PDF file.

Ad-hoc - Opens the Correspondence form.

Contains the following commands:
Account - Allows you to open the Account Doc-

ument Tracking form at either the Document
Tracking or Document Maintenance master tab.

Contains the following commands:
Run - Allows you to generate a wide array or
predefined reports. (Note: For a complete list of
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Interfaces

Batch

Transactions

Monitor

Setup
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reports available in Oracle Daybreak, please
refer to the Oracle Daybreak Lending Suite
Reports Catalog.)

Print - Modifies the Run command to generate a
predefined report, either as a file or a printed
document.

Preview - Modifies the Run command to gener-
ate a predefined report and view it as a PDF file
with a browser.

Contains the following commands:

GL Transactions - Opens the General Ledger
form.

AP Transactions - Opens the AP Transactions
form.

Card Transactions - Opens the Card Transac-
tions form.

Conversions - Opens the Conversion App/Acc
form.

Contains the following commands:

Advances - Allows you to open the Consumer
Lending (Advance and Payment) form at either
the Advance Entry or Advance Maintenance tab.
Payments - Allows you to open the Consumer
Lending (Advance and Payment) form at either
the Payment Entry or Payment Maintenance tab.
Escrow - Allows you to open the Escrow Analy-
sis and Disbursements form at the Escrow Anal-
ysis, Escrow Analysis Maintenance, Escrow
Disbursement Entry, or Escrow Disbursement
Maintenance master tabs.

Contains the following commands:

System - Allows you to open the Utilities form
at the Setup, Monitor Batch Jobs, Monitor Jobs,
Monitor Users, Services, Log Files, or Parked
Transactions master tab.

User - Allows you to open the Utilities form at
the Monitor Users master tab or open the User
Productivity form at the Underwriting/Funding
or Customer Service/Collection master tab.

Contains the following commands:
Administration - Allows you to open the
Administration form at the System or User mas-
ter tab.

Products - Allows you to open the Product
Setup form at the Setup or Lease master tab.
Queues - Allows you to open the Queue Setup
form at the Setup, Origination, or Customer Ser-
vice master tab.



Window

Help

Correspondence - Opens the Correspondence
form.

Events - Allows you to open the Events form at
the Lease master tab.

Credit Bureau - Allows you to open the Credit
Bureau Setup form at the Request or Reporting
master tab.

Batch Jobs - Opens the Utilities form.
Producers - Opens the Producer Management
form.

Vendors - Opens the Vendor Management form.
Subvention - Opens the Subvention form at the
Loan or Lease master tab.

Escrow - Opens the Escrow Setup form at the
Loan master tab.

Securitization - Opens the Securitization form.
General Ledger - Opens the General Ledger
form.

Contains the following commands:

Cascade - Arranges the open forms on your
screen so that they overlap, with the active form
on top.

Tile Horizontally - Arranges the open forms on
your screen so that they appear one on top of
another.

Tile Vertically - Arranges the open forms on
your screen so that they appear one next to
another.

Note: The lower portion of the menu displays the
Oracle Daybreak forms you have opened. You
can use this menu to move between forms by
selecting a specific form.

Contains the following commands:

Keys - Opens the Keys dialog box, containing a
listing of all the hot keys available for the current
form in use. Hot keys are shortcuts that perform
Oracle Daybreak tasks with a minimum of key-
strokes.

Display Error - Displays information about
recently encountered Oracle errors. (i-flex solu-
tions Corp. requests that you create a screen shot
of this information and send it to us when you
have a system error.)

Debug - Contains two commands: Set On and
Set Off.

Oracle Daybreak Help - Allows you to open a
browser and view .pdfs of either the User Guide
or Setup Guide.

Oracle Daybreak On the Web - Allows you to
open the i-flex solutions home page and report to
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Technical Support department when you encoun-

ter an error.

About Oracle Daybreak and Audit - Opens the
About Oracle Daybreak dialog box, displaying

version and audit information such as object data
and recent updates. It also allows you access the

column audit.

Oracle Daybreak toolbarThe row beneath the menu bar containing 19 icon buttons used
to perform tasks and carry out commands. The toolbar buttons are
labeled with the action they perform. To view the label, use the
mouse to place the mouse pointer on the button without clicking
and the label appears.

T Pl & 1) o 5@ 4> P ledeg ® =1 01 2

A B C DEF GHI JEKILM NOP Q R 5

If you choose: (hot key) Oracle Daybreak will:

[A] Save Changes (F10) Save any pending changes on the
form.

[B] Print (SHIFT + F8) Print the current screen.

[C] Exit (CTRL + E) Close the current form or exits the
application.

[D] Cut (CTRL+X) Remove selected text and stores it
on the clipboard.

[E] Copy (CTRL+C) Copy selected text and stores in on
the clipboard.

[F] Paste (CTRL+V) Insert text stored on the clipboard
in a selected field.

[G] Enter Query (F7) Change Oracle Daybreak to Enter-
Query mode.

[H] Execute Query (F8) Perform the query entered while in
Query mode.

[I1 Cancel Query (CTRL+Q) Change Oracle Daybreak back to
user mode.

[J] First Record Display the first record.

[K] Previous Record (SHIFT + UP) Display the previous record.

[L] Next Record (SHIFT + DOWN)  Display the next record.

[M] Last Record Display the last record.

[N] Insert Record (F6) Create a new record.

[O] Remove Record Delete the current record from the
database.

[P] Clear Record (SHIFT+F4) Clear the current record from the

[Q] Lock/Unlock Record
[R] Copy with Details Record

[S] Help

(CTRL + H)

form.

Lock and unlocks a record.

Copy the selected record to the
clipboard.

Display help for the selected item.

Note: Depending on the context of the selected field, some toolbar buttons may not be
available. For example, if you select a field that does not allow a query, the Enter Query

button is unavailable.
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Message lineThe message line is located in the lower left corner of the Oracle Daybreak
window and displays field prompts, error messages, or additional details about a field. In
the illustration below, the message line contains the error message: “Query caused no
records to be retrieved.”

FRM-40350: Query caused no records to be retrieved.

Record: 111 Il ==

Status line The status line appears below the message line and displays status
information about the current form or field. A status line can con-
tain the following indicators:

Enter-Query Indicates that Oracle Daybreak is in Enter-Query
mode, allowing you to specify search criteria for

a query.

List of Values Appears when a List of Values (LOV) is avail-
able for the selected field.

Form components

This section presents an overview of the components found on forms and how to use them.
Tab Oracle Daybreak uses tabs as a primary navigation tool.
Tabs are small flaps used for quick access to pages of informa-
tion, not unlike the tabs on a folder in your file cabinet. There are
three types of tabs in Oracle Daybreak system: master tab, tab,
and sub tab.
Master tabs are the highest level of tab. If present on a form, they
are usually numbered and appear near the top of the form. Master
tabs are used primarily to navigate to other pages.

Tabs and sub tabs open pages that contain information.

Sub tabs, if present, appear at the bottom of the form.
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Page (or tabbed page) The information items associated with a tab (blocks, records,
check boxes, command buttons, and so on) are located on a page.
The name of the page is the same as the name of the tab. The
information associated with a sub tab is a sub page.

In the illustration below, the Primary page and Address sub pages
are is circled.
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Block

A frame, or box, that encloses a set of related functions or data. A
shadowed line marks a block’s perimeter. The title of the block
appears across the top of the block in bold, black text. In the illus-
tration below, the Additional Lease Details page contains two
blocks: “Extensions and Due Date” and “Additional Details.” The
“Extensions and Due Date” block is circled.

Additional Loan Details

Addtional Line of Credit Detailz Additional Lease Details I

Extensions and Due Date

Year  Life
#otExensions[ || Total Term|
# of Extension Term I_ l_ Paid Term l—
# of Due Day Changes l_ l_ Iaturity Crt

Last Extn Ot Due Day Chy Ot

Additional Details

Command button

Field

A rectangle button that initiates a predefined action. Buttons do
not contain values as fields do. A button is usually labeled with
text noting the action that it performs. In the illustration below,
the Loan page contains six command buttons: “Calculate,”
“Amortize,” “Initialize,” “Copy to Decision,” “Copy to Con-
tract,” and “Print Report.” All three are located in the Action
block.

Note: The “Copy to Contract” button is unavailable.

Loan [ =z

W Calculate Payment

T Calculate Interest Rate

Calculste |

Amottize |

Iritislize |

Copy to Decision | Copy o Cortract Print Repott

Loan Details
Contract Dt |07/28/2003 First Pt Dt |07/29/2003
At Financed IW Pre-Paid Fees IW
Loan &mt $0.00 Financed Fees IW
Balloon Pt &t | $000 Term| 0 Maturity 0t [07/28/2008
Rate

Rate 0.0000 APR

0.0000

A box on a form used to enter, view, update, or delete informa-
tion. Each page contains fields. Fields can display values in dif-
ferent formats; including text, numbers, and dates.

Text field
Number field

A field that stores characters and numbers.

Number fields store only numbers, often dollar
figures, with or without decimals.

Date field Date fields store dates and sometimes time val-

ues.

IMPORTANT:
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Option button

Check box

When you select a field, messages appear in the message area in
the lower left corner of the Oracle Daybreak window. The mes-
sages describe the field or what type of information can be
entered in the field. (See Message line and Status line later in this
section for more information.)

Loan I Lease

Calculate | Amortize | Initialize |
Loan Details
Cartract First Pt Ot
At Financ F1,500.00 Pre-Paid Fees $0.00
Loan §1,500.00 Financed Fees $0.00
Balloon Pt fumt | F200.00 Term 0 hdaturity Crt

Action

@ Calculate Payment " Calculate Interest Rate

Calculatgr Optigns

Pmt F equenc'ﬂr\ﬂONTHL“fr
Biallooh Methad |1 PMTS
Tine Counting Method [FED CALENDAR

y

)

Y

| 4
Date Field

\j

Mumber Field Text Field

A round button used to select an action from a group of options.

You can select only one option button in a group at a time. In the
illustration below, option buttons are used to select whether Ora-
cle Daybreak calculates payment or calculates interest rate.

Loan l =z

Calculate |

" Calculate Interest Rate ]

Amortize | Intizlize |

Copy to Decision | Copy to Contract Print Repart

A check box indicates a state for a particular field, such as
enabled/disabled, primary/secondary, and current/not current. For
that reason, check boxes are sometimes called “indicators.” The
title of the check box indicates what it controls. A check denotes
that the check box is selected. Click a selected check box to
“clear” it.

Note: One or more check boxes can be selected, since each one
acts independently.

Pricing

Pricing Decision Ot

Select Pricing

OGMDE2003

|

Status Sub Status Underweriter

1
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List of Values (LOV) A dialog box linked to a field that enables you to select a single
item from a predefined list. To view a field's List of Values, press
F9. Move the blue highlighted bar using the UP or DOWN ARROW
keys or the slide bar on the LOV dialog box to the value you want
to select. In the example below, 55001 AFTON MN is selected.
Some LOV contain lists long enough to require a scroll bar to
view the entire contents. Choose OK, press ENTER, or double-

click the LOV item to populate the field with the selected value.

.
Find %043

=

MH ]
04043 KERMEBLINK ME
04330 ALGUSTA, ME
04330 CHELZEA ME
04330 SIDMEY ME
04332 ALUGUSTA ME
04333 AUGUSTA ME
04356 AUGUSTA ME
04338 AUGUSTA ME
04344 COOPERS MILLS ME
04342 DRESDEM ME
04343 ELST WIRTHROP ME
043544 FARMIMGDALE ME
04343 GARDINER ME

043435 WEST GARDIRER ME -

Blue square (cursor) Oracle Daybreak uses a blue square as a cursor. The blue square
indicates the active item, usually a field or record. You can move
the blue square using the arrow keys on your keyboard or by
clicking an item with the mouse.

ending Reg
Application
App #l D‘th 21272005 Joiml— ngr Purposel Priority | Statusl Companyl |
Procuct Existing Customer Dupl— Contact Channe\| Producer| | Sales Agent
Search (1) Applicants (2) Decizion (3) Contract (5) Collsteral (8] Comments (7) Imace (8) “erification (9) Tools (100
Resutts I Search Review Requests
Sort 5
Primary Sort Order Secondary Sort Order Wiew Alllv
MOHE - @ Cn HOME - ®a Cp Sort
Company Branch  Priority App # Diate Title: Product Status Producer
[pcc he  |NormaL|poooooozes |2t 2001 [shibia 7 LE MMAGNOLLY |LoanHE |4PPROVED-FINAL DOCUM [MN-00001 : N HOUSE (DIRECT DE
mbcc  He  [NoRMAL 0DO0000254 |05/01/2001 [PAULA J JOHN CCERASTOSTIGMA  [LOAN UNSECUREE |APPROWED-FINAL DOCUIM [MN-D0001 : IN HOLISE (DIRECT DE
[pcc he  |NorMaL|poonoonzes |07/t 2001 [GRAHAM JLISA COARNATION [LoAN UNSECUREE |AFPROYED-FINAL DOCUM MN-00001 © IN HOUSE (DIRECT DE
[pcc |he  |normaL Doooooozao |05/ 2001 [MARIE £ HANK CCOTONEASTER |LoAM UNSECUREL [4PPROYED-FIMAL DOCUM [MK-D0001 : IM HOUSE (DIRECT DE
Gueue Mame ‘CONTRACT YERIFICATION QLELE Secured Applicationr Copy Application | Mext Application |
Record A logically related collection of fields within a block about one

person, place, or thing.
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There are two types of records in Oracle Daybreak; table records
and block records. A scroll bar allows you view records not cur-
rently displayed. The message bar informs you of the total num-
ber of records in the table block, as well as the record you are
currently viewing.

Table records Appear as a grid, where each record is a single
row of related data.

Block records Record appears as a single block.

Record line  Located in the lower left corner of the Oracle
Daybreak window, the record line displays how
many records exist within the record on display.

Next Record/ The presence of a record scroll bar indicates that

Previous there are records above or below the one on
Record which you are working. If the scroll bar does not
scroll bar stretch the entire length between the two arrows,

this indicates there are additional records avail-
able. If the scroll bar stretches the entire length
between the two arrows this indicates no other
records are available. Click the arrows to view
these records. Click the up (A) or left () arrow
for previous records. Click the down (V) or right
(») arrow for following records.

Hint box A yellow box that appears when the mouse pointer is moved over
a field. The hint box will display a description of the field’s con-

tent. If the field is associated with a List of Value dialog box, the
hint box displays the Lookup Type of the LOV.

Using colors as a guide

Fields appear in different colors to indicate what type of information the field contains.

Aqua Required - Information is required in an aqua field to complete a
form.
White Optional - A white field is not required to contain information

when completing a form.

IMPORTANT:

Some optional fields may be required by your organization. Such
fields, though not mandatory on the form, must be completed dur-
ing edit verification.

Gray Display only - Data cannot be entered in these fields.
Note: Aqua, white, and gray are the default colors in the Oracle

Daybreak system. Your organization may have selected different
colors during implementation.
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Understanding parent-child relationships

A parent-child relationship is an association between a master block and one or more
detail pages. The master-detail relationship is arranged in the shape of a pyramid, from the
top of the form to the bottom. The top block contains the basic, or master, information.
The detail pages then expand on the contents of the master block. Detail pages themselves
can serve as master blocks for other sub detail pages that follow. When a block and pages
are linked in a master-detail relationship, the following conditions exist:

1  The detail page displays only those records that are associated with the current record
in the master block.

2 Querying between the master block and detail pages is always coordinated.

When a record is displayed in a master block, the detail pages contain information that
corresponds to that record. If you perform query or change information in the master
block, Oracle Daybreak updates the detail pages to match the new record in the master
block. If you use the master block to perform a query and gain access to the records for a
different application, the detail pages refresh to display information for the new record in
the master block.

Note: You can perform a query from a detail page if the master block (or page) is com-
pleted. Otherwise, it is not possible to directly query from a detail page.

Example: Parent-child relationship

In the illustration below, note that the Underwriting form is divided into three sections.
The top section (the Application block) is the master page. It contains such information as
application number, product, and other items related to a specific application. The Appli-
cants (2) master tab has been selected to display the Primary page and Address Informa-
tion sub page. These detail pages contain further information about the application; in this
case, the application’s primary applicant and that person’s address information.
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APPENDIX B :NAVIGATING AND QUERYING IN ORACLE DAY-

BREAK

This appendix explains how to use Oracle Daybreak to complete these frequently com-
pleted tasks:

* Navigate within and between forms

* Print a form

* Save an entry

» Edit data (including cutting, copying, and pasting data)

e Clear data

*  Duplicate data

*  Create and delete records

*  Use the Editor dialog box

»  Enter and query data using the List of Values (LOV) dialog box

e Use additional LOV tools (auto reduction, long-list, list search, and power list)

*  Query data

» Use query operators and wildcard characters (including Query by example, Query/
Where, and Query count)

*  Use hot keys.
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Navigating within a form

The following procedures can be used to navigate within a Oracle Daybreak form. Choose

the one you are most comfortable using:

*  Move the cursor with your mouse

*  Select a command from the menu bar (Navigation menu)
» Select a command from the Oracle Daybreak toolbar

* Enter a keyboard shortcut (hot key)

The Navigation menu

The Navigation menu contains the following commands, all of which allow you to navi-
gate within a form: Block, Record, and Field.

The Block command contains the following sub commands:

If you choose: (hot key)

Previous (CTRL + PAGE UpP)
Next (CTRL + PAGE DOWN)
Clear (SHIFT + F5)

Oracle Daybreak will:

Move the cursor to the previous block (if one
exists).

Move the cursor to the next block (if one exists).
Clear the block currently containing the cursor.

The Record command contains the following sub commands:

If you choose: (hot key)

Previous (SHIFT + F8)
Next (SHIFT + DOWN)
Scroll Up (PAGE Up)

Scroll Down (PAGE DOWN)

Insert (F6)
Remove (SHIFT + F6)
Duplicate (F4)
Clear (SHIFT + F4)

Oracle Daybreak will:

Display the previous record (if one exists).
Display the next record (if one exists).

Perform that same action as pressing PAGE UP.
Perform that same action as pressing PAGE
DOWN.

Create a new record.

Remove the current record.

Duplicate the current record.

Clear the current record.

The Field command contains the following sub commands:

If you choose: (hot key)

Previous (SHIFT + TAB)
Next (TAB)
Clear (CTRL + U)

Duplicate (F4)

IMPORTANT:

Oracle Daybreak will:

Move the cursor to the previous field (if one
exists).

Move the cursor to the next field (if one exists).
Clear the current field.

Duplicate the current field.

The TAB and ENTER keys move the cursor between fields. F8 refreshes the record.
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Navigating between forms

You can open multiple forms in each window and navigate between them with the Win-
dow menu. The lower part of the Window menu lists the forms that are currently open.
Selecting the form’s option button moves you to that form.

Cascade
Tile Horizantally
Tile Yerdically

] LGN

2 COTOMEASTER MARIE f COTOMNEASTER HAMNK (Underwriting)(Pending Request ; 0)
3 Securitization

® 4 endor Management

To navigate between forms
1  On the Oracle Daybreak menu bar, choose Window.
2 Select the form you want to move to by selecting it with one of the following methods:
*  Click the option button for the corresponding form.
_Or_
*  Move the cursor on the open Windows menu with the up and DOwWN ARROW keys and press
ENTER to open a highlighted form.
_Or_
*  Type the number on the Windows menu next to the form you want to open.

Oracle Daybreak displays the form you selected.

Common Oracle Daybreak tasks

This section explains tasks common to many Oracle Daybreak modules and forms. Here
you will learn how to:

*  Print a form

* Save your work

+ Editing data

»  Using the Editor dialog box

* Close a form/leave Oracle Daybreak

Printing a form

You can print a form at any time. Make sure a printer driver is installed and at least one
printer is defined before printing. (Contact your system administrator for information on
how to install printer drivers and define printers.)

To print a window

*  On the File menu, choose Print
_Or_
*  Click Print on the Oracle Daybreak tool bar.

Appendix B :-3 User Guide - Consumer Lease Collection



Saving your entry

When you save your work, the database is updated with all changes made since the last
time the data was saved.

To save your work in Oracle Daybreak

¢ On the File menu, choose Save

_Or_

*  On the Oracle Daybreak tool bar, choose Save (the yellow disk icon)
_Or_

e Press F10.

When you save an entry, the message line at the bottom of your screen displays a “Trans-
action complete” message to inform you of the changes.

FRM-40400: Transaction complete: 1 records applied and saved.

_Record: 111 | | |

Editing data

In this section, you will learn how to use Oracle Daybreak to edit data. You will learn how
to:

*  Cut, copy, and paste data
e C(Clear data

*  Duplicate data

¢ Create and delete records
*  Use the Editor dialog box

Cutting, copying, and pasting data

The cut, copy, and paste commands on the Oracle Daybreak menu bar allow you to move
and edit data.

To cut, copy, and paste with the Oracle Daybreak menu bar

1 Open the form and select the data in the field you want to edit. (You can either drag your
mouse over the data or double-click the data to select it.)

2 On the Edit menu, select Cut or Copy. (Copy leaves the data in the field while copying it;
Cut clears the field when it copies the data.)

3 Move the cursor to the field where you want to place the copied data.
4 On the Edit menu, choose Paste.

Oracle Daybreak pastes the cut or copied data in the new field.
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Keyboard guide for the previous steps

These three tasks can also be completed with the keyboard by doing the following:

Press this: To do this:
CTRL+X Cut
CTRL+C Copy
CTRL+V Paste

Clearing data

You can clear data from a form at any time. The data you clear is simply erased from the

form, not deleted from the database. You can clear fields, records, blocks, or entire forms.
This is particularly useful when you went to add an new entry to a record, block, or form
that appears “full.”

If the data is new and has never been saved in the database, it will be permanently lost
when you clear it from the form. Some items cannot be cleared of information. If you
attempt to clear an item that cannot be cleared, the error message “Field is protected
against update” appears in the message line.

To clear a field
*  Select the field you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Field > Clear.

-or-

Select and type over the existing data, or use the BACKSPACE or DELETE key to remove the
data.

_Or_

Press CTRL+U.

IMPORTANT:
The data you clear from the field is not available for pasting into another field. If you want
to paste the data elsewhere, use the Copy or Cut commands on the Edit menu.

To clear a record
»  Select the record you want to clear and use one of the following methods to clear data:
On the Navigation menu, choose Record > Clear.
_Or_
On the Oracle Daybreak tool bar, choose the Clear Record icon.
_Or_
Press SHIFT+F4.

Oracle Daybreak clears the values in all the fields of your current record and returns the
cursor to the first field of the next record.

To clear the current block

» Select a field in the block you want to clear and use one of the following methods to clear
data:

On the Navigation menu, choose Block > Clear.
_Or_
Press SHIFT+FS5.
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Oracle Daybreak clears the block and returns your cursor to the first field in the current
block.

IMPORTANT:

If the current block is a multi-record block, this action erases all records displayed in the
block.

To clear a form
e Open the application of the form you want to clear and press SHIFT+F7.

Oracle Daybreak clears the data from all the fields of the current form and returns your
cursor to the first field of the form.

Duplicating data

If data needs to be repeated in a new record, you can duplicate data from a previous
record.

To copy a field from a previous record
1 Depending on the form you are using, enter a new record or query an existing record.

2 On the Navigation menu, choose Record > Insert
_Or_
On the Oracle Daybreak tool bar, choose the Insert Record icon
_Or_
Press F6.

Oracle Daybreak inserts a new record after the existing record.
3 Move the cursor to the field you want to duplicate in the new record.

4 On the Navigation menu, choose Field > Duplicate.
_Or_
Press F3.

Oracle Daybreak copies the field value from the previous record to the current record.

To copy all fields from a previous record
1  Enter a new record, or query an existing record in your form.

2 On the Navigation menu, choose Record > Insert
_Or.
On the Oracle Daybreak tool bar, choose the Insert Record icon
_Or_
Press Fe6.

Oracle Daybreak inserts a new record after the existing record.
3 On the Navigation menu, select Record > Duplicate.

_Or_
Press F4.
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IMPORTANT:
If your current block requires all records to be unique, the Duplicate command does not
duplicate those fields that must be unique.

To copy all information on a page and its sub pages
1  Move the cursor to the first field on the page you want to duplicate.
2 On the Oracle Daybreak tool bar, choose the Copy with Details Record icon.
Note: For this process to work, the entry has to be locked (lock parameter set to y)
3 Make the changes you desire to the details in the duplicate entry to make it unique.
4  Choose the Copy with Details Record icon to complete sub tabs.

5 Make the changes you desire to the sub page details in the duplicate entry to make it
unique.

6 Save your new entry.

Creating and deleting records

You can enter new records in the database or delete existing records from the database.
Only users who have the appropriate permissions set up in their user responsibility can
create or delete records.

To create a new record

1  On the Navigation menu, choose Record > Insert.
_Or_
On the Oracle Daybreak tool bar, click Insert Record.
_Or_
Press Fé.

Note: When you create a record in a multi-record block, Oracle Daybreak inserts a new
blank row below the selected row. In a single-record block, Oracle Daybreak clears the
fields in the block.

2 Once the selected field is cleared, enter the data for the new record.

3 On the File menu, choose Save.
-Or-
On the Oracle Daybreak tool bar, click Save.
_Or_
Press F10.

Oracle Daybreak saves the record in the database.

IMPORTANT:
If you exit the form without saving your work, the record is not added to the database.
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To delete a record
1  Select the record you want to delete.
2 Use one of the following methods to delete data from a field:

On the Navigation menu, choose Record > Remove.
_Or_
On the Oracle Daybreak tool bar, choose the Remove Record icon.

Oracle Daybreak erases the current record from your form and returns your cursor to the
first field of the next record; however, the record is not yet deleted.

3 On the File menu, choose Save.
_Or_
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

IMPORTANT:
If you exit the form without saving your work, the record is not deleted from the database.
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Using the Editor dialog box

You can use the Editor dialog box to view, enter, or update the entire contents of an entry
field. The Editor dialog box is especially useful for editing scrollable text fields. A scrolla-
ble text field is a field whose actual width is longer than its display width and whose con-
tent you can view by scrolling through the field. Searches performed in the Editor dialog
box are case-sensitive.

IMPORTANT:
If a text field is set up to use a default system editor, then the following procedures open
the editor determined by the profile option “Editor (Character).”

To use the Editor dialog box
1  Open the form and select the field you want to edit.
2 On the Edit menu, choose Edit Field.

The Editor dialog box appears with the text from the field you selected.
Sl Sedelese e e e e e e e e e e e e e e e e e e L e e e e e e

| ¥

The text fram the selected field appears here.|

4

Note: You can also open the Editor dialog box by pressing CTRL+E.
3 Enter a new text or edit the existing text in the Editor dialog box and choose Ok.

IMPORTANT:
If the current field is a display-only field, then the Editor dialog box appears in display-
only mode.

To search for a phrase and replace it with another phrase
1 On the Edit menu, choose Edit Field.

The Editor dialog box appears.
2 Choose Search.

The Search/Replace dialog box appears.
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3 In the Search for field, type the text or characters you want to find on the form.

If you want to replace that data with other data, type the new data in the Replace with
field.

4 Choose the Search button to search for the value.
_Or_
Choose Replace to search for the value and replace the first occurrence.
-Or-
Choose Replace All to search for the value and replace all occurrences.

5 To close the Search/Replace dialog box, choose Cancel.
6 When you are finished editing the value in the Editor window, choose Ok.

The Editor dialog box closes the window and the edited value appears in the field.

Exiting a form/leaving Oracle Daybreak

You can close a Oracle Daybreak form, or end a Oracle Daybreak session, using the mouse
or keyboard.

To save exit a form/leave Oracle Daybreak

*  On the File menu, choose Exit
_Or_

*  On the Oracle Daybreak tool bar, choose Exit (the blue door icon)
_Or_

*  Press CTRL + Q.

Oracle Daybreak will end a Oracle Daybreak session when you perform one of these
actions from the Login form.

Entering and querying data

This chapter explains how to use the List of Values dialog boxes and search for data while
using a form.

List of Values (LOV) dialog box

Many fields on Oracle Daybreak forms are linked to a List of Values (LOV) dialog box.
An LOV displays all possible entries that Oracle Daybreak will accept for a particular
field. You can select data from the LOV to complete the field instead of having to search
for acceptable entries. Likewise, a field that is associated with an LOV only accepts
entries found on the list of values. Using the LOV increases accuracy and productivity, as
it ensures uniformity and efficiency during data entry.

Note: If you are in Enter-Query mode, the LOV cannot be used.
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When an LOV is available for a field, “List of Values” appears on the status line. Also,
when you move the cursor to the field with an LOV from a Lookup field in the Setup
menu, a yellow hint box appears, citing the lookup type for the LOV.

Address { Emplayments Telecoms Financials Liakilties Cthet Incames
Postal Type # Pre Strest Name Street Type Post  Apt Mo Own / Rent Yfrz  Mths At Freq a
Type|HOME INORMAL A | \ | | \ MM HOME  gted| O] O 3000 MONTHLY |
Malingh#  Address| ﬂm Landor | Ph|
Current ¥ | i — T Cenzug Tract/BMA Code ‘ MS4, Code|
Cty s m[ [ conylus enl Comment| 3]

When you open an LOV from an entry field, the field’s LOV dialog box appears.

_ookup -

Fine|%

Lookup =

ANENUE
BOULEY ARD
CIRCLE
CEMTER
CRESCEMT -
COURT

CANY O
DALE

DRIVE
EXPRESEVAY
FREEWAY
GARDEM
GROWE

HILL

LIFLm T

1 ¥

Find Cancel

An example of a List of Values box. This one appears from the Street Type field on an
Address block.
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An LOV might contain more than one column of information. Most LOV's provide a
descriptive heading at the top of each column.

Find|se043
Zip City State =
02043 HIMGH AR
03043 FRAMCESTO YN MH ]
04043 KEMMEBLINMK ME
04330 AUGUSTA ME
04330 CHELZEA ME
04330 SIDMEY ME
04332 AUGUSTA, ME
04333 ALUGUSTA ME
04336 ALGUSTA ME
04338 ALGUSTA ME
04341 COOPERS MILLS ME
04342 DRESDEMN ME
04343 EAST WANTHROP ME
04344 FARMMGDALE ME
04345 GARDINER ME
04345 WEST GARDIMNER ME -

) gencel |

To select data from an LOV
1  Move the cursor to an entry field with an LOV.
“List of Valu...” appears on the status line.

2 On the Edit menu, choose List of Values.
_Or_
Press F9.

When the LOV appears, you can either use the mouse to scroll through the list box and
double-click on a value to select it, or press the UP ARROW or DOWN ARROW keys to high-
light a value with the blue bar.

If you choose Cancel, the LOV closes and no entry appears in the field.
3 Press ENTER or choose OK to select the value.

Once you select a value, the LOV dialog box closes and the selected value appears in the
field.
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Additional LOV tools

In addition to allowing you to select a field value, LOVs provide tools to simplify entering
data and working with long lists. Auto Reduction lets you view a condensed portion of the
entire list of values. Power List allows you to quickly enter data without opening the LOV.

In some cases, an LOV is too large to fit entirely in the list box and the Long-List LOV
appears.

Auto reduction

Using Auto Reduction, you can shorten an LOV. With a shortened list, you only need to
scan a subset of the original values.

To use the Auto reduction feature

* In the Find field on the LOV dialog box, type the first character(s) of a value you want to
locate. (A percent sign appears by default in the Find field.)

Oracle Daybreak automatically reduces the list to just those values in the first column that
match the characters you enter.

Note: To return to the entire contents of the LOV, type the wildcard character % in the
Find field and press ENTER.

List search

If you do not know the initial characters of your value, but do know that your value con-
tains a certain word or set of characters, you can perform a list search to find the values
that contain those words or characters.

To perform a list search

1 In the Find field on the LOV dialog box, enter any group of characters as search criteria.
Use wildcard characters, such as the percent sign (%), which represents any number of
characters, or underline ( _ ), which represents a single character in your search criteria.

IMPORTANT:
The criteria you enter for a list search is not case-sensitive. For example, to reduce a

search list to just those values containing the word “schedule,” enter %schedule% in the
Find field.

2 Choose Find.

A reduced list appears, containing just those values that match the search criteria.
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Long-list

Long-List is the other tool you can use to shorten an LOV. Long-List works similarly to
Auto Reduction. The Long-List dialog box appears when a field has a list too large for
Auto Reduction.

To perform a list search

1 Inthe Find field on the long list LOV dialog box, type the first few characters that occur in
your value in the Find field

2 Choose Find.

Oracle Daybreak reduces the long list to a smaller sub set of values meeting the search cri-
teria in the Find field in a regular LOV.

3 Select the value you want to use and choose Find.

Other LOV features

You do not have to use a field’s LOV to complete a field. If your entry appears in the
field’s” LOV, Oracle Daybreak will accept it when you type it in the field.

The Auto Reduction logic that applies to the LOV also applies to your entry in a field with
an LOV. If you type the first letter of your entry and press TAB, Oracle Daybreak will auto-
matically complete the field if there is a single match in the LOV.

If more than one entry in the LOV share the characters you typed, Oracle Daybreak will
open the LOV displaying only the entries beginning with those characters.

If no entry in the LOV matches the characters you typed, Oracle Daybreak opens the LOV
displaying all of its entries when you press TAB.
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Querying data

Oracle Daybreak provides you with search options to locate information when working
with a form. You can retrieve and review all available information in your database with-
out having to remember the information from a previously displayed form or printing
lengthy reports to view an item. Instead, you can perform a search to obtain and review the
information you want.

This section describes the methods you can use to locate and retrieve records in Oracle
Daybreak. These include:

* Using query operators
*  Query-by-example

*  Query/Where

e Using query count

Note: If you are in Enter-Query mode, the LOV cannot be used.

IMPORTANT:

Searches cannot be performed in forms that require using the Search page to retrieve infor-
mation. These forms (for example, the Underwriting form, the Funding form, and Cus-
tomer Service form) only display run-time output, or only run specific processes. The
following message appears in the message line if you attempt to search such a form:
“Function key not allowed. Press Ctrl+F1 for list of valid keys.”

Enter a queny; press FAE to execute, Cirl+ 0 to cancel.

_Recard: 1/1 | | Enter-qu.. |

Using query operators

Query operators are used to create search criteria to limit searches to specific information.
The query operators available in most fields include:

Operator Meaning Example Expression

= equal to = 'Janet' or = 107
I= not equal to != '"Bob' or != 107
> greater than > 99 or > '01-JAN-93"'
>= greater than or equal to >= 55

< less than < 1000.00

<= less than or equal to <= 100

#BETWEEN between two values #BETWEEN 1 AND 1000

The query operator expressions retrieve results according to character-ordering rules for
character fields and numeric-ordering rules for numeric fields. For example, look at the
following field values:

002, 003, 004, 005, 078, 123, 253, 441, 576, 775, 1274, 3298,
4451, 5600, 9578, 10500, 58437, 708445
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These values are shown in the order you expect for numeric values, where 005 is between
004 and 078. If the field is defined as a numeric field, then the phrase “#BETWEEN 004
AND 078" would retrieve 004, 005, and 078.

However, if the field is defined as a character field, then the phrase “#BETWEEN 4 AND
7” would retrieve the values 441, 576, 4451, 5600, and 58437, which all start with
characters between 4 and 7. The values 775 and 005 would not appear because 775 is
lexically greater than 7, and 0 is lexically less than 4.

Some fields contain date values that are actually “Date-format” character values. These
fields act like character fields in that the value 01-FEB-92 would be lexically less than 01-
JAN-92, because F precedes J in a character set.

IMPORTANT

Sometimes you cannot instantly determine if a field containing numeric values is defined
as a character or numeric field. To identify what the field type is, you may have to enter
and experiment with different search criteria expressions and see what results are returned.

Tips for using Query Operators

» Use single quotation marks (' ') to enclose the character or date value in your
expression. For example:

'Texas'
'01-MAY-93"

*  Query operators cannot be used in time fields.

When you use the #BETWEEN query operator, the search criteria “#BETWEEN valuel
AND value2” retrieves all records containing values between and including valuel and

value2. The same applies to dates. For example, using the search criteria “#BETWEEN

'01-JAN-93' AND '01-MAR-93" in a date field retrieves all records with dates between
and including January 1, 1993 and March 1, 1993.

Finding patterns with wildcard characters

In addition to query operators, you can include wildcard characters in your search criteria.
Wildcard characters search for particular patterns in your data. Use the percent (%) wild-
card character within a field to represent any number of characters (including no charac-
ters), or use the underline (_ ) wildcard character to represent any single character.

For example, if you want to retrieve all records that contain the word “XXX” in a specific
field, you would enter the search criteria %XXX% in that field.
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Enter-Query mode

If you want to retrieve a group of records in a Oracle Daybreak from using search criteria,
you can use Enter-Query mode.The Enter-Query mode may be used to specify complex
search criteria in any of the fields on your current block.

The search criteria can include:

*  Specific values

*  Phrases containing wildcard characters

*  Phrases containing query operators

*  Any combination of the three to help you pinpoint the data of interest.

IMPORTANT:

When your application is in Enter-Query mode, you will not be able to navigate out of the
current form. To navigate from the form, you must exit Enter-Query mode by choosing
Cancel Query or Exit on the task bar or pressing CTRL+Q.

To user Query-by-example

1  On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches from data entry mode to Enter-Query mode and clears the form.
The Enter-Query message appears in the status line.

2 Enter search criteria in any of the fields, using wildcard characters and query operators as
necessary. You can also choose Last Criteria on the Query menu to display the search cri-
teria used in your last search, if there was one.

Note: Pressing F7 twice will also display the search criteria from your last search.

IMPORTANT:

While in Enter-Query mode, all check boxes are in a neutral state; that is, they are neither
selected nor cleared as a default. If you want your search criteria to include a selected
check box, you have to select it, regardless of whether it already appears to be checked.
Similarly, if you want your search criteria to include a cleared check box, you have to clear
it, regardless of how it currently appears. (To clear it, first select the check box to activate
it, then select it again to clear it.)

3 On the Query menu, choose Execute
_Or_
Press F8
_Or_
On the Oracle Daybreak toolbar, click the Execute Query icon.

IMPORTANT:

To retrieve all the database records for a block, you can bypass steps 1 and 2 and select
Execute on the Query menu. This is known as a blind query. To retrieve all records for a
block, press F7, then press F8 to perform the query.
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4  To leave the Enter-Query mode, choose Cancel from the Query menu
_Or_
Press CTRL+Q
_Or_
On the Oracle Daybreak toolbar, click the Cancel Query icon.

Query/where

An even more sophisticated search method is to use Query/where. Query/where allows
you to modify a query by using a SQL Plus statement as your search criteria.

To use Query/where
1  On the Query menu, choose Enter
-Or-
Press F7
_Or_
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches to Enter-Query mode.

2 Enter the character & (or a blind variable) in the field from which you want to run the
query.

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

The Query/Where dialog box appears.

4  Type the search criteria in the format of a SQL Plus statement in the window.
For example, the following Query/Where search criteria:
:P like 'SVEHS' and :A in ('0000000374', '0000000532")

5 Choose OK to execute the query.
_Or_
Choose Cancel to close the Query/Where dialog box without running a query.

Note: If you have a long statement as your search criteria, you can use a field editor to
make changes to your statement by choosing Search.
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Query count

If you do not need to retrieve the records from a query-by-example search, but only want
to know how many records match your search criteria, you can perform a query count.

To obtain a count of the number of records

1  On the Query menu, choose Enter
_Or_
Press F7
_Or_
On the Oracle Daybreak toolbar, click the Enter Query icon.

2 Enter the search criteria in the field you want to perform the query.

3 On the Query menu, choose Count Hits.
_Or_
Press SHIFT+F2.

Oracle Daybreak counts your query. A message appears on the message line displaying
the number of records query-by-example would retrieve if you ran the search.

IMPORTANT:
If you select Count Hits on the Query menu without specifying any search criteria in a
block, query count displays the total number of records in the database for that block.
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Hot keys
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“Hot keys” are keystroke shortcuts that perform navigation and data entry tasks. A dialog
box containing a form’s available hot keys can be viewed by selecting Help > Keys on the

Oracle Daybreak menu bar. Below is a list of these keys:

Function

Block Menu

Cancel Query

Clear Block

Clear Field

Clear Form

Clear Record

Copy

Count Query

Cut

Delete Record

Display Error

Down

Down

Duplicate Item

Duplicate Previous Record

Exit

Enter Query

Execute Query

Help

Insert Record

List Tab Pages

Move between master tabs
Master tab 1
Master tab 2
Master tab 3
Master tab 4
Master tab 5
Master tab 6
Master tab 7
Master tab 8
Master tab 9
Master tab 10

Move to next page/sub page

Move to previous page/sub page

Next Block/Page to sub page

Next Field

Next Primary Key

Next Record

Next Set of Records

Paste

Previous Block/Sub page to page

Previous Field

Previous Record

Print

Return

Save changes

Scroll Down

Scroll Up

Scroll Keys

Up

Up

Update Record

Key(s)

F5

CTRL +Q
SHIFT + F5
CTRL+ U
SHIFT + F7
SHIFT + F4
CTRL + C
SHIFT + F2
CTRL + X
SHIFT + F6
SHIFT + F1
DOWN ARROW
CTRL + L
F3

F4

CTRL + E
F7

F8
CTRL+H
Fo6

F2

SHIFT + CTRL + F1
SHIFT + CTRL + F2
SHIFT + CTRL + F3
SHIFT + CTRL + F4
SHIFT + CTRL + F5
SHIFT + CTRL + F6
SHIFT + CTRL + F7
SHIFT + CTRL + F8
SHIFT + CTRL + F9
SHIFT + CTRL + F10
CTRL+TAB
CTRL+SHIFT+TAB
CTRL + PAGE DOWN
TAB

SHIFT + F3

SHIFT + DOWN ARROW
SHIFT + CTRL + PAGE DOWN
CTRL +V

CTRL + PAGE UpP
SHIFT + TAB

SHIFT + UP ARROW
SHIFT + F8

ENTER

F10

PAGE DOWN

PAGE Upr

CTRL + F1

CTRL +P

UP ARROW

CTRL + U
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APPENDIX C : TRANSACTION PARAMETERS

The Customer Service form Maintenance (3) master tab allows you to post an array of
monetary and nonmonetary transactions for any given account. The transactions that are
available depend on the responsibility of the Oracle Daybreak user, the nature of the
account, and whether the account is a lease.

This appendix catalogues the baseline transaction codes and parameters available on the
Customer Service form’s Maintenance (3) master tab. Instructions on how to use the
Maintenance (3) master tab are located in the Customer Service chapter of this User
Guide.

Lease monetary transactions

This section catalogues the transaction codes and parameters required to complete the fol-
lowing monetary tasks for leases:

*  Apply, adjust, or waive servicing expenses

* Adjust or waive late charges

* Adjust or waive nonsufficient funds

*  Apply, adjust, or waive repossession expenses
*  Apply, adjust, or waive bankruptcy expenses
e Apply or adjust phone pay fees

* Change an index/margin rate

*  Apply, adjust, or cancel financed insurance

*  Generate a payoff quote

* Payoff an account

*  Charge-off an account

*  Close an account

* Change a due date

*  Apply, adjust, or waive a disposition fee

*  Apply, adjust, or waive a termination fee

* Record selling an asset

* Apply, adjust, or waive an excess usage fee

*  Apply, adjust, or waive other fees and taxes
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Servicing expenses

Service expenses are any expenses incurred to service an account; for example, employing
a courier to send documents, such as payoff quotes or balance statements. Servicing
expenses appear in the Other Due field on the Dues block of the Account Details page.
This is the first page to appear on the Customer Service form when you load an account.

Search - - o

Contact Information

Auto Run Lo # Status Product Payoff Amt At Due Dllest Due O Company  Branch
I B T R 001 0200031 543 |cHaRGED OFF [ LEASE wEHICLE | $0.00 | $0.00 0402202007 [SSFC (o0 =
Acc #120010200031543 [1120200032343 |cHARGED OFF |LEASE vEHICLE | $0.00 | $0.00 042202007 [SSFC [CO -
Or 55 Shaw A1V Tatal| $0.00 | $0.00 #of Accourts| B
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4)  RepoiForeclosure (5) Deficiency (6) Contract (7)) Collsteral (8) Bureau (9) Comments (100
Account Details l Customer Details ElLfinzss Balances Transactions Tracking Attributes Statements =R Insurances “endor Work Order
lclj;lm:;:AHAM [PrRIMeRY - D%I:dsayls [ som Oldlest Due Ot [01/22r2010 i Sl _ (ol
I e lbrouse ; Payaft - o b1 L B [SHIP TRACE ASSIGNMENT  [11/27/2008 [11/30/2008 |~
|CREDIT INSURANCE AMD e 1142772009 [11/30/2009
Customer # SSN Birth Dt Gender Dy Due | $0.00 | q [oEe2007 | $0.00 —
[ 219690 [xxz-xx-1213 03111973 [UNKNCWI LC Dus | 3000 2 [o72202007 | $0.00 L‘e = l l v
Einail [JOHN. ABRAHAM@GMAIL COM NSF Dus $0.00 3 |Derz2/2007 | $0.00 | C
Lanquage [ENGLISH Werital = [aRRED lother Due $0.00] 4 [05r222007 | $0.00 |
Digakility [ Shin[— Stop Correspondencel | Totsl Due $0.00 5 |04i22/2007 $0.00 [ =l
Privacy Opt-0ut Time Zone l— Active Wiitary Duty [ Activity

Eftective Ot Active Dt Paid Off Ot Chargeoff Ot Current Pt Due Day

Delinquency Information
Late 30 B0 @90 420 150 180

Address Type CurrentConfirmedhaling  Phone o320 o3mze00r [o1otzo00 [oroseonn |

ssaas | 22 [ o[ s o 2] 2 4] 2

HOME W [ ¥ 1234567800 = LostPrt &mt PmtDt  LastBil Amt Last Activity Dt Mitary Duty e ) R )
h23 [ $O.00 (01012000 | $44 486,88 [01721/2010 I S e
EDEM FRAIRIE Mh-55344 Frocucer [MC-00003 : JENKINS INYESTMENT Sehavior Soore| 0 Days  Category Collctor
= App & ,W Customer Grade ,m Ecore 'W ’_D,—W
Call Activities l Promises Comments Checklist References Payment Rsting History  Due Date History
Action Resutt Contact Resson Promise Ct Promise Amt Cancel  Condition Followwup Ot Time Zone Acli, Followeup Ot Appt
mcc Hu [ [ [ $0.00 [ [none [11/302008 0224719 A | (11302009 Da:amag Am 2
lec [pr [ [ [11/27:2009 | 200,00 W [NONE [11/30/2008 04:45:34 &M | [11/30/2009 04:45:34 AM [
lec PR [ [ 112712009 | $101.00 W [NONE 113012008 04:41:58 &M | 113042009 04:41:56 AM [
[To (] [ [ [ I 0.00 [ DELG [11.21/2008 09:21 47 am | 112172008 03:21:47 A0 [
[To L [ [ [ I $0.00 [ NONE 117212008 09:21:04 Am | [11/21/2008 02:21:04 &M [~

To post a servicing expense

Transaction
SERVICING EXPENSES

To adjust a servicing expense

Transaction
ADJUSTMENT TO SERVICING EXPENSES - ADD

ADJUSTMENT TO SERVICING EXPENSES - SUBTRACT
To waive a servicing expense

Transaction
WAIVE SERVICING EXPENSES
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Late charges

Late charges occur when payment is not made within the grace period or by the day after
payment is due. The due date is determined by the contract. Late charges cannot be
assessed by a user, they are assessed automatically by Oracle Daybreak.

Late charges appear in the LC Dues field on the Dues block of the Account Details page.
This is the first page to appear on the Customer Service form when you load an account.

nog Reg

Accounts

Search Queue Auto Run Ao # Status Product Payoff St it D Ollzst Due Ot Company  Branch
T Mg 3154 |cHarzED oFF | LEasE vEHCLE | $0.00 | $0.00 042202007 [ssFC [co -]
Ao #2001 1200031 543 [112m200n32545 [cHarsED oFF | LEasE vEHICLE | 000 | 000 [Ne2e007 [SSFC jom =
or sSM Show IV Total| $0.00 | $0.00 # of Accourts B
Search (1) Customer Service (21 | Maintenance (3)  Bankruptcy (4)  Repo/foreclosure (5] Deficiency (6] Contract (71 Collateral (5) Buresu (30 Comments (10)
Accourt Details l Customer Details BlEiEss Balances Transactions Tracking Attributes Statements ESGrony. Inzsurances “endor York Order
.Cuslumers D'lfloedsay's Condrtions, . ion Start Dt Followup Dt
a |_
HOHN AERAHAM [PRIMARY B ey 3000 ;"de[? e Dﬁfmm B [SKIP TRACE ASSIGMMENT 117272009 [11/5002009 | &)
LEE K ABRAHAM SPOUSE U
| | e |CREDIT INSURANCE AMD 2 [11/27/2009 [11/50/2000
Customer # SEH Birth Dt Gender Dl Due 3000 1 [peiz2r2007 | $0.00 | | | .
-
[ 219680 [rooe-0¢-1213 (031141973 [UNKNSWAN Jicoue $0.00| 2 [o7iz2/2007 | $0.00 e
Bl [JOHN. ABRAHAM@GMAIL COM MSF Due $0.00 3 |D6r22/2007 | $0.00 | A
Language [ENGLISA Martal St MARRED Other Due [ §0.00 4 (05222007 | $0.00 |
Dizability [ Skipl— Stop Correspondence Tatal Due | $0.00 5 [04:22/2007 | $0.00 [ -]
Privacy Opt-Outl‘—’ Time Zone Active Miltary Duty [ Activity Delinquency Information
" Effective Ot Active Dt Paid Off Ot Chargeoif Ot Current Pmt  Due Day Late 30 60 90 120 150 180
Contact Information
Address Type CurrentConfirmedhaling  Phone |oarzzen0r oazaeo0T (o101 2000 |pose0nn | 553048 22 2| oz 2| =z 2| 1] z
HOME [ W [izzams - LastPmt Amt  PmtDt  Last il Amt Lest Activity C8  Miltary Dut
123-456-7800 4 a At B ast Activity itary DUty BRmSF Lty 0 0
123 [ $0.00 [o1/01/2000 | 344,486.58 [01/21/2010 [ S D
Ear,
EDEN PRAIRE MN-55344 | Producer [NC-00003 - JENKINS INVESTMENT Behavior Score| O Beus Geimgmy | @olsdiy
v App # [20010200031543 Customer Grade [C GRADE | Scare| 500 of [DEMOCOLL
Call Activities l Promizes Comments: Checklist References Payment Rating History — Due Date History
Action Result Contact Reazon Promise Dt Promise Amt Cancel  Concition Fallowwp Ot Time Zone Adfj. Folliowug Ot Appt
mcC Hu [ [ [ [ 50,00 [ [nonE [11/30/2009 04:47:19 &M | [11/30/2008 04:47:19 AM [ 2]
lec 3 | | 11272009 | $200.00 [ [NONE |11r30/2008 04:45:34 &M | [11£30/2009 04:45:34 &M [
== |pr | | [11/2772009 | 101,00 [ [HGHE 11 r3002000 04:41:55 am | 1173002000 04:41:58 2M [
1o [ | I | | $0.00 [ |pELG [ 11721 2008 0921247 2 | 1172172008 032147 A [
[T [ | | | | $0.00 [ |MCHE 11721 2008 09:21:04 A | 1212008 002104 M T 5

To adjust a late charge

Transaction Parameters

ADJUSTMENT TO LATE CHARGE - ADD TXN DATE
AMOUNT

ADJUSTMENT TO LATE CHARGE - SUBTRACT TXN DATE
AMOUNT

To waive a late charge

Transaction Parameters

WAIVE LATE CHARGE TXN DATE
AMOUNT
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Nonsufficient fund fees

Nonsufficient fund fees are posted when a payment does not cover the amount owed. The
fee that Oracle Daybreak automatically applies to an account is recorded during setup.

Nonsufficient fund fees appear in the NSF Due field on the Dues block of the Account
Details page. This is the first page to appear on the Customer Service form when you load
an account.

Search ¢ ce Auta Run Accounts Status Product Payaff Amt &mtDue  Oldest Dug Dt Company Branch
[/ b | m Y 3 [CHARGED OFF | LEASE VEHICLE | $0.00 | 000 [pe2on7 [ssFc jem A
A0 #2001 0200031543 (1120200032343 [CHARGED OFF | LEASE VEHICLE | $0.00 | 5000 [s2onr [ssFc jem |5
or SsN Show MV Totsl| 50.00 | $0.00 #of Accourts| 6
Search (10 Customer Service (2) | Mairtenance (31 Bankrugtcy (4)  RepofForeclosure (5)  Deficiency (6] Contract (7) Callateral (8) Buresu (9) Commerts (100
Accourt Details I Customer Details BEEIEss: Balances Transactions  Tracking Attributes Statements By Inzurances Wendar Wark Orcler
.Cuslomers n%loecisay‘s Conditions. oo Start Dt Followu Dt
R r
}JOHN CERAT IPR'MARY B ey o [?‘dEDS: BUB(Es Ul\ﬁ:rm B [SKP TRACE ASSIGNMENT 1112772009 [11/3012008 |4
LEE K ABRAHAM SPOUSE - e
CREDIT INSURANCE AND Vi 11/27/2009 [11/30/2009
Customer # = Birth Ot Gender Dele D $0.00 1 08222007 | $0.00 I I I L
-
[ 219690 oceoe1213 03101975 [UNKNGWN 7222007 | $0.00 e
Emil |JOHN. ABRAHAME@GMAIL COM MEF e [ 5000 B [08r2202007 | $0.00 | A
Language ENGLISH Marital St [MARRED Cther Dug | 5000 4 0572202007 | 50.00 |
Disaaiity | kil Stop Correspondencel . Total D 5000 5 [04/2202007 | 50.00 | =
Privacy Cat-Outl¥ Time Zanie Active Mitary Duty [ petiuity Delinquency Information
Contact Information Effective 0t Active Ot Paidd Off Ct Chargeoff Ot Currert Pt Due Day Lete 30 BD 90 120 150 180
Address Type CurrentConfirmedhsiing — Phane (03222007 [o312202007 [0t 10122000 [mmse20te | ssagas | m [ 2 2f 2] z[ 2 [ 2
m Om  F T - =
HoME 1234567890 (4] LastPmt &mt  PmtDt  LastBil Amt Last Activity Dt itary Duty T 5
123 [ $0.00 (010172000 | $94,486.85 |01/212010 I o c
=18
EDEN PRAIRE MN-55344 _ Producer [Mc-00003 - JENKINS INVESTMENT Biehavior Score 0 Days Category  Collector
T appi [20010200031543 Customer Gradz [C GRADE | Seore| 60D o [DEMOCOLL
Call Activities I Promizes Comments Checklist References Payment Rating History  Due Date History
Action Result Cortact Resson Promize Ot Promize &mt Cancel  Concition Followeug Ct Time Zane Adf. Followeup Ot Appt
mjcc |Hu [ [ \ [ 5000 [ [NonE 1173072008 04:47:18 AM | [11/30/2009 D4:47:19 M [~
cc 3 | | 112712009 | $200.00 [ [NONE [11/3072008 04:45:34 8w | [11r3002009 D4:45:34 A T
lcc e [ [ (114272008 | $101.00 [ [NONE [11/3002009 04:41:58 &M | [11r30/2009 04:41:55 am [
[0 T [ [ \ [ 50.00 [ |DELG: [112112008 03 21:47 A0 | 116212008 02:21:47 s [
[0 T [ [ \ [ 50.00 [ [NONE [112112008 03 21:04 &M | [11r21:2008 02:21:08 2 [+
To adjust a nonsufficient funds
Transaction Parameters
ADJUSTMENT TO NONSUFFICIENT TXN DATE
FUND FEE - ADD AMOUNT
ADJUSTMENT TO NONSUFFICIENT TXN DATE
FUND FEE - SUBTRACT AMOUNT
To waive a nonsufficient funds
Transaction Parameters
WAIVE NONSUFFICIENT FUND FEE TXN DATE

AMOUNT
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Repossession expenses

Repossession expenses include any costs incurred while obtaining the asset, including
legal fees or storage costs.

Repossession expenses appear in the Other Due field on the Dues block of the Account
Details page. This is the first page to appear on the Customer Service form when you load
an account.

Search o .. Ao Run Accounts

Aoo # Status Product Payoff Amt Amt Due Cldest Due Ot Company  Branch
[y |cHarGED OFF | LEASE VEHICLE | $0.00 | 50.00 042272007 [SsFC oo -
Ace #20010200031543 [1120200032343 |cHARGED OFF | LEASE VEHCLE | $0.00 | $0.00 [0422007 [ssFC [con -
or 55 Shaw I Total 000 | .00 # of Aocounts [;
Search (1) Customer Service (2) | Maintenance () Bankruptcy (4)  RepofForeclosure (5)  Deficiency (6) Contract (7 Collateral (8) Bureau (3) Comments (100
Accourt Details l Customer Details BEihEss Balances Transactions Tracking Attributes Statements Bzl Insurances “endor VWork Crder
.Cuslomers ~ D?fdsay.s co"dmnnstondition Start Dt Falloweup Ot
Iig:r( i::::z: };’:gj:; B oy SJ:EDS: e Dlﬁfmm B [SKP TRACE ASSIGNMENT [11/27/2009 (117302009 &
Z |CREDIT INSURANCE AND Wie[11/27/2009 [11/30/2009
Customer # SN BMRDt  Gender Delcy Due $0.00 1 [08r222007 | 50.00 | | | I
B
[ 219650 [rooco-1213 031171973 [UNKHCWAN LC Due | $0.00 2 [07/22/2007 | $0.00 ]
Email [JOHN.ABRAHAMEGMAIL COM MSF Due | $0.00 3 [06/22/2007 | $0.00 | A
Languags [ENGLIH Meriel St MaRRED Mr Due | $0.00 |4 (052272007 | $0.00 |
Disabilty [ skpl Stop Correspondencel || Tolal Due| 000 5 04222007 | 50.00 | =
Privacy Opt-outh Time Zone Active Mitary Duty [ Activity Definquency Information
Contact Information Effective Ot Active It Paid Off Ot Chargeoff Ot Current Pmt  Due Day Late 30 GO0 90 120 150 180
Address Type CurrentConfirmediaiing  Phons 0312202007 [ai22/2007 0140172000 [0052010 | §53048 | = 2[ 2 2 2] 2] 1] 2
HOME WV W 1234567800 |~ LestPrt Amt  PiiDt  LastBil Amt Lest Activity Dt Miitsry Duty S I D
23 [ $0.00 (010102000 | 44,486 88 011212010 [ SPAF (o) : z
car,
EDEN PRAIRIE MN-55344 Producer [MC-00003 ; JEMKING INVESTMENT Behaviar Score i Days  Category Callectar
T aop# 010200031543 Customer Grade |[C GRADE  Score| 600 o [DEMOCOLL
Call Activities l Promizes Comments Checklist References Payment Rating History  Due Dste History
Action Result Contact Reason Promize Dt Promise &mt Cancel  Condition Folloneu Ot Titme Zone Adj. Falloweup Dt Appt
m|ce [Hu \ [ [ [ $0.00 [ [uonE [11/30/2009 04:47:13 A0 | [1130/2009 044719 ant 2]
|cc [pe [ | [1152772008 | 200,00 [/ [NONE [11/30/2008 04:45:34 am | [11/30:2008 04:45:34 am
cc [rp [ | [1102772008 | §101.00 [ [NONE [11/30/2008 04:41:58 &M | [11/20/2008 04:41:58 am [
[ro ] [ [ [ [ 000 [ [DEL@ [11:21/2008 05:21:47 am | [11/212008 09:21 47 am [
[ro ] [ [ [ [ 50.00 [ [NONE [11:21/2008 09:21:04 &M | [11/21,2008 03:21.04 am 5

To post a repossession expense

Transaction Parameters
REPOSSESSION EXPENSES TXN DATE
AMOUNT

To adjust a repossession expense

Transaction Parameters

ADJUSTMENT TO REPOSSESSION TXN DATE
EXPENSES - ADD AMOUNT

ADJUSTMENT TO REPOSSESSION TXN DATE
EXPENSES - SUBTRACT AMOUNT

To waive a repossession expense

Transaction Parameters
WAIVE REPOSSESSION EXPENSES TXN DATE
AMOUNT
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Bankruptcy expenses

Bankruptcy expenses include any costs incurred when an account holder declares bank-
ruptcy, such as legal fees or additional collection costs.

Bankruptcy expenses appear in the Other Due field on the Dues block of the Account
Details page. This is the first page to appear on the Customer Service form when you load
an account.

nding Request: 0)
Search Queue Auto Run Sriiinis Ao # Status Procuct Payott Amt At Due Cldest Due Ot Company  Branch
(IR A -001 020003 3 |cHaRGED oFF | LEASE VEHICLE | $0.00 5000 04222007 [sSFC [co (A
Ace #20010200031543 [1120200032343 |CHARGED OFF | LEasE vEHICLE | §0.00 | $0.00 [0422/2007 [SSFC o =
Or S5H Shiowe Al Total[ 50.00 | .00 #0f Accounts 5
Search (1) Custamer Service (2) | Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5]  Deficiency (6) Contract (7) Collateral () Bureau (9) Comments (10)
Account Details l Customer Details EIBMESS Balances Tranzactions Tracking Attributes Statements EBnroy, Insurances Wendor Wiork Order
.Cus(umers D?;isay's cnndmunstondition Start Ot Followup Ot
HOH ABR AHAM [PRBARY = || Payoff {m ;"’EDT Due bt Ul\ﬁmm W [SKP TRACE ASSIGNMENT [11/27/2009 [1/3062009 4
LEE Kk ABRAHAM SPOLISE ue
| | Z |CREDIT INSURANCE anD e 1102772009 [11/30:2009
Customer # 55N Birth Ot Gender Del Due | $0.00 1 [oarzarz007 | $0.00 i i i -
=
[ 219690 [rooee-1213 03171973 [UNKNOIAT LC Due | $0.00 2 [o7i22/2007 | $0.00 o
Enmil | JOHN.ABRAHAM@GMAIL COM s Dus | MI 3 [psrzzr2007 | $0.00 | =)
Larueage [ENGLEA Wartal St MARRIED hier Due | $0.00 4 josi22r2007 | $0.00 |
Disahilty Skipl | Stop Corespondencel | || Total Dug| $0.00 5 04222007 | $0.00 | =
Privacy Opt-OutD Time: Zone: Active Mitary Duty [ Aetivity Delinquency Information
_ Effective [t Active Ot Paid Off [t Chargeoff Ot Current Pmt Due Day Lete 30 6O 90 120 150 180
Contact Information
ddress Type CurrertConfirmechsiing  Prone 03220007 jn3sz2i2007 [o1i01 2000 (01052010 | §aa04e | 2 2[ 2 z[ 2 2 [ 2
4 [ [ 456 - i i
HOME 123-456-7690 | = Last Pt Amt Pmt Ot Last Bill &mt  Last Activity Ot Military Duty BPIISF (Life) I_D’_D
123 [ $000 01002000 | $44,456.88 (017212010 r S
EDEN PRAIRIE MN.55344 Praducer [MC-00003 : JENKINS INVESTMENT Behavior Saare 0 Days Category  Collector
T app# 2001020031543 Customer Grade [C GRADE  Score| 60D of lpEMocoLL
Call Activities l Promizes Commerts Checklist References Payment Rating Histary  Due Date History
Action Re=sult Contact Reaszon Promize [t Promise &mt Cancel  Condition Follovwwup Ct Time Zone Ad). Followeup Ot Appt
m/cC HU \ [ [ §0.00 [ nonE [11/3002000 04:47.18 &M | 113002009 044719 80 40
cc P [ | 1142772009 | $200.00 [ NGNE [11r3002009 04:45,34 o | [11/3002009 04:45:34 AM [
cc P [ [ 1142772009 | $101.00 [ NONE 1113002009 04:41:58 o | [11/3002009 04:41:58 am [
[to [Lwt [ [ [ [ s0.00 [ |DEL@ [11r21.2008 09:21:47 ot | [11:21 12008 03-21-47 aM [
[to [Lwt [ [ [ [ 50.00 [/ NGNE [11r21,2008 09:21:04 amt | [11:21 2008 02:21:08 aM [

To post a bankruptcy expense

Transaction Parameters
LEGAL BANKRUPTCY EXPENSES TXN DATE
AMOUNT

To adjust a bankruptcy expense

Transaction Parameters

ADJUSTMENT TO BANKRUPTCY TXN DATE
EXPENSES - ADD AMOUNT

ADJUSTMENT TO BANKRUPTCY TXN DATE
EXPENSES - SUBTRACT AMOUNT

To waive a bankruptcy expense

Transaction Parameters
WAIVE LEGAL BANKRUPTCY EXPENSES TXN DATE
AMOUNT
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Phone pay fees

Phone pay fees are where a borrower calls the lender and arranges for a debit to their
checking or savings account to make a payment on a lease account.

Phone pay fees appear in the Other Due field on the Dues block of the Account Details
page. This is the first page to appear on the Customer Service form when you load an
account.

Search g eue Avto Run Statuz Product Payoft Amt Amt Due Cldest Due Dt Campany  Branch
g | m [ 43 |cHARGED oFF [LErSE VEHCLE | $0.00 | $0.00 (042202007 [BSFC [om -
oo #]20010200031543 [1120200032342 |cHARGED OFF [LEsSE vEHICLE | $0.00 | $0.00 (042202007 [BEFC [om v
Or 35M Showr &1 Totsl| $0.00 | $0.00 # of Accounts 3
Search (1) Custotmer Service [2) | Maintensnce (3)  Banktuptcy (4)  RepofForeclosure (5) Deficiency (6] Contract (7) Collatersl [5) Bureau (9) Comments (10)
Account Details { Customer Details ElEiEss: Balances Transactions Tracking Atributes Statements Rt Insurances “'endor Wiork Crder
.Cus‘lumers D?;‘sayws ,7 Condiﬁonﬁ:nndﬂinn Start Ot Followwp Ct
=
IJOHN ABRARAM IPR‘MARY = | peyoit SO ;"“e;: Due bt UL’::QUW B [5KP TRACE ASSIGNMENT [11/27/2003 [11/80/2003 |~
LEE K ABRAHAM SPOUSE - e
[CREDIT NSURANCE AND 2 [11/27/2008 [11/30/2009
Customer # =3 Birth Ot Gener Delq Due | $0.00 1 [nsr22i2007 | $0.00 I I I ]
-
[ 218690 pooe-xx-1213 (03111973 [Unkncian LC Due | $0.00 2 0772272007 | $0.00 e
Email [JOHN. ABRAHAMEGMAL COM NSF Dug $0.00 3 [oezzz00r | $0.00 | C
Language [ENGLISH Marial St [MARRED [ Gtrer Due $0.00] 4 052272007 | $0.00 |
Disahilty | Skipl Stop Carrespondencel | Total Due $0.00 5 [0422r2007 | $0.00 | =
Privacy OM-OMD Time Zong Ative Witary Cuty Activity Delinquency Information

Eftective [t Active Dt Paid Off [t Chargeoff Dt Current Pmt  Due Day lste 30 &0 80 120 150 1&0

0312202007 [03/22/2007 010172000 [01m52010 | ssagas | 22| [ 2| 2[ 2[ 2[ z2[ [ 2

Contact Information
Address Type CurrentConfirmedhdailing

Phone

HOME v [ [ 1234567800 = Lazt Pt At Pt Ot Last Bill &mt Last Activity Ot Military Duty (R Y

123 [ $0.00 [01/01/2000 | P44 48688 |01/21/2010 - NS
(=18

EDEN PRAIRIE MN-55344 Procucer [NC-D0003 : JENKINS INYESTMENT Behavior Score i Days Category Rt

~ App # [20010200031543 Customer Grade [C GRADE  Score 600 a DEMOCOLL

Call Activities { Promizes Comments Checklist References Payment Reting History — Due Date History
Action ResLit Cortact Resson Promise Ot Promise Amt Cancel  Condtion Falloweug Ct Time Zone Acli. Followup Ot Appt
mlcC |Hu [ [ [ | $0.00 [ [MOnE [11/302009 04:47:19 AM | [11/302009 044719 am T =
lcc |pp [ [ [11.27.2009 | $200.00 v [MOKE [11/30/2009 04:45:34 am | [11/30/2008 04:45:34 am [
lcc [pe [ [ [11.27.2009 | $101.00 [V [NORE [11r30/2009 04:41:58 AM | [11r30/2000 04:41:55 am [
e |Lm [ [ [ [ $0.00 [ [DEL@ [1121/2008 09:21:47 AM | [1121/2008 09:21:47 am [
[ra |Lm [ [ [ [ $0.00 [ [MONE [11.21 2008 Da:21:04 AN | [11:21/2008 D3:21:04 aM [+
To adjust a phone pay fee
Transaction Parameters
ADJUSTMENT TO PHONE PAY FEE - ADD TXN DATE
AMOUNT
ADJUSTMENT TO PHONE PAY FEE - SUBTRACT TXN DATE
AMOUNT
To waive a phone pay fee
Transaction Parameters
WAIVE PHONE PAY FEE TXN DATE
AMOUNT

Appendix C :-7 User Guide - Consumer Lease Collection



Financed insurances

You can add financed insurance to an existing account with the INSURANCE ADDITION
transaction. This transaction adds the insurance premium amount to advance/principal bal-
ance on the loan and adjusts the loan receivables accordingly. The transaction also triggers
the process to re-compute the repayment amount for the loan. After you post the transac-
tion, the loan will be billed for the newly computed payment amount and will be consid-
ered for delinquencies and fees calculations based on information on the Contract (7)
master tab. The newly added insurance information can be viewed on Customer Service
form’s Insurances page.

To add financed insurance

Transaction Parameters

INSURANCE ADDITION TXN DATE
INSURANCE TYPE
SINGLE/JOINT
INSURANCE MODE
INSURANCE PLAN
COMPANY NAME
PHONE #1
EXTN #1
PHONE #2
EXTN #2
POLICY #
POLICY EFFECTIVE DATE
PREMIUM AMOUNT
EXPIRATION DATE
PRIMARY BENEFICIARY
SECONDARY BENEFICIARY
COMMENT

You can cancel financed insurance on an existing account with the INSURANCE CANCEL-
LATION transaction. When you post this transaction, Oracle Daybreak computes the pre-
mium refund amount based on the refund method associated with the insurance item. If
you enter a value for the PREMIUM AMOUNT parameter, Oracle Daybreak overrides the
calculated refund amount and adjusts the advance/principal balance and the loan receiv-
ables accordingly. The INSURANCE CANCELLATION transaction re-computes the repay-
ment amount for the loan based on remaining balances. After posting the transaction, the
loan will be billed for the newly computed payment amount according information on the
Contract (7) master tab. The insurance cancellation information can be viewed on the Cus-
tomer Service form’s Insurances page on the Customer Service (2) master tab.

To cancel a financed insurance

Transaction Parameters

INSURANCE ADDITION TXN DATE

INSURANCE TYPE

POLICY EFFECTIVE DATE

INSURANCE REFUND
AMOUNT

INTEREST REFUND
AMOUNT

PAYMENT AMOUNT

CANCELLATION REASON
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You may rectify possible errors resulting from incorrect information entered on the
INSURANCE ADDITION transaction (such as an incorrect premium account) with the
monetary transaction INSURANCE MODIFICATION.

When you post the INSURANCE MODIFICATION transaction, Oracle Daybreak re-com-
putes the repayment amount using the new premium amount and adjusts the advance/prin-
cipal balance on the loan and the loan receivables.

To modify financed insurance information

Transaction Parameters

INSURANCE MODIFICATIONS TXN DATE
INSURANCE TYPE
POLICY EFFECTIVE DATE
PREMIUM AMOUNT
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Payoff quotes

A payoff quote is the amount still owed on the account or the amount needed to satisfy the
loan. It can be generated anytime and may be requested during a call from a customer,
dealer, or insurance agent. The payoff quote appears in the Results block of the Mainte-

nance (3) master tab.

Search g0 Auto Run Accounts —, Status Product Payoif Amt AmtDue  Oldest Due Ot Company Branch
[ | m [20060500704475 lacTrve lLoANYEHCLE | $9425.00 | $000 [oem 2006 [ssFc [Ha Al
Ao #Z00R0S00704475 [ [ \ [ [ [ [ [ 52
Or SN Total| $9,425.00 | $0.00 #of dccourts[ 1
Search (1) Cuztomer Service (2) Maintensnce (3) | Bankruptcy (4)  RepoForeclosure () Deficiency (5] Cortract (7) Collateral (8) Bureau (9) Commenits (100
Mairtenance l
Action rRm;ulta; 3
Load Parameters Bost Wi
Dste Monetary Transaction Status Batch Transaction Processing Details
1 W |pavorF auote [posTED = ADVANCE / PRINCIPAL = $9,300.00 A
Parameter Walue Required IHTEREST = ¢0.00
THNDATE W [151672006 s FEE LLTE CHRRGE = G-
PAYOFF QUOTE VALID UPTO DATE  [05/6/2006 [ FEE HSF = 0.
ASSESS PAYOFF QUOTEFEE [ 74 FEE EXTENSION = Gl
PAYOFF QUOTELTRPRINT [ W pe L T Fes.oo
COMMENT  [PROVIDED TO CLISTOMER 7 IS AT = PO
| I EXPENSE REPOSESSION/FORECLOSURE = §0.00
| r EXPENSE SERVICING = $0.00
| I INTEREST ACCRUED = §9.16
| B PAYOFF = $9,334.16
| m INTEREST PELR DIEM = §2.29
| r *x*++  TRANSACTION POSTING SUCCESSFUL *#+++
| [
[ [nl
[ [
[ 5
| O] Ea
N
To generate a payoff quote for an account (Lease)
Transaction Parameters
PAYOFF QUOTE LEASE TXN DATE
PAYOFF QUOTE VALID UP
TO DATE
LEASE BUYOUT INDICATOR
DISPOSITION FEE
EARLY TERMINATION FEE
OTHER FEE
DEPRECIATION ADJUST-
MENT
CURRENT USAGE
PAYOFF QUOTE LTR PRINT
COMMENT
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Account payoff

An account is automatically paid off or marked for payoff processing by Oracle Daybreak
with a batch transaction when the account balance is $0.00. You can also manually payoff
an account with the Maintenance (3) master tab. Note: You can also pay off an account
using the Consumer Lending (Advance and Payment) form. (For more information, see
the Batch Transactions chapter.)

When you payoff an account, Oracle Daybreak changes the account’s status to PAID OFF.
The date the account was paid off appears in the Activity block’s Paid Off Dt field on the

Account Details page.

78 BEOTTLEBRL orm
Search GEuE Auto Run Accounts Acc @ Status Product Paryoff Amt Amit Due Clidest Due Ot Company  Branch
[ ng | m [20080501048656 JCLOSEDPAID OFF JEasE vEHICLE | $0.00 | $0.00 (024002000 DO |Ha Al
Ao #| 20060501 149656 [20060101009729 |acTive |LE~SE vEHICLE | 0.00 | $0.00 [01A02008 [55FC |Ha -]
Or SSM Showy &1l Tutal| $0.00 | $0.00 # of Accourts 7
Search (1) Customer Service (2) | Maintenance (3)  Bankruptcy (4] RepofForeclosure (5] Deficiency (6 Contract (7] e ErerE E Bureau (9) Commerts (100
Accourt Details l Customer Details BIEnESS Balances Transactions Tracking Aftributes Statements EEaray Insurances Wendar VWork Order
Customers Ducs) = Conditions;, . 1tic Start Ot Followup Dt
M |GECRGE & BBOTTLEBRUSH [PRIMARY =] - 30.00 Oldest Due Ot (02402009 " | ‘ —
= o ]
|BETH B BBOTTLEERUSH |sPoLSE - t Due Ot At | | i
Custamer # == Birth Dt Gender Del; Due [ 000 q [05/10:2008 | $0.00 | | i |
-
[ 305690 [roxx-xx-2316 (017141963 |UNKNOVN L Dus | §0.00 2 [14s10:2005 | $0.00 e
Emeil (BEORGEB@SSC.COM WSF Due | $0.00 3 |13 02008 | $0.00 [ a]
Language [ENGLISH Wertel St paaRRED || CtherDue [ §0.00 4 [D2s106008 | $0.00 |
Disabiity Skipl™ Stop Correspondencel | Total Due| $0.00 5 [01/10/2008 | $0.00 | =
Privacy 0pt-0ut|7 Time Zone |AMERICA Active Military Duw|— Activity e e e faT
Contact Information Effective Ot Active Dt Iﬂa\a OTT L% I:hargeoff Ot Currert Pt Due Day Late 30 60 &0 120 150 180
Address Type Currert Confimedbdailing Phane |DS.¢1 0/2008 |DSBDJ‘EDDB bB.ﬂ 1/2008 I | $0.00 10 i} 0 0 0 0 1 3
HOME % W p1z-3asad4ed = LastPmt &mt  PmtDt  LastBil At Last Activity Dt Miltary Duty e ey N )
4430 FARS CT [ $2,758.40 [11204r2008 | $2,666.76 [06/30/2009 r S DD
TAMUINING GA-96331 Producer [MN-00001 : M HOUSE (DIRECT DEAL) Bishavior Score i Days  Category Collector
= App # 0000000332 Customer Grace Score i 0150 CALE
Call Activities l Promizes Comments Checklist References Payment Rating History — Due Date History
Action Resutt Contact Resson Promize Ot Promise Amt Cancel  Concition Followup Ot Time Zone Aclj. Followeup Dt Appt
u [ [ [ [ [ 0,00 \ [emERICAMEN v OR: | ][]
| | | | \ \ il \ | \ r
[ [ [ [ \ \ | \ [ \ i
| | | | [ [ il [ | [ I
| | | | [ [ il [ | [ i~

Oracle Daybreak also notes the amount of the principal that was waived when the account
was paid off in the Waived column on the Balances page.

To pay off an account

Transaction
PAID OFF

Parameters
TXN DATE

If you reverse the payoff payment using the Customer Service form, then the pay-off is

automatically reversed. Oracle Daybreak changes the account’s status from PAID OFF to
ACTIVE when you refresh the account.
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Account charge off

Charging off an account refers to when a lender decides to take a loss on an account, sig-
naling that attempts to recover the loan have failed. In calculating a charge off, Oracle
Daybreak considers the total compensation amount (up front compensation plus remaining
compensation amount).

When you charge off account, Oracle Daybreak changes the status to CHARGED OFF. The
balance on the account appears on the Customer Service form’s Balance page when you
choose Deficiency Balance in the Balance Group block.

The date of the charge off appears on the Account Details page in the Activity block’s
Chargeoft Dt field.

Note: Charging off is a process of writing off a loss on a loan which is not repaid by the
customer. It is different from the waive off process since a waive off is a concession
offered to the customer on payment of some component, such as a late fee. The repayment
of the original loan still continues in waive off process.

To charge off an account

Transaction Parameters
CHARGED OFF TXN DATE

Account closure

Oracle Daybreak automatically closes an account when its status changes to PAID or
VOID. It is manually closed on charge off accounts. Accounts marked as CLOSED are not
processed and after a period of time are purged from Oracle Daybreak.

Note: The ACCOUNT CLOSE transaction can not be processed on accounts with an
ACTIVE status. Accounts with a status of CHARGE OFF can be closed.

To close an account

Transaction Parameters
ACCOUNT CLOSE TXN DATE
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Due date change

You can change the due date of an account. If a late fee is no longer applicable because of
this due day change, Oracle Daybreak will automatically remove the fee.

Search o - o

Acc# Status Prociuct Paryoff Amt At Due Olclest Due Ot Company  Branch
|cHaRGED OFF | LEASE VEHICLE | $0.00 | $0.00 [0a2zr2007 [s5FC [em -
Acc #20010200031543 [1120200032343 |cHARGED OFF | LEASE VEHICLE | $0.00 | $0.00 [odi2zi2007 [s5FC oo =
Or 53N Show &1V Total| $0.00 | %000 # of Accounts [
Search (1) Custotner Service (2) | Mairtenance (3)  Bankruptcy (4)  Repo/Foreclosure (5) Deficiency (B Cortract (7) Collsteral (3) Buresu (9) Comments (10)
Account Details { Customer Details HNEMESS: Balances Transactions Tracking Attributes Statemerts Bzt Insurances “endor Work Order
.Cus(umers D“rjc?dsay‘s Conditions,.  on Start 0t Followup Dt
R [ w
IJOHN AR IPR'MARY = Payoff 000 DOMEDS: el Uﬁ:mm B [SKIP TRACE ASSIGRMENT (115272009 11502008 =
LEE K ABRAHAM SPOUSE uz
Z |CREDIT IMSURANCE AND W 11272009 [11 /3002009
Customer # S3h Birth Ot Gender Del Due | $0.00 1 [08z2/2007 | 30,00 | ‘ ‘ -
=
[ 219690 [roeex-1213 (03411973 [UNKNOWN L Due [ $0.00 | 2 [07422/2007 | $0.00 s
Email HOHM ABRAHAMEEMAIL SOM RIS Due [ $0.00 3 [D6azzz007 | $0.00 | A
Language [ENGLISH il 5 TR Cther Due | $0.00 4 [05:20/2007 | §0.00 |
Disahilty [ skpl” stop Corespondence [ | Total Due| 000 5 (042202007 | $0.00 | =l
Privacy Opt-outh Time Zone acthve Miitary Duty | petivity Delinquency Information

Contact Information Effective Ot Active Ot Paid Off Ot Chargeoff Ot Currert Pmt | Due Day Lste 30 60 90 4120 150 180
Lodress Type CurrentConfrmedaiing  Phone |0zi222007 [03i222007 |01/01,2000 [D1.0872010 | ssanad | 2| [ 2] 2 z[ z2[ 2] [ 2
HOME W [ [ [123-456-7890 = LastPmtAmt  PiDt  LastBil smt Last sctivity Dt Military Duty e s S
123 [ $0.00 [0101/2000 | $44,486.88 [01/21/2010 [ FE—— [
EDEN PRAIRIE MN-55344 Producer [NC-D0003 : JENKING INVESTMERT Behaviar Score ,—D Days  Category Callectar
= app# 2001020003154 Customer Grade [C GRADE  Score| 600 [ o DEMOCOLL
Call Activities { Promises Comments Checklist References Paymert Rating History — Due Date History
Action Result Contact Resson Promize Ot Promise Amt Cancel  Condition Followeug Ot Time Zone A, Folloseup Dt Appt
mo (] [ I [ [ $0.00 [ [MONE [11:2002008 044719 20 | [11/m00z008 044719 a0 T 20
lcc |pr [ [ [1127:2009 | $200.00 [+ [NONE [1113002009 04:45:34 am | [11r3002009 04:45:34 am [
lcc pp [ I [11/2712009 | $101.00 k# [NONE [113002009 D4:41:58 am | [11r3002009 D4:41:58 am [
[T |Lm [ I [ [ $0.00 [ [pEL@ [11:21/2008 09:21:47 am | [11521:2008 09:21:47 am [
[To (] [ | | [ $0.00 [ [NONE [11021/2008 09:21:04 AM | [11i21.2008 092104 a0 [ 5

Note: When you change a due date, Oracle Daybreak determines the next bill date, as well
as the next due date. The DUE DATE CHANGE transaction does not allow the next billing
date to change such that it is less than the current billing date.

Oracle Daybreak also notes the change on Loan Details sub pages in the Extn and Due
Dates block’s # of Due Day Changes and Due Day Chg Dt fields.

To change a due date

Transaction Parameters
DUE DATE CHANGE TXN DATE
DUE DATE

Disposition fees

Disposition fees are assessed towards leasing/processing a leased vehicle, especially if it is

returned prior to the standard maturity date.

To post a disposition fee

Transaction
DISPOSITION FEE

Parameters
(NO PARAMETERS)
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To adjust a disposition fee

Transaction Parameters
ADJUSTMENT TO DISPOSITION FEE - ADD (NO PARAMETERS)
ADJUSTMENT TO DISPOSITION FEE - SUBTRACT (NO PARAMETERS)

To post a disposition fee

Transaction Parameters
DISPOSITION FEE

To waive a disposition fee

Transaction Parameters
WAIVE DISPOSITION FEE (NO PARAMETERS)

Termination

If the lease is terminated earlier than the contract maturity date, then termination fees may
be applied.

To terminate

Transaction Parameters

TERMINATE TXN DATE
LEASE BUYOUT INDICATOR
DISPOSITION FEE
EARLY TERMINATION FEE
OTHER FEE
CURRENT USAGE
SALE PRICE
DEPRECIATION ADJUST-
MENT

To post an early termination fee

Transaction Parameters
EARLY TERMINATION FEE (NO PARAMETERS)

To adjust an early termination fee

Transaction Parameters
ADJUSTMENT EARLY TERMINATION FEE - ADD (NO PARAMETERS)

ADJUSTMENT EARLY TERMINATION FEE - SUBTRACT (NO PARAMETERS)

Sale of asset

To record selling an asset

Transaction Parameters
SALE OF ASSET TXN DATE
AMOUNT
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Excess usage

Excess usage fees, or mileage fees, may be applied when a leased vehicle is returned with
more than the agreed upon number of miles on the odometer.

To post excess usage fee

Transaction
EXCESS USAGE FEE

To adjust excess usage fee

Transaction
ADJUSTMENT TO EXCESS USAGE FEE - ADD

ADJUSTMENT TO EXCESS USAGE FEE - SUBTRACT

To waive excess usage fee

Transaction
WAIVE EXCESS USAGE FEE

Other fees and taxes

Parameters

Parameters
(NO PARAMETERS)

(NO PARAMETERS)
(NO PARAMETERS)

Parameters
(NO PARAMETERS)

The other fees and taxes transactions allow you to assess fees and taxes not defined within

Oracle Daybreak.

To post other fees and taxes

Transaction

OTHER FEES AND TAXES
AMOUNT

To adjust other fees and taxes

Transaction

ADJUSTMENT TO OTHER FEES AND
TAXES - ADD

ADJUSTMENT TO OTHER FEES AND
TAXES - SUBTRACT

To waive other fees and taxes

Transaction
WAIVE OTHER FEES AND TAXES

Parameters
TXN DATE

Parameters
(NO PARAMETERS)

(NO PARAMETERS)

Parameters
(NO PARAMETERS)
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Lease nonmonetary transactions

This section catalogues the transaction codes and parameters required to complete the fol-

lowing nonmonetary tasks for leases:

» Update a customer’s name
*  Maintain customer details
*  Mark a customer as a skipped debtor

¢ Change a customer’s Privacy Opt-Out indicator

»  Stop correspondence

*  Modify financed insurance information
»  Start or stop an ACH

*  Reprint a statement (batch only)

*  Create or cancel a one time ACH - phone pay

* Reorder coupon books (or payment books)

Customer name maintenance

You can update and change a customer’s name.

Search o, . o

Status Product Paryoff &mt At Due Oldest Due Ot Company Branch
r |cHaRGED OFF | LEASE VEHICLE | $0.00 | $000 42202007 [SSFC o -
Ace 220010200031 543 |cHarGED OFF [LEASE VEHICLE | $0.00 | $000 (042202007 [SSFC |c01 -
or 55N Show A1V Total| $0.00 | $0.00 # of Accounts 3
Search (1] Customer Service (2) | Mairtenance (3) Bankruptcy (4) RepoForeclosure (9 Deficiency (61 Contract (7 Collatersl (8) Bureau (9) Comments (10)
Account Details l Customet Detaills Ellzinz s Balances Transactions Tracking Attributes Statemenits ESsroin Insurances “endor Work Order
- "
b [ | i D%';fay-s ,7 ’— Conditions, . jjion Start Dt Fallovwup Ot
liCE’:: :BE';:::: l;ig"j;; = payatt St ;J:e;: Due 0t U:’:fﬂm U B[Sk TRACE ASSIGNMENT [11/27/2008 [11/02008 |~
h |CREDIT MSURANCE AND e [11/27,2008 [11/30/2009
Customer # =0 Birth Dt Genider Dl Due | $0.00 4 [ngizzz007 | #0100 | | ‘ I
=
[ 219690 [on-01213 (03411973 (UKo LG Due [ $0.00 2 (072272007 | §0.00 e
Emsil [JOHM AERAHAMEGMAL COM NSF Due | $0.00 3 (06222007 | $0.00 T ~
Languscs [ENGLISH Marital St [MARRIED Cther Due | $0.00 4 [osr22r2007 | $0.00 I
Dizability | Skin | Stop Correspondence | || Total Due | $0.00 5 04222007 | $0.00 [ =
Privacy Opt-Cuth Time Zone ctive Miltary Duty T Activity Delinquency Information
Contact Information Effective Ot Active Ot Paid Off Ot Chargeotf Ot Current Pt Due Dary Lste 30 60 90 120 150 18&0

Address Type CurrentConfirmedhaling  Phane |par2202007 [na202007 [01001 /2000 010010 | g53048 | 22 2 2| 2] 2 =z 4| =z
HCItE v r ¥ |123.456.7890 | = Last Pimt &mt Pt Ot Last Bill &mt  Last Activity Ot Military Duty 7 I
123 [ $000 010162000 | $44,436.88 012102010 I B::zf:::; ,72’72
EDEN PRAIRIE MH-55344 Prosucer [FC-0D003 : JENKINS INESTMENT Behavior Scare | 0 B @mEy Collector

-] App # (20010200031 543 Customer Grads |(© GRADE | Score| 600 0 DEMOCOLL
Call Activities l Promises Comments Checklist References Payment Rating History  Due Date History
Action Resut Contact Reason Promize Ot Promize Amt Cancel  Conclition Follatneug Ot Time Zone Ad. Followwup Ot Appt
mcc [Hu | | [ | $0.00 [ [NoNE [11£30/2009 04:47:19 M | [11£30/2009 04:47:19 M T~
cc |Pr [ [ [1127/2009 | $200.00 b [MONE [11/3002009 04.45:34 am | [11/3002009 04:45:34 2 [
lcc PP | | [1127/2009 | $101.00 W [MONE [11/3002000 04.41:55 am | [11/3002009 04:41:55 &M [
[ro |Cra [ [ [ [ $000 [ [DELar [11/212008 n321:47 2m | [114212008 n3:21:47 2 [
[ro |Cra [ [ [ [ $0.00 [ [MonE [11621/2005 09:21:04 2w | [11/212008 D3 21:04 20 [ =
T dat t ’
O update a customer's name
Transaction Parameters
CUSTOMER NAME MAINTENANCE TXN DATE
RELATION TYPE CODE
CUSTOMER FIRST NAME
CUSTOMER MIDDLE NAME
CUSTOMER LAST NAME
CUSTOMER GENERATION

CODE

The new name appears in the account title and on the Customer Service (2) master tab’s

Account Details and Customer Details pages.
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Customer details maintenance

You can update and change the following details regarding a customer: social security
number, marital status, disability indicator, driving license number, number of dependents,

and email address.

Accounts

Contact Information

Search o 0 e At Run Status Product Fayott Amt &t Due  Oldest Due Dt Company Branch
Nz | = O 543 |cHaRGED OFF | LESE VEHICLE | 5000 | $0.00 naiz2r2007 [S5FC Jom N
A0 #120010200051543 [1120200032343 |cHARGED OFF | LEASE VEHICLE | $0.00 | $0.00 0di22/2007 [s5FC oo ~
Or 53N Shaw Al Tatal| $0.00 | $0.00 #of Accounts 6
Search (1) Customer Service (2) | Msintensnce (3)  Bankruptcy (4)  RepoForeclosure (3) Deficiency (6) Cortract (T) Collateral (3] Buresu (9) Comments (100
Account Details l Customer Details HIEESE Balances Trangactions Tracking Attributes Statements ESCrEY Insurances Wendor Work Orcer
.Custnmers D“f‘:o?ay's C""dm“"ﬁ:ondmon Start Ot Followwup D
a [ wm [p12za010
Iig:: ::::::: };:L:':;Y = |l Payort 000 ;::EDS: Due Dt Dlﬁmm B [SKIP TRACE ASSIGNMENT (112772008 [11/302008 |~
= |CREDIT INSURANCE AND W2 [1127/2009 (113042009
Customer # =] Birtt: Ot Gendzr Dl Due $0.00 ¢ (1872272007 | $0.00 | i | |
-
[ 219630 foot--1213 (03111573 [UNKNCAN LG Due [ $0.00 2 [07/2202007 | $0.00 e
Email HOHN ABRAHAMZGMAL.COM MSF Dus | $0.00 3 05220007 | $0.00 | a
Language [ENGLISH e T Ciher Due | $0.00 4 [05/22/2007 | §0.00 |
Disabilty Shinl Stap Correspondence | | Total Due | $0.00 5 042202007 | $0.00 | -
ivacy Opt-Outh¥ Time Zone Active hiltary Duty [ Activity Delinquency Infarmation

Eftective Dt Active Ot Paid Off Dt Chargeoff Ot Current Pt

Due Day Late 30 B0 90 120 150 180

Address Type CurrentConfrmediaiing  Phone 032212007 032202007 [01401 02000 0052010 | saavas | 2 [ 2| 2 2| 2] z2[ 1| =2
howe W T 2 [1z34567800) (4 LastPrt Amt  PmtDt LastBilAmt Last Activity Ot Mitary Duty s e [ )
123 [ $0.00 [01/01/2000 | $44 48685 [01/21.2010 i o
EDEN PRAIRIE Mh-55344 Producer [NC-DO003 ; JEMKINE INWESTMENT Behavior Seore| 0 Deys  Cotegory Collector

< App#[20010200031543  Customer Grade [CGRADE  Seore| 60D [ o]  [pemoco.
Call Activities l Promizes Comments Checklist Reterences Payment Rating History  Due Dete History
Action Result Contact Reason Promize Ot Promise Amt Cancel  Conction Falloswup Ot Time Fone Adj. Followup O Appt
mcC |Hu | | [ | $0.00 [ MOKE [11/m002009 044719 20 | [11m002000 0aa7 18 am T =
cc |pp [ [ 11272008 | $200.00 [ NONE [11/30/2000 04:45:54 A | [11/30/2000 04:45:34 aM [
|cc pe | | [11.2712009 | $101.00 [P/ NOKE [11/30/2009 04:41:58 A | [11/30/2009 044155 am [
{To |Lh | | [ I $0.00 [ |DELG: [11221/2008 09:21:47 Am | {11621 72008 09 21:47 A [
[ro LM | [ [ [ $0.00 [ MONE [11521 2008 092104 2t | [11:21/2008 0921 04 AM 1=
To change other details about a customer
Transaction Parameters
CUSTOMER MAINTENANCE TXN DATE
RELATION TYPE CODE
CUSTOMER SSN
CUSTOMER MARITIAL
STATUS CODE
CUSTOMER DISABILITY
INDICATOR
CUSTOMER DRIVING
LICENSE NUMBER
CUSTOMER NUMBER OF
DEPENDENTS
CUSTOMER EMAIL
ADDRESS 1
CUSTOMER BIRTH DATE
CUSTOMER GENDER CODE
CUSTOMER LANGUAGE
CODE
CUSTOMER DRIVING
LICENSE STATE CODE
CUSTOMER TIME ZONE

The new details appears on the Customer Service (2) master tab’s Account Details and

Customer Details pages.
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“Skipped” customers

When a customer cannot be located, Oracle Daybreak allows you to mark that person as
“skipped” (as in, “the person is a skipped debtor.”) Marking a customer as skipped indi-
cates that the customer’s whereabouts are unknown.

To mark a customer as “skipped”

Transaction Parameters

CUSTOMER SKIP TXN DATE
RELATION TYPE CODE
CUSTOMER SKIP INDICATOR

The Skip box is selected on the Customer Service (2) master tab’s Account Details and
Customer Details pages.

Note: To remove the Skip indicator, follow the procedures above; however, type N in the
CUSTOMER SKIP INDICATOR parameter.

Privacy Opt-Out indicator

You can change the customer’s Privacy Opt-Out indicator.

Pending Reguest: 0)

Search o o0 Avto Run Status Procuct Payaff smt Amt Due Oldest Dus Dt Company  Branch
| x 0010200031543 |cHARGED OFF | LEASE vEHICLE $0.00 $0.00 (042202007 [SSFC [co1 =
Acc #/20010200031 543 |cHARGED COFF | LEASE VEHICLE $0.00 $0.00 (04222007 [SSFC [C01 [~
Or 55 Show a1V Total $0.00 $0.00 # of Accounts B
Search (1) Custamer Service (21 | Maintenance (3)  Bankruptcy (4)  RepoiForeclosure (5)  Deficizncy (8) Cortract (7) Collateral (9) Bursau (3) Commerts (10)
Accourt Detsils | Customer Details ElEliess Belances Transactions  Tracking Aftributes Statements sy, Insurances wendor Wark Order
.‘:“5‘“’“"'5 e e Conditions; - jtion Start Dt Followup Ot
|sori araam [prmerer =1 Pavaft 3000 DO“’E;‘ EroER E'Lrjf’?m” B [SKIP TRACE ASSICHMENT  [11/27/2000 [11/30/2000 =
LEE K ABRAHALM SPOUSE - ue
| | [CREDIT INSURANCE AND W2 [1/27,2008 [11/30/2008
Customer # =) Birth Dt Gender Dsley Due | $0.00 4 [o82ze007 | $0.00 |
| 219690 ez 213 [03M1 M 973 [UNKMCRIM LC Due §0.00 2 |07/22/2007 $0.00 et
Emeil [JOHN ABRAHAMEGMAIL COM MSF Due $0.00 3 [08/22/2007 $0.00 03
Language [ENGLISH Martal St MARRIED Cther Due $0.00 4 [05/22/2007 $0.00 [

R Skip[— Stop Correspondence Total Due | $0.00 5 (0472202007 $0.00 [ ~]
Privacy Opt-Out P Time Zone Active Military Duty Activi

Delingquency Information

Contact Information Effective D1 Active Dt Paid Off Dt Chargeoff Dt CurrertPmt DueDay | Lats 30 60 480 120 150 180
Address Type CurrentConfirmediaiing  Phone |narz2z007 [narz2r2007 (010142000 [01052010 | gsagae [ 22 | [ 2] 2 2[ =2 =z[ 1] =
HOME I [ Iv¥ [123-456-7830 |~ Last Pt &t Pt Ot Last Bill &mt Last Activity Dt Miltary Duty e i G
123 [ §0.00 [01.01/2000 | §44 486,88 [01/21/2010 " e G
EDEN PRAIRIE Mh-55344 Producer [NC-00003 ; JENKINS INVESTMENT Behavior Score 0 e Cllasar
=] spp# [20010200031543  Customer Grede [C GRADE | Score| 500 [ o [pEMOcoLL
Call Activiies | Promises Commerts Checkist References  Payment Rating History  Due Date History
Action Result Cortact Reason Promise Dt Promise Amt Cancel  Coneliion Fallowup Dt Time Zone Al Folowup Dt Appt
mfcc ] [ | $0.00 [ [NONE [11/30/2008 D4:47:19 am | [11/30:2009 04:47:18 4 [ 2]
e 533 [ [ [11:27:2008 | 520000 [ [MOME [1/2002000 04:45:34 am | [11/2002000 04:45:34 2w [
e 533 [ [ [11:27:2008 | $101.00 (v [NOME [113002008 n4:41:55 am | [11/3002008 04:41:56 am [
1o 1] [ [ g0.00 [ [DELa [1421 2008 n9:21:47 am | [11421 2008 09:21:47 2w [
it} Y] [ [ [ [ $0.00 [ [NONE [11421/2008 09:21:04 AM | [11:21:2008 09:21:04 am [ [~

To change the customer’s privacy opt-out indicator

Transaction Parameters

CUSTOMER PRIVACY INFO SHARING PREFERENCE PRIVACY OPTOUT
EFFECTIVE DATE
RELATION TYPE CODE
The Primary Opt-Out box is selected on the Customer Service (2) master tab’s Account
Details and Customer Details pages.

Note: To remove the Primary Opt-Out indicator, follow the procedures above; however,
type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.
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Correspondence (stopping)

You can choose at any time to stop correspondence to a customer. When you do so, the
customer will receive no correspondence of any kind from Oracle Daybreak.

To stop correspondence with a customer

Transaction Parameters
CUSTOMER STOP CORRESPONDENCE TXN DATE
RELATION TYPE CODE
CUSTOMER STOP CORR
INDICATOR

The Stop Correspondence box is selected on the Customer Service (2) master tab’s
Account Details and Customer Details pages.

Note: To remove the Stop Correspondence indicator, follow the procedures above; how-
ever, type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

Financed insurance (modifying)

You can change other insurance details entered on the INSURANCE ADDITION transaction
with the nonmonetary INSURANCE DETAILS MODIFICATION transaction. The changed
insurance information can be viewed on Customer Service form’s Insurances page on the
Customer Service (2) master tab.

Note: Please contact your account manager for back porting this functionality on existing
loan accounts.

Transaction Parameters

INSURANCE MODIFICATION TXN DATE
EFFECTIVE DATE
INSURANCE TYPE
POLICY EFFECTIVE DATE
COMPANY NAME
PHONE # 1
EXTN#1
PHONE # 2
EXTN #2
POLICY #
EXPIRATION DATE
PRIMARY BENEFICIARY
SECONDARY BENEFICIARY
REFUND AMOUNT
RECEIVED
FULL REFUND RECEIVED
COMMENT

Appendix C :-19 User Guide - Consumer Lease Collection



ACH

With the Transaction page, you can either start or stop an automated clearinghouse, or
electronic funds transfer, for an account.

To start an ACH for an account

Transaction
ACH MAINTENANCE

Parameters

TXN DATE

ACH BANK NAME

ACH BANK ROUTING
NUMBER

ACH ACCOUNT TYPE CODE

ACH ACCOUNT NUMBER

ACH PAYMENT DAY

ACH PAYMENT AMOUNT

ACH PAYMENT FEQUENCY
CODE

ACH START DATE

This information appears on the ACH sub page, available on the Balances, Transactions,
Tracking Attributes, and Insurances pages on the Customer Service (2) master tab.

Search o o

Accounts

Bank Information

Auto Run Status Psyoff Amt Amt Dug Oldest Due Ot Company  Branch
[ ‘mx | m [poos1001099545 |acTrveDELGiSCHEDULED C[LEASE VEHICLE | §16,310.85 | $15,555.40 111002005 [SSFC [co1 B
Acc #|20061 001093646 |200801 01009862 |cHARGED OFF |LEASE VEHICLE | $0.00 | $0.00 [02M02006 [SSFC oo ~
Cr SN Showy W Tntall 2568511 | 24,251 70 # of Accounits: 11
Search (1) Custotner Service (2) | Maintenance (3)  Bankruptcy (4)  RepofForeclosure (5) Deficiency (6) Contract (7) Collateral (8) Bureau (9 Comments (10)
Accourt Details Customer Details EET eSS Balances Transactions Tracking Attributes I Statements ESTr “endor \Work Crder
Balance Group Txn Period
® Cyrrert Bslance " Deficiency Balance " Mon-Performing Balance [ Termingte Balance & [TDICTD YT
Balance Type Opening Balance Posted Psid Waived Charged Off Adjusted () Adjusted (+) Balance
W || EASE RECENVABLE [ $0.00 | §15,899,54 | $444.44 | $0.00 | 50.00 | $0.00 | 50.00 | $15555.40 |~
|FEE LATE cHARGE [ $0.00 | §755.45 | 000 | 000 | $0.00 | 000 | $0.00 | $755.45
|FEE HsF [ $0.00 | 50,00 | $0.00 | $0.00 | 50.00 | $0.00 | 50.00 | $0.00
|FEE ADvancE [ $0.00 | 5000 | §0.00 | $0.00 | $0.00 | $0.00 | $0.00 | $0.00
|FEE PHONE PAY [ $0.00 | 50.00 | $0.00 | 50.00 | 50.00 | $0.00 | 50.00 | $0.00
|EXPENSE BANKRUPTCY [ $0.00 | 50,00 | $0.00 | $0.00 | 50.00 | $0.00 | 50.00 | §0.00
|ExPENSE REPOSESSIONFORE | $0.00 | 0.0 | 000 | 000 | $0.00 | 000 | $0.00 | $0.00
|EXPENSE SERVICING [ $0.00 | 50,00 | $0.00 | $0.00 | 50.00 | $0.00 | 50.00 | $0.00
[saLEs rusAGE TAx [ $0.00 | 5000 | §0.00 | $0.00 | $0.00 | $0.00 | $0.00 | o0 T
Total Balance $18,310.58
|| P2 A aEEmEtEiEs SREpEy e EHE (Bt et Lease Details eyl ey = e s =2 Card Details

acHlv | Bank|us BanK

Routing # | 373638378

Aceount Type [CHECKING

Account # |XXXX){X){TEST
ACH Debit Amt $0.00

Dehit Freg MONTHLY Dehit Day 10

Start Ot |10/ 072006

To stop an ACH for an account

Transaction
STOP ACH MAINTENANCE

Parameters
TXN DATE

Oracle Daybreak clears the information on the ACH sub page, available on the Balances,
Transactions, Tracking Attributes, and Insurances pages on the Customer Service (2) mas-

ter tab.
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Statement reprinting (batch only)

You can reprint a statement of account activity by defining the starting and closing dates
included within the statement.

To reprint a statement

Transaction Parameters
STATEMENT REPRINT MAINTENANCE TXN DATE
STATEMENT CLOSING DATE

One time ACH - phone pay

Oracle Daybreak provides the ability to handle one time automated clearinghouse initiated
by nonmaintenance transactions, giving you the ability to offer phone pay services to your
customers. When accessing a phone pay, Oracle Daybreak creates an ACH file and gener-
ates payment batches.

Note: A one time ACH - phone pay transaction has parameters which are required for the
ACH file processing.

To create one time ACH - phone pay

Transaction Parameters

ONETIME ACH - PHONE PAY BANK NAME
BANK CITY
ROUTING NUMBER
ACCOUNT TYPE
NAME AS IT APPEARS ON

ACCOUNT

ACCOUNT NUMBER
DEBIT DATE
PAYMENT AMOUNT
PHONE PAY FEE
SECRET QUESTION
SECRET ANSWER
WHO AUTHORIZED
CHECK NUMBER

To cancel one time ACH - phone pay

Transaction Parameters

CANCEL ONETIME ACH - PHONE PAY (NO PARAMETERS)
* Post transaction to complete.
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Coupon book maintenance (batch only)

In reordering coupon books, you will need supply the first date of new coupons, the new
coupon start number, and the number of new coupons to order.

To re-order coupon book (batch only)

Transaction Parameters

COUPON BOOK MAINTENANCE TXN DATE
COUPON FIRST PAYMENT
DATE
COUPON START NUMBER
COUPON COUNT

* To cancel the coupon book re-order before it is processed in the nightly batch, choose
Void.
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APPENDIX D : PAYMENT AMOUNT CONVERSIONS

The following table contains the calculations Oracle Daybreak uses to convert the differ-
ent payment frequencies (weekly, biweekly, semimonthly, and so on) to standard monthly

values for installment accounts.

Payment Frequency:
D = Deferred

P = Single payment loan

W = Weekly (due every week)

B = Biweekly (due every two weeks)

E = Semimonthly (due twice a month)
M = Monthly (due every month)

L = Bimonthly (due every two months)
Q = Quarterly (due every three months)
T = Triannually (due every four months)
S = Semiannually (due twice a year)

Y = Annually (due every year)

Scheduled Monthly Income Amount:
Zero fill

Zero fill
Multiple by 4.33
Multiple by 2.16
Multiple by 2
As given

Divide by 2
Divide by 3
Divide by 4
Divide by 6

Divide by 12
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